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What do you think of this book? We want to hear from you! 
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources	
for you. To participate in a brief online survey, please visit: 

microsoft.com/learning/booksurvey
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Introducing Microsoft Office  
Professional 2010

Microsoft Office 2010 is a comprehensive system of programs, servers, services, and  
solutions, including a dozen desktop productivity programs that you can install on  
your computer, and four new online program versions. To meet the varying needs  
of individuals and organizations, Microsoft offers five different Office 2010 software 
suites, each consisting of a different subset of programs. The following table identifies 
the programs available in each of the software suites.

Office Home 
and Student 
2010

Office Home 
and Business 
2010

Office 
Standard 
2010

Office 
Professional 
2010

Office 
Professional 
Plus 2010

Access Yes Yes
Communicator Yes
Excel Yes Yes Yes Yes Yes
InfoPath Yes
OneNote Yes Yes Yes Yes Yes
Outlook Yes Yes Yes Outlook with 

Business 
Contact 
Manager

PowerPoint Yes Yes Yes Yes Yes
Publisher Yes Yes Yes
SharePoint 
Workspace

Yes

Word Yes Yes Yes Yes Yes
Office  
Web Apps

Yes Yes

Office Standard and Office Professional Plus are available only to volume licensing 
subscribers. The Office Web Apps, which are available with Office Standard and Office 
Professional Plus, and available to the general public through Windows Live, are online 
versions of Word, Excel, PowerPoint, and OneNote. You can store documents online and 
work with them from within any Web browser window by using the Office Web Apps.
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This book provides instructional material for the following programs, which together 
form the Office Professional 2010 software suite:

●	 Microsoft Word 2010  A word-processing program with which you can quickly 
and efficiently author and format documents.

●	 Microsoft Excel 2010  A spreadsheet program with which you can analyze, 
communicate, and manage information.

●	 Microsoft PowerPoint 2010  A program with which you can develop and present 
dynamic, professional-looking slide presentations.

●	 Microsoft OneNote 2010  A digital notebook program with which you can collect, 
organize, and quickly locate many types of electronic information.

●	 Microsoft Outlook 2010  A personal information management program with which 
you can manage e-mail, contacts, meetings, tasks, and other communications.

●	 Microsoft Access 2010  A database program with which you can collect information 
and output information for reuse in a variety of formats.

●	 Microsoft Publisher 2010  A desktop publishing program with which you can lay 
out newsletters, cards, calendars, and other publications.

The information in this book applies to these programs in all the software suites. If you 
have a software suite other than Office Professional, or if you installed one or more of 
these programs independently of a software suite, this is the right book for you.

Certification
Desktop computing proficiency is increasingly important in today’s business world. When 
screening, hiring, and training employees, more employers are relying on the objectivity 
and consistency of technology certification to ensure the competence of their workforce. 
As an employee or job seeker, you can use technology certification to prove that you 
already have the skills you need to succeed. A Microsoft Office Specialist (MOS) is an 
individual who has demonstrated worldwide skill standards through a certification exam 
in one or more of the Office 2010 programs, including Microsoft Access, Excel, Outlook, 
PowerPoint, or Word. To learn more about the MOS program, visit the Microsoft Office 
Specialist Certification page at go.microsoft.com/fwlink/?LinkId=193884.
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For More Information
The chapters of this book that cover Microsoft Word 2010, Excel 2010, PowerPoint 2010, 
Outlook 2010, and Access 2010 are excerpted from the full-length Step by Step books 
written about those programs. This book provides an overview of each program and 
information to get you started. To learn more, refer to the following books.

Microsoft Word 2010 Step by Step
By Joyce Cox and Joan Lambert (Microsoft Press, 2010) 
ISBN 978-0-7356-2693-5

Contents:

	 1	 Explore Word 2010

	 2	 Edit and Proofread Text

	 3	 Change the Look of Text

	 4	 Organize Information in Columns and Tables

	 5	 Add Simple Graphic Elements

	 6	 Preview, Print, and Distribute Documents

	 7	 Insert and Modify Diagrams

	 8	 Insert and Modify Charts

	 9	 Use Other Visual Elements

	 10	 Organize and Arrange Content

	 11	 Create Documents for Use Outside of Word

	 12	 Explore More Text Techniques

	 13	 Use Reference Tools for Longer Documents

	 14	 Work with Mail Merge

	 15	 Collaborate on Documents

	 16	 Work in Word More Efficiently
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Microsoft Excel 2010 Step by Step
By Curtis Frye (Microsoft Press, 2010) 
ISBN 978-0-7356-2694-2

Contents:

	 1	 Setting Up a Workbook

	 2	 Working with Data and Excel Tables

	 3	 Performing Calculations on Data

	 4	 Changing Workbook Appearance

	 5	 Focusing on Specific Data by Using Filters

	 6	 Reordering and Summarizing Data

	 7	 Combining Data from Multiple Sources

	 8	 Analyzing Alternative Data Sets

	 9	 Creating Dynamic Worksheets by Using PivotTables

	 10	 Creating Charts and Graphics

	 11	 Printing

	 12	 Automating Repetitive Tasks by Using Macros

	 13	 Working with Other Microsoft Office Programs

	 14	 Collaborating with Colleagues

Microsoft PowerPoint 2010 Step by Step
By Joyce Cox and Joan Lambert (Microsoft Press, 2010) 
ISBN 978-0-7356-2691-1

Contents:

	 1	 Explore PowerPoint 2010

	 2	 Work with Slides

	 3	 Work with Slide Text

	 4	 Format Slides

	 5	 Add Simple Visual Enhancements
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	 6	 Review and Deliver Presentations

	 7	 Add Tables

	 8	 Fine-Tune Visual Elements

	 9	 Add Other Enhancements

	 10	 Add Animation

	 11	 Add Sound and Movies

	 12	 Share and Review Presentations

	 13	 Create Custom Presentation Elements

	 14	 Prepare for Delivery

	 15	 Customize PowerPoint

Microsoft Outlook 2010 Step by Step
By Joan Lambert and Joyce Cox (Microsoft Press, 2010) 
ISBN 978-0-7356-2690-4

Contents:

	 1	 Get Started with Outlook 2010

	 2	 Explore the Outlook Windows

	 3	 Send and Receive E-Mail Messages

	 4	 Store and Access Contact Information

	 5	 Manage Scheduling

	 6	 Track Tasks

	 7	 Organize Your Inbox

	 8	 Manage Your Calendar

	 9	 Work with Your Contact List

	 10	 Enhance Message Content

	 11	 Manage E-Mail Settings

	 12	 Work Remotely

	 13	 Customize Outlook
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Microsoft Access 2010 Step by Step
By Joyce Cox and Joan Lambert (Microsoft Press, 2010) 
ISBN 978-0-7356-2692-8

Contents:

	 1	 Explore an Access 2010 Database

	 2	 Create Databases and Simple Tables

	 3	 Create Simple Forms

	 4	 Display Data

	 5	 Create Simple Reports

	 6	 Maintain Data Integrity

	 7	 Create Custom Forms

	 8	 Create Queries

	 9	 Create Custom Reports

	 10	 Import and Export Data

	 11	 Make Databases User Friendly

	 12	 Protect Databases

	 13	 Customize Access

Let’s Get Started!
Office 2010 includes new features, new functionality, and an easy-to-use interface 
intended to streamline your computing experience and make it easier to learn new 
programs. We’re excited to bring you this glimpse into the inner workings of selected 
features in the core Office programs. We’ll start with the basics and work into the most 
interesting and necessary features of each program. If you are an experienced Office 
user, you can skim Chapter 1, “Explore Office 2010,” skip Chapter 2, “Work with Files,” 
and jump right into the program-specific chapters.
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Modifying the Display of the Ribbon
The goal of the Microsoft Office 2010 working environment is to make working with Office 
files—including Microsoft Word documents, Excel workbooks, PowerPoint presentations, 
Outlook e-mail messages, and Access databases—as intuitive as possible. You work with 
an Office file and its contents by giving commands to the program in which the docu-
ment is open. All Office 2010 programs organize commands on a horizontal bar called 
the ribbon, which appears across the top of each program window whether or not there 
is an active document.

Ribbon tabs Ribbon groups

A typical program window ribbon.

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some appear 
in galleries in which you can choose from among multiple options. Some groups have 
related dialog boxes or task panes that contain additional commands.

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this section, we discuss the general appearance 
of the ribbon, things that affect its appearance, and ways of locating commands that 
aren’t visible on compact views of the ribbon.

See Also  For detailed information about the ribbon, see “Working in the Program 
Environment” in Chapter 1, “Explore Office 2010.”

Tip  Some older commands no longer appear on the ribbon but are still available in the 
program. You can make these commands available by adding them to the Quick Access 
Toolbar. For more information, see “Customizing the Quick Access Toolbar” in Chapter 1, 
“Explore Office 2010.”
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Dynamic Ribbon Elements
The ribbon is dynamic, meaning that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the 
ribbon in the form of a large button, a small button, a small labeled button, or a list 
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons 
on the ribbon adapt to the available space.

For example, when sufficient horizontal space is available, the buttons on the Review 
tab of the Word program window are spread out and you’re able to see more of the 
commands available in each group.

Drop-down list Large buttonSmall labeled button

The Review tab of the Word program window at 1024 pixels wide.

If you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons are hidden under one button that represents the group. Click the group button 
to display a list of the commands available in that group.

Group button Small unlabeled buttons

The Review tab of the Word program window at 675 pixels wide.
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When the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.

Scroll arrow

The Review tab of the Word program window at 340 pixels wide.

Changing the Width of the Ribbon
The width of the ribbon is dependent on the horizontal space available to it, which 
depends on these three factors:

●	 The width of the program window  Maximizing the program window provides 
the most space for ribbon elements. You can resize the program window by 
clicking the button in its upper-right corner or by dragging the border of a 
non-maximized window.

On a computer running Windows 7, you can maximize the program window by 
dragging its title bar to the top of the screen.

●	 Your screen resolution  Screen resolution is the amount of information your screen 
displays, expressed as pixels wide by pixels high. The greater the screen resolution, the 
greater the amount of information that will fit on one screen. Your screen resolution 
options are dependent on your monitor. At the time of writing, possible screen reso-
lutions range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the greater 
the number of pixels wide (the first number), the greater the number of buttons that 
can be shown on the ribbon, and the larger those buttons can be.
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On a computer running Windows 7, you can change your screen resolution from 
the Screen Resolution window of Control Panel.

You set the resolution by dragging the pointer on the slider.

●	 The density of your screen display  You might not be aware that you can change the 
magnification of everything that appears on your screen by changing the screen mag- 
nification setting in Windows. Setting your screen magnification to 125% makes text 
and user interface elements larger on screen. This increases the legibility of informa-
tion, but it means that less information fits onto each screen.

On a computer running Windows 7, you can change the screen magnification from 
the Display window of Control Panel.

See Also  For more information about display settings, refer to Windows 7 Step by Step 
(Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows 
XP Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.
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You can choose one of the standard display magnification options or create another by setting 
a custom text size.

The screen magnification is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms 
are interchangeable, and in fact are both used in the Windows dialog box in which 
you change the setting.) The greater the dpi, the larger the text and user interface 
elements appear on screen. By default, Windows displays text and screen elements 
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and 
screen elements to 120 dpi. You can choose a custom setting of up to 500 percent 
magnification, or 480 dpi, in the Custom DPI Setting dialog box.

You can choose a magnification of up to 200 percent from the lists, or choose a greater 
magnification by dragging the ruler from left to right.
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Adapting Exercise Steps
The screen images shown in the exercises in this book were captured at a screen reso-
lution of 1024 × 768, at 100% magnification, and with the default text size (96 dpi).  
If any of your settings are different, the ribbon on your screen might not look the same 
as the one shown in the book. For example, you might see more or fewer buttons in 
each of the groups, the buttons you see might be represented by larger or smaller 
icons than those shown, or the group might be represented by a button that you 
click to display the group’s commands.

When  we instruct you to give a command from the ribbon in an exercise, we do it in 
this format:

●	 On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

●	 On the Page Layout tab, in the Page Setup group, click the Breaks button 
and then, in the list, click Page.

The first time we instruct you to click a specific button in each exercise, we display 
an image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to 
not appear as shown in the book, you can easily adapt the steps to locate the command. 
First, click the specified tab. Then locate the specified group. If a group has been collapsed 
into a group list or group button, click the list or button to display the group’s commands. 
Finally, look for a button that features the same icon in a larger or smaller size than that 
shown in the book. If necessary, point to buttons in the group to display their names in 
ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.
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Features and Conventions  
of This Book

This book has been designed to lead you step by step through tasks you’re likely to 
want to perform in Microsoft Word 2010, Excel 2010, PowerPoint 2010, OneNote 2010, 
Outlook 2010, Access 2010, and Publisher 2010. These programs are available as part of 
the Microsoft Office Professional 2010 software suite.

See Also  This book, Microsoft Office Professional 2010 Step by Step, includes a selection of 
instructional content for each program in the Office Professional 2010 software suite. For 
more complete coverage of the features of each of these programs, refer to the corresponding 
program-specific Step by Step book.

Each chapter of this book includes self-contained topics that teach you about specific 
program features. Most topics conclude with a step-by-step exercise in which you 
practice using the program. The following features of this book will help you locate 
specific information:

●	 Detailed table of contents  Scan the listing of the topics and sidebars within 
each chapter.

●	 Chapter thumb tabs  Easily locate the beginning of each chapter by looking 
at the colored blocks on the odd-numbered pages.

●	 Topic-specific running heads  Within a chapter, quickly locate a topic by looking 
at the running heads at the top of odd-numbered pages.

●	 Glossary  Look up the meaning of a word or the definition of a concept. The 
glossary for this book is available as online companion content. For more infor-
mation, see go.microsoft.com/fwlink/?LinkID=192155.

●	 Detailed index  Look up specific tasks and features in the index, which has been 
carefully crafted with the reader in mind.
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You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information. These 
conventions are listed in the following table.

Convention Meaning
SET UP This paragraph preceding a step-by-step exercise indicates the practice 

files that you will use when working through the exercise. It also indicates 
any requirements you should attend to or actions you should take before 
beginning the exercise.

CLEAN UP This paragraph following a step-by-step exercise provides instructions 
for saving and closing open files or programs before moving on to 
another topic. It also suggests ways to reverse any changes you made 
to your computer while working through the exercise.

1
2

Blue numbered steps guide you through hands-on exercises in  
each topic.

1

2

Black numbered steps guide you through procedures in sidebars and 
expository text.

See Also This paragraph directs you to more information about a topic in this 
book or elsewhere.

Troubleshooting This paragraph alerts you to a common problem and provides guidance 
for fixing it.

Tip This paragraph provides a helpful hint or shortcut that makes working 
through a task easier.

Important This paragraph points out information that you need to know to 
complete a procedure.

Keyboard Shortcut This paragraph provides information about an available keyboard 
shortcut for the preceding task.

Ctrl+B A plus sign (+) between two keys means that you must press those 
keys at the same time. For example, “Press Ctrl+B” means that you 
should hold down the Ctrl key while you press the B key.
Pictures of buttons appear in the margin the first time the button is 
used in an exercise.

Black bold In exercises that begin with SET UP information, the names of program 
elements, such as buttons, commands, windows, and dialog boxes, 
as well as files, folders, or text that you interact with in the steps, are 
shown in bold black type.

Blue bold In exercises that begin with SET UP information, text that you should 
type is shown in bold blue type.
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Using the Practice Files
Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, and other information, can be downloaded 
from the book’s detail page, located at:

http://go.microsoft.com/fwlink/?Linkid=192155

Display the detail page in your Web browser and follow the instructions for downloading 
the files.

Important  The Office Professional 2010 software suite is not available from this Web page. 
You should purchase and install that software suite before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 1:  
Explore Office 2010

None

Chapter 2: 
Work with Files

Prices_start.docx
Procedures_start.docx
Rules_start.docx

Chapter 3:  
Edit and Proofread Text

Bamboo_start.docx
Brochure_start.docx
Letter_start.docx
Orientation_start.docx
RulesRegulations_start.docx

Chapter 4:  
Change the Look of Text

AgendaA_start.docx
AgendaB_start.docx
Information_start.docx
OrientationDraft_start.docx
RulesDraft_start.docx

Chapter 5:  
Organize Information in 
Columns and Tables

ConsultationA_start.docx
ConsultationB_start.docx
RepairCosts_start.docx
RoomPlanner_start.docx
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Chapter File
Chapter 6:  
Add Simple Graphic  
Elements

Announcement_start.docx
Authors_start.docx
Flyer_start.docx
Joan.jpg
Joyce.jpg
MarbleFloor.jpg
OTSI-Logo.png

Chapter 7:  
Preview, Print, and  
Distribute Documents

InfoSheetA_start.docx
InfoSheetB_start.docx
InfoSheetC_start.docx
OfficeInfo_start.docx

Chapter 8: 
Set Up a Workbook

ExceptionSummary_start.xlsx
ExceptionTracking_start.xlsx
MisroutedPackages_start.xlsx
PackageCounts_start.xlsx
RouteVolume_start.xlsx

Chapter 9: 
Work with Data  
and Excel Tables

2010Q1ShipmentsByCategory_start.xlsx
AverageDeliveries_start.xlsx
DriverSortTimes_start.xlsx
Series_start.xlsx
ServiceLevels_start.xlsx

Chapter 10: 
Perform Calculations  
on Data

ConveyerBid_start.xlsx 
ITExpenses_start.xlsx
PackagingCosts_start.xlsx
VehicleMiles_start.xlsx

Chapter 11: 
Change Workbook 
Appearance

CallCenter_start.xlsx
Dashboard_start.xlsx
ExecutiveSearch_start.xlsx
HourlyExceptions_start.xlsx
HourlyTracking_start.xlsx
Phone.jpg
Texture.jpg
VehicleMileSummary_start.xlsx

Chapter 12: 
Focus on Specific Data  
by Using Filters

Credit_start.xlsx
ForFollowUp_start.xlsx
PackageExceptions_start.xlsx
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Chapter File
Chapter 13:  
Work with Slides

Projects.pptx
ServiceA_start.pptx
ServiceB_start.pptx
ServiceC_start.pptx
ServiceD_start.pptx
ServiceOrientation.docx

Chapter 14:  
Work with Slide Text

BuyingTripsB_start.pptx
BuyingTripsC_start.pptx
CommunityServiceA_start.pptx
CommunityServiceB_start.pptx
CommunityServiceC_start.pptx

Chapter 15:  
Format Slides

BusinessTravelA_start.pptx
BusinessTravelB_start.pptx
ColorDesign_start.pptx
CompanyMeetingA_start.pptx
CompanyMeetingB_start.pptx
LandscapingA_start.pptx

Chapter 16: 
Add Simple Visual 
Enhancements

Agastache.jpg
JournalingA_start.pptx
JournalingB_start.pptx
Penstemon.jpg
WaterConsumption.xlsx
WaterSavingA_start.pptx
WaterSavingB_start.pptx
WaterSavingC_start.pptx

Chapter 17:  
Review and Deliver 
Presentations

Harmony_start.pptx
Meeting_start.pptx
SavingWater_start.pptx
ServiceOrientationA_start.pptx
ServiceOrientationB_start.pptx
YinYang.png

Chapter 18: 
Explore OneNote 2010

None

Chapter 19: 
Create and Configure 
Notebooks

None
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Chapter File
Chapter 20: 
Create and Organize Notes

SBS Content Entry folder
ADatumLogo.png
Cabo.jpg
California_Poppy.jpg
Desert.jpg
Landscaping.pptx

Chapter 21: 
Send and Receive E-Mail 
Messages

Brochure.docx
StrategySession.pptx
SBS First Draft message (created in this chapter)

Chapter 22: 
Store and Access Contact 
Information

Andrea Dunker, Andrew Davis, Idan Rubin, Nancy Anderson, 
and Sara Davis contact records (created in this chapter)

Chapter 23: 
Manage Scheduling

SBS Lunch with Jane and SBS Staff Meeting appointments, 
SBS Pay Day event (created in this chapter)

Chapter 24: 
Track Tasks

SBS First Draft and SBS Tradeshow Schedule messages 
(created in Chapter 21)
SBS Dinner Reservations, SBS Order Brochures, and SBS Send 
Dinner Invitations tasks (created in this chapter)

Chapter 25: 
Explore an Access 2010 
Database

GardenCompany01_start.accdb

Chapter 26: 
Create Databases and Simple 
Tables

None

Chapter 27: 
Create Simple Forms

GardenCompany03_start.accdb
Logo.png

Chapter 28: 
Display Data

GardenCompany04_start.accdb

Chapter 29: 
Get Started with  
Publisher 2010

Importing.docx
Logo.png
Printing_start.pub

Chapter 30: 
Create Visual Interest

BirthdayGirl.jpg
Blank_start.pub
Text.docx

Chapter 31:
Create Colorful Cards and 
Calendars

DataSource.xlsx
Peaceful.jpg
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Getting Help
Every effort has been made to ensure the accuracy of this book. If you do run into 
problems, please contact the sources listed in the following sections.

Getting Help with This Book
If your question or issue concerns the content of this book or its practice files, please 
first consult the book’s errata page, which can be accessed at:

http://go.microsoft.com/fwlink/?Linkid=192155

This page provides information about known errors and corrections to the book. If 
you do not find your answer on the errata page, send your question or comment to 
Microsoft Press Technical Support at:

mspinput@microsoft.com

Your Companion eBook
The eBook edition of this book allows you to:

●	 Search the full text

●	 Print

●	 Copy and paste

To download your eBook, please see the instruction page at the back of this book.
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Getting Help with Office 2010
If your question is about one of the programs in the Microsoft Office Professional 2010  
software suite, and not about the content of this book, your first recourse is the Help 
system for the individual program. This system is a combination of tools and files stored 
on your computer when you installed the software suite or program and, if your computer 
is connected to the Internet, information available from the Microsoft Office Online Web 
site. You can find Help information in the following ways:

●	 To find out about an item on the screen, you can display a ScreenTip. For example, to 
display a ScreenTip for a button, point to the button without clicking it. The ScreenTip 
gives the button’s name, the associated keyboard shortcut if there is one, and some-
times a description of what the button does when you click it.

●	 In the program window, you can click the Help button (a question mark in a blue 
circle) at the right end of the ribbon to display the program-specific Help window. 

●	 At the right end of the title bars of some dialog boxes is a Help button (also a 
question mark) that you can click to display the program-specific Help window. 
Sometimes, topics related to the functions of that dialog box are already identified 
in the window.

To practice getting help, you can work through the following exercise.

SET UP  You don’t need any practice files to complete this exercise. Start Word, and 
then follow the steps.

	 1.	 At the right end of the ribbon, click the Microsoft Word Help button.

The Word Help window opens.
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You can change the size of the font in the window by clicking the Change Font Size button on 
the toolbar.

If you are connected to the Internet, clicking any of the buttons below the Microsoft 
Office banner (Products, Support, Images, and Templates) takes you to a correspond-
ing page of the Office Web site.
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	 2.	 Below the bulleted list under Browse Word 2010 support, click see all.

The window changes to display a list of Help topics.

	 3.	 In the list of topics, click Activating Word.

Word Help displays a list of topics related to activating Microsoft Office programs. 
You can click any topic to display the corresponding information.

	 4.	 On the toolbar, click the Show Table of Contents button.

The window expands to accommodate two panes. The Table Of Contents pane  
appears on the left. Like the table of contents in a book, it is organized in sections. 

If you’re connected to the Internet, Word displays sections, topics, and training 
available from the Office Online Web site as well as those stored on your computer.

Clicking any section (represented by a book icon) displays that section’s topics (represented by 
Help icons).
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	 5.	 In the Table of Contents pane, click a few sections and topics. Then click the Back 
and Forward buttons to move among the topics you have already viewed.

	 6.	 At the right end of the Table of Contents title bar, click the Close button.

	 7.	 At the top of the Word Help window, click the Type words to search for box, 
type saving, and then press the Enter key.

The Word Help window displays topics related to the word you typed.

Next and Back buttons appear, making it easier to search for the topic you want.



	 8.	 In the results list, click the Recover earlier versions of a file in Office 2010 topic.

The selected topic appears in the Word Help window.

	 9.	 Below the title at the top of the topic, click Show All.

Word displays any information that has been collapsed under a heading and 
changes the Show All button to Hide All. You can jump to related information  
by clicking hyperlinks identified by blue text.

Tip  You can click the Print button on the toolbar to print a topic. Only the displayed 
information is printed.

CLEAN UP  Click the Close button at the right end of the Word Help window.

More Information
If your question is about an Office 2010 program or another Microsoft software product 
and you cannot find the answer in the product’s Help system, please search the appro-
priate product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/
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	 5	 Organize 
		  Information in  
		  Columns and Tables
In this chapter, you will learn how to
✔	 Present information in columns.
✔	 Create tabbed lists.
✔	 Present information in tables.
✔	 Format tables.

Information in documents is most commonly presented as paragraphs of text. To make 
a text-heavy document more legible, you can flow the text in two or more columns, or 
you can display information in a table. For example, flowing text in multiple columns is 
a common practice in newsletters, flyers, and brochures; and presenting information in 
tables is common in reports.

When you need to present data in a document, using a table is often more efficient than 
describing the data in a paragraph, particularly when the data consists of numeric values. 
Tables make the data easier to read and understand. A small amount of data can be dis-
played in simple columns separated by tabs, which creates a tabbed list. A larger amount 
of data, or more complex data, is better presented in a table, which is a structure of rows 
and columns, frequently with row and column headings.

In this chapter, you’ll first create and modify columns of text. Then you’ll create a simple 
tabbed list. Finally, you’ll create tables from scratch and from existing text, and format 
a table in various ways.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter05 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

	 Contents

	 5	 Organize Information in Columns and Tables	 139
Presenting Information in Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        140
Creating Tabbed Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
Presenting Information in Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           149

Performing Calculations in Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    158
Other Layout Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               159

Formatting Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                       160
Quick Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                       164

Key Points  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              165



140    Chapter 5  Organize Information in Columns and Tables

Presenting Information in Columns
By default, Microsoft Word 2010 displays text in one column that spans the width of the 
page between the left and right margins. You can specify that text be displayed in two, 
three, or more columns to create layouts like those used in newspapers and magazines. 
When you format text to flow in columns, the text fills the first column on each page 
and then moves to the top of the next column. You can manually indicate where you 
want the text within each column to end.

The Columns gallery in the Page Setup group on the Page Layout tab displays several 
standard options for dividing text into columns. You can choose one, two, or three 
columns of equal width or two columns of unequal width. If the standard options 
don’t suit your needs, you can specify the number and width of columns. The number 
of columns is limited by the width and margins of the page, and each column must be 
at least a half inch wide.

The Columns gallery displays the predefined column options.

No matter how you set up the columns initially, you can change the layout or column 
widths at any time.

You can format an entire document or a section of a document in columns. When you 
select a section of text and format it as columns, Word inserts section breaks at the begin-
ning and end of the selected text to delineate the area in which the columnar formatting is 
applied. Within the columnar text, you can insert column breaks to specify where you want 
to end one column and start another. Section and column breaks are visible when you dis-
play formatting marks in the document.



Tip  You can apply many types of formatting, including page orientation, to content within 
a specific section of a document without affecting the surrounding text. For information 
about sections, see “Controlling What Appears on Each Page” in Chapter 7, “Preview, Print, 
and Distribute Documents.”

You can apply character and paragraph formatting to columnar text in the same way you 
would any text. Here are some formatting tips for columnar text:

●	 When presenting text in narrow columns, you can justify the paragraphs (align 
the text with the left and right edges) to achieve a neat and clean appearance. 
To justify the paragraphs, Word adjusts the spacing between words, essentially 
moving the empty space that would normally appear at the end of the line into 
the gaps between words.

●	 To more completely fill columns, you can have Word hyphenate the text to break 
words into syllables to fill up the gaps.

In this exercise, you’ll flow the text in one section of a document into three columns. 
You’ll justify the text in the columns, change the column spacing, and hyphenate the 
text. You’ll then break a column at a specific location instead of allowing the text to flow 
naturally from one column to the next.

SET UP  You need the RoomPlanner_start document located in your Chapter05 practice 
file folder to complete this exercise. Open the RoomPlanner_start document, and save 
it as RoomPlanner. Then display formatting marks and the rulers, and follow the steps.

	 1.	 Click at the beginning of the paragraph that begins Take a look (do not click in the 
selection area). Then scroll down until you can see the end of the document, hold 
down the Shift key, and click to the right of the paragraph mark after credit cards.

Word selects the text from the Take a look paragraph through the end of the last 
paragraph (but not the empty paragraph).

Tip  If you want to format an entire document with the same number of columns, you 
can simply click anywhere in the document—you don’t have to select the text.

	 2.	 On the Page Layout tab, in the Page Setup group, click the Columns button, and 
then in the Columns gallery, click Three.

Word inserts a section break above the selected text and flows the text within the 
section into three columns.
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	 3.	 Press Ctrl+Home to move to the top of the document.

The section break is visible above the columns.

A continuous section break changes the formatting of the subsequent text but keeps it on the 
same page.

	 4.	 On the Home tab, in the Editing group, click the Select button, and then click 
Select All.

Keyboard Shortcut  Press Ctrl+A to select all the text in the document.

	 5.	 In the Paragraph group, click the Justify button.

Keyboard Shortcut  Press Ctrl+J to justify paragraphs.

The spacing between the words changes to align all the paragraphs in the document 
with both the left and right margins. Because you applied the formatting to the entire 
document, the title is no longer centered. However, it is often quicker to apply format-
ting globally and then deal with the exceptions.



	 6.	 Press Ctrl+Home to move to the paragraph containing the document title. Then in 
the Paragraph group, click the Center button.

Keyboard Shortcut  Press Ctrl+E to center text.

Word centers the document title between the left and right margins.

	 7.	 Adjust the zoom percentage until you can see about two-thirds of the first page of 
the document.

See Also  For information about adjusting the zoom percentage, see “Viewing Files 
in Different Ways” in Chapter 2, “Work with Files.”

	 8.	 Click anywhere in the first column.

On the horizontal ruler, Word indicates the margins of the columns.

On the ruler, the indent markers show the indentation of the active column.

Tip  If your rulers aren’t turned on, select the Ruler check box in the Show group of the 
View tab.
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	 9.	 On the Page Layout tab, display the Columns gallery, and click More Columns.

The Columns dialog box opens. The spacing between columns is set by default to a 
half inch.

Because the Equal Column Width check box is selected, you can adjust the width  
and spacing of only the first column.

Tip  To separate the columns with vertical lines, select the Line Between check box.

	 10.	 In the Width and spacing area, in the Spacing box for column 1, type or 
select 0.2".

Word changes the measurement in the Spacing box for column 2, and widens all 
the columns in the Preview area to reflect the new setting.

	 11.	 Click OK.

Word reflows the columns to fit their new margins.



Wider columns generally look neater on the page.

	 12.	 Click at the beginning of the Take a look paragraph. Then in the Page Setup 
group, click the Hyphenation button, and click Automatic.

Word hyphenates the text of the document, which fills in some of the large gaps 
between words.

	 13.	 Click anywhere in the NOTE paragraph in the third column.

	 14.	 On the horizontal ruler, at the left end of the third column, drag the Hanging 
Indent marker 0.25 inch (two marks) to the right.

All the lines in the NOTE paragraph except the first are now indented, offsetting 
the note from the paragraphs above and below it.
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You can change the indentation of individual paragraphs within a column.

	 15.	 Display the bottom of page 1. In the first column on page 1, click at the beginning 
of the Take your Room Planner home paragraph. Then in the Page Setup group, 
click the Breaks button, and click Column.

Word inserts a column break. The text that follows the column break moves to the 
top of the second column.

	 16.	 At the bottom of the third column on page 1, click at the beginning of the If you’re 
not sure paragraph, and then on the Quick Access Toolbar, click the Repeat Insertion 
button to insert another column break.

Keyboard Shortcut  Press Ctrl+Y to repeat the previous action.

Word inserts a column break. The text that follows the column break moves to the 
top of the first column on page 2.

CLEAN UP  Return the Zoom Level setting to 100%, and then save and close the 
RoomPlanner document.



Creating Tabbed Lists
If you have a relatively small amount of data to present, you might choose to display 
it in a tabbed list, which arranges text in simple columns separated by tabs. You can 
align the text within the columns by using left, right, centered, or decimal tab stops.

See Also  For more information about setting tab stops, see “Manually Changing the Look of 
Paragraphs” in Chapter 4, “Change the Look of Text.”

When entering text in a tabbed list, inexperienced Word users have a tendency to 
press the Tab key multiple times to align the columns of the list with the default tab 
stops. If you do this, you have no control over the column widths. To be able to  
fine-tune the columns, you need to set custom tab stops rather than relying on the 
default ones. 

When setting up a tabbed list, you should press Tab only once between the items that 
you want to appear in separate columns. Next you apply any necessary formatting. And 
finally, you set the custom tab stops. Set left, right, centered, and decimal tabs to control 
the alignment of the column content, or set a bar tab to add a vertical line to visually 
separate list columns. By setting the tabs in order from left to right, you can check the 
alignment of the text within each column as you go.

In this exercise, you’ll first enter text separated by tabs and format the text. Then you’ll 
set custom tab stops to create a tabbed list.

SET UP  You need the ConsultationA_start document located in your Chapter05 
practice file folder to complete this exercise. Open the ConsultationA_start 
document, and save it as ConsultationA. Then display formatting marks and the 
rulers, and follow the steps.

	 1.	 Set the zoom percentage to a level that is comfortable for you, and then press 
Ctrl+End to move the cursor to the blank line at the end of the document.

	 2.	 Type Location, press Tab, type Discount Applies, press Tab, type Hourly Rate, 
and then press Enter.

	 Creating Tabbed Lists    147



148    Chapter 5  Organize Information in Columns and Tables

	 3.	 Add three more lines to the list by typing the following text, pressing the Tab and 
Enter keys where indicated.

In home Tab No Tab $50.00 Enter
Phone Tab Yes Tab $35.00 Enter
In store Tab Yes Tab $40.00 Enter

The tab characters push the items to the next default tab stop, but because some 
items are longer than others, they do not line up.

In a tabbed list, it’s important to press the Tab key only once between items.

	 4.	 Select the first line of the tabbed list, and then on the Mini Toolbar that appears, 
click the Bold button.

Troubleshooting  If the Mini Toolbar doesn’t appear, click the Bold button in the Font 
group on the Home tab.

Keyboard Shortcut  Press Ctrl+B to apply bold.

	 5.	 Select all four lines of the tabbed list, and then on the Mini Toolbar, click the 
Increase Indent button.

Tip  It’s more efficient to make all character and paragraph formatting changes to the 
text before setting tab stops. Otherwise, you might have to adjust the tab stops after 
applying the formatting.

	 6.	 With the tabbed list still selected, on the Page Layout tab, in the Paragraph 
group, under Spacing, change the After setting to 0 pt.

	 7.	 Click the tab setting button at the junction of the horizontal and vertical rulers until 
the Center Tab button is active. (You will probably have to click only once.) Then 
click the 2.5 inch mark on the horizontal ruler.



On the ruler, Word sets a center-aligned tab stop that looks like the Center Tab icon. 
The items in the second column of the tabbed list center themselves at that position.

	 8.	 Click the tab setting button once.

The Right Tab button is now active.

	 9.	 With the Right Tab button active, click the horizontal ruler at the 4.5 inch mark.

On the ruler, Word sets a right-aligned tab stop that looks like the Right Tab icon. The 
items in the third column of the tabbed list right-align themselves at that position.

	 10.	 On the Home tab, in the Paragraph group, click the Show/Hide ¶ button to hide 
the tabs, paragraph marks, and other formatting marks. Then click away from the 
tabbed list to see the results.

The tabbed list resembles a simple table.

You have created a simple table-like layout with just a few clicks.

CLEAN UP  Save the ConsultationA document, and then close it.

Presenting Information in Tables
A table is a structure of vertical columns and horizontal rows. Each column and each row 
can be named with a heading, although some tables have only column headings or only 
row headings. At the junction of each column and row is a box called a cell in which data 
(text or numeric information) is stored.
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You can create empty or predefined tables in a Word document in the following ways:

●	 The Insert Table gallery, which is available from the Tables group on the Insert tab, 
displays a simple grid. 

You can create a simple table from the grid in the Insert Table gallery.

Clicking a cell in the grid inserts an empty table the width of the text column. The 
table has the number of rows and columns you indicated in the grid, with all the rows 
one line high and all the columns of an equal width.

●	 To insert a more customized empty table, you can click Insert Table on the menu at 
the bottom of the Insert Table gallery to open the Insert Table dialog box, in which 
you can specify the number of rows and columns and customize the column width.

You can create a custom-width table from the Insert Table dialog box.



●	 To insert a less clearly defined empty table, you can click Draw Table below the grid 
in the Insert Table gallery. This command displays a pencil with which you can draw 
cells directly in the Word document to create a table. The cells you draw connect by 
snapping to a grid, but you have some control over the size and spacing of the rows 
and columns.

You can draw a table directly on the page.

See Also  For information about drawing tables, refer to Microsoft Word 2010 Step 
by Step, by Joyce Cox and Joan Lambert (Microsoft Press, 2010).

●	 In addition to empty tables, you can insert any of the available Quick Tables, 
which are predefined tables of formatted data that you can replace with your 
own information. Built-in Quick Tables include a variety of calendars, simple  
tables, tables with subheadings, and tabbed lists. You can also save your own 
custom tables to the Quick Tables gallery so that you can easily insert a frequently 
used table structure and data into any document.

The Quick Tables gallery includes a selection of predefined tables such as this one.
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A new table appears in the document as a set of cells, usually bordered by gridlines. (In 
some Quick Tables, the gridlines are turned off.) Each cell contains an end-of-cell marker, 
and each row ends with an end-of-row marker. (The end-of-cell markers and end-of-row 
markers are identical in appearance, and are visible only when you display formatting 
marks in the document.) When you point to a table, a move handle appears in its upper-
left corner and a size handle in its lower-right corner. When the cursor is in a table, two 
Table Tools contextual tabs—Design and Layout—appear on the ribbon.

Move handle End-of-cell marker
End-of-row marker
Size handle

A table has its own controls and its own contextual ribbon tabs.

Tip  The move handle and size handle appear only in Print Layout view and Web Layout view.

After you create a table, you can enter data (such as text, numbers, or graphics) into the 
table cells and press the Tab key to move the cursor from cell to cell. Pressing Tab when the 
cursor is in the last cell of a row moves the cursor to the first cell of the next row. Pressing 
Tab when the cursor is in the last cell of the last row adds a new row to the table and moves 
the cursor to the first cell of that row.

Tip  You can move and position the cursor by pressing the Tab key or the Arrow keys, or by 
clicking in a table cell.

If the data you want to present in a table already exists in the document, either as regular 
text or as a tabbed list, you can convert the text to a table by selecting it and then clicking 
Convert Text To Table in the Insert Table gallery. Conversely, you can convert an active table 
to regular text by clicking the Convert To Text button in the Data group on the Layout tab.

You can modify a table’s structure by changing the size of the table, changing the size of 
one or more columns or rows, or adding or removing rows, columns, or individual cells. 



Tip  To change a table’s structure, you often need to select the entire table or a specific column 
or row. The simplest way to do this is to position the cursor in the table, column, or row, click the 
Select button in the Table group on the Layout tab, and then click the table element you want. 
Alternatively, you can point to the top edge of a column or left edge of a row and, when the 
pointer changes to an arrow, click to select the column or row.

The basic methods for manipulating a table or its contents are as follows:

●	 Insert a row or column  Click anywhere in a row or column adjacent to where you 
want to make the insertion. Then on the Layout tab, in the Rows & Columns group, 
click the Insert Above, Insert Below, Insert Left, or Insert Right button.

The Rows & Columns group of the Layout tab.

Selecting more than one row or column before you click an Insert button inserts 
that number of rows or columns in the table.

Tip  You can insert cells by clicking the Rows & Columns dialog box launcher and 
specifying in the Insert Cells dialog box how adjacent cells should be moved to 
accommodate the new cells.

●	 Delete a row or column  Click anywhere in the row or column, and in the Rows & 
Columns group, click the Delete button. Then click Delete Cells, Delete Columns, 
Delete Rows, or Delete Table.

●	 Resize an entire table  Drag the size handle.

●	 Resize a single column or row  Without selecting the column, drag its right border 
to the left or right. Without selecting the row, drag its bottom border up or down. 
(If you select a column or row and then drag its border, only the selected column 
or row changes.)

●	 Move a table  Point to the table, and then drag the move handle that appears in 
its upper-left corner to a new location. Or use the Cut and Paste commands in the 
Clipboard group on the Home tab to move the table.

●	 Merge cells  Create cells that span multiple columns or rows by selecting the cells 
you want to merge and clicking the Merge Cells button in the Merge group on the 
Layout tab. For example, to center a title in the first row of a table, you can merge 
all the cells in the row to create one merged cell that spans the table’s width.
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●	 Split cells  Divide one cell into multiple cells by clicking the Split Cells button in the 
Merge group on the Layout tab and then specifying the number of columns and 
rows you want.

●	 Sort information  Click the Sort button in the Data group on the Layout tab to sort 
the rows in ascending or descending order by the data in any column. For example, 
in a table that has the column headings Name, Address, ZIP Code, and Phone 
Number, you can sort on any one of those columns to arrange the information in 
alphabetical or numerical order.

In this exercise, you’ll work with two tables. First you’ll create an empty table, enter and 
align text in the table cells, add rows to the table, and merge cells. Then you’ll create a 
second table by converting an existing tabbed list, change the width of a column, and 
change the width of the entire table.

SET UP  You need the ConsultationB_start document located in your Chapter05 practice 
file folder to complete this exercise. Open the ConsultationB_start document, and save it 
as ConsultationB. Then display formatting marks and the rulers, and follow the steps.

	 1.	 Click to the left of the second blank paragraph below Please complete this form.

	 2.	 On the Insert tab, in the Tables group, click the Table button. Then in the Insert 
Table gallery, point to (don’t click) the cell that is five columns to the right and five 
rows down from the upper-left corner of the grid.

Word highlights the cells that will be in the table, indicates the table dimensions 
in the gallery header, and creates a temporary table in the document.

You can preview the table with the number of columns and rows you have specified.



	 3.	 Click the cell.

Word creates a blank table consisting of five columns and five rows. The cursor is 
located in the first cell. Because the table is active, Word displays the Design and 
Layout contextual tabs.

	 4.	 In the selection area to the left of the table, point to the first row of the table, and 
then click once to select it.

	 5.	 On the Layout contextual tab, in the Merge group, click the Merge Cells button.

Word combines the five cells in the first row into one cell.

	 6.	 With the merged cell selected, in the Alignment group, click the Align Center button.

The end-of-cell marker moves to the exact center of the merged cell to indicate 
that anything you type there will be centered both horizontally and vertically.

	 7.	 Type Consultation Estimate.

The table now has content that looks like a table title.

Merged cells are often used for table titles and column headings.

	 8.	 Click the first cell in the second row, type Type, and then press Tab.

	 9.	 Type Location, Consultant, Hourly Rate, and Total, pressing Tab after each entry.

Pressing Tab after the Total heading moves the cursor to the first cell of the third 
row. The table now has a row of column headings.

	 10.	 Select the column heading row, and then on the Mini Toolbar, click the Bold button.

	 11.	 In the third row, type Window treatments, In home, Andy Ruth, $50.00, and 
$50.00, pressing Tab after each entry.

You have entered a complete row of data.

	 12.	 Select the last two rows, and then on the Layout tab, in the Rows & Columns 
group, click the Insert Below button.

Word adds two new rows and selects them.

	 13.	 In the last row, click the first cell, hold down the Shift key, and then press the Right 
Arrow key four times to select the first four cells in the row.
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	 14.	 In the Merge group, click the Merge Cells button.

Word combines the selected cells into one cell.

	 15.	 In the Alignment group, click the Align Center Right button.

	 16.	 Type Subtotal, and then press Tab twice.

Word adds a new row with the same structure to the bottom of the table.

When you add a new row, it has the same format as the one it is based on.

	 17.	 Type Add trip fee, press Tab twice to add a new row, and then type Total.

Now you’ll create a different table by converting existing text.

	 18.	 Scroll down to the bottom of the document, and select the rows of the tabbed list 
beginning with Distance and ending with $20.00.

	 19.	 On the Insert tab, in the Tables group, click the Table button, and then click 
Convert Text to Table.

The Convert Text To Table dialog box opens.

You can separate text into columns based on the symbol you specify.



	 20.	 Verify that the Number of columns box displays 2, and then click OK.

The selected text appears in a table with two columns and six rows.

	 21.	 Click anywhere in the table to release the selection, and then point to the right 
border of the table. When the pointer changes to two opposing arrows, double-
click the border.

Word adjusts the width of the right column to accommodate its longest cell 
entry.

Tip  You can also adjust the column width by changing the Table Column Width setting 
in the Cell Size group on the Layout tab.

	 22.	 Point to the In-Home Trip Charge table.

Word displays the move handle in the upper-left corner and the size handle in 
the lower-right corner.

	 23.	 Drag the size handle to the right, releasing the mouse button when the right 
edge of the table aligns approximately with the 4 inch mark on the horizontal 
ruler.

The width of the table expands.

The table is now approximately as wide as the tabbed list above, creating a nice balance.

CLEAN UP  Save the ConsultationB document, and then close it.
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Performing Calculations in Tables

When you want to perform calculations with the numbers in a Word table, you 
can create a formula that uses a built-in mathematical function. You construct a 
formula by using the tools in the Formula dialog box, which you display by clicking 
the Formula button in the Data group on the Layout contextual tab. 

The Formula dialog box.

A formula consists of an equal sign (=), followed by a function name (such as SUM), 
followed by parentheses containing the location of the cells you want to use for the 
calculation. For example, the formula =SUM(Left) totals the cells to the left of the 
cell containing the formula.

To use a function other than SUM in the Formula dialog box, you click the function 
you want in the Paste Function list. You can use built-in functions to perform a num-
ber of calculations, including averaging (AVERAGE) a set of values, counting (COUNT) 
the number of values in a column or row, or finding the maximum (MAX) or minimum 
(MIN) value in a series of cells.

Although formulas commonly refer to the cells above or to the left of the active cell, 
you can also use the contents of specified cells or constant values in formulas. To 
use the contents of a cell, you type the cell address in the parentheses following the 
function name. The cell address is a combination of the column letter and the row 
number—for example, A1 is the cell at the intersection of the first column and the 
first row. A series of cells in a row can be addressed as a range consisting of the first 
cell and the last cell separated by a colon, such as A1:D1. For example, the formula 
=SUM(A1:D1) totals the values in row 1 of columns A through D. A series of cells in a 
column can be addressed in the same way. For example, the formula =SUM(A1:A4) 
totals the values in column A of rows 1 through 4.



Other Layout Options

You can control many aspects of a table in the Table Properties dialog box, 
which you display by clicking the Properties button in the Table group on the 
Layout tab. You can set the following options:

●	 On the Table page, you can specify the width of the entire table, as well as the 
way it interacts with the surrounding text.

●	 On the Row page, you can specify the height of each row, whether a row is 
allowed to break across pages, and whether a row of column headings should 
be repeated at the top of each page. 

Tip  The Repeat As Header Row option is available only if the cursor is in the top 
row of the table.

●	 On the Column page, you can set the width of each column.

●	 On the Cell page, you can set the width of cells and the vertical alignment of 
text within them.

Tip  You can also control the widths of selected cells by changing the settings in 
the Cell Size group on the Layout tab.

●	 On either the Table page or Cell page, you can control the margins of cells 
(how close text comes to the cell border) by clicking Options and specifying 
top, bottom, left, and right settings.

Tip  You can also control the margins by clicking the Cell Margins button in the 
Alignment group on the Layout tab.

●	 On the Alt Text page, you can enter text that describes what the table is 
about.
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Formatting Tables
Formatting a table to best convey its data can be a process of trial and error. With Word 
2010, you can quickly get started by applying one of the table styles available in the 
Table Styles gallery on the Design contextual tab. 

The table styles include a variety of borders, colors, and other attributes to give the table a  
professional look.

If you want to control the appearance of a table more precisely, you can use the commands 
on the Design and Layout tabs. You can also format the table content. As you saw in the 
previous exercise, you can apply character formatting to the text in tables just as you would 
to regular text, by clicking buttons on the Mini Toolbar. You can also click the buttons in the 
Font group on the Home tab. You can apply paragraph formatting, such as alignment and 
spacing, by clicking buttons in the Paragraph group on the Home tab. And you can apply 
both character and paragraph styles from the Quick Styles gallery.



In this exercise, you’ll first apply a table style to a table. Then you’ll format a table row 
and column. You’ll also apply character and paragraph formatting to various cells so 
that the table’s appearance helps the reader understand its data.

SET UP  You need the RepairCosts_start document located in your Chapter05 practice 
file folder to complete this exercise. Open the RepairCosts_start document, and save it 
as RepairCosts. If formatting marks are displayed, hide them, and then follow the steps.

	 1.	 Click anywhere in the table, and then on the Design tab, point to each thumbnail 
in the first row of the Table Styles gallery to see its live preview.

	 2.	 In the Table Style Options group, clear the Banded Rows check box, and select 
the Total Row check box.

The table style thumbnails no longer have banded rows, reflecting your changes.

	 3.	 In the Table Styles group, click the More button.

The Table Styles gallery appears.

	 4.	 Preview all the styles in the gallery. When you finish exploring, click the second 
thumbnail in the fifth row (Medium Shading 2 – Accent 1).

The style needs to be modified to suit the data, but it’s a good starting point.

This table style applies formatting to the header and total rows, the first column, and the 
text of the table.
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	 5.	 Select all the cells in the last row by clicking in the selection area to its left. Then in 
the Table Styles group, click the Borders arrow, and click Borders and Shading.

The Borders And Shading dialog box opens, displaying the borders applied to the 
selected cells.

	 6.	 On the Borders page of the dialog box, scroll to the top of the Style list, and click 
the thick black border. 

	 7.	 In the Preview area, click the top border button once to remove the current border, 
and click again to apply the thick black border.

	 8.	 Click the Shading tab, and click the Fill arrow. Under Theme Colors in the palette, 
click the fifth box in the top row (Blue, Accent 1). Then click OK.

	 9.	 Without moving the selection, on the Home tab, in the Font group, click the Font 
Color arrow, and under Theme Colors in the palette, click the white box. Then 
press Home to release the selection.

The table now has the same border at the top and bottom.

You can customize a table style to meet your needs.

	 10.	 Point to the left side of the Elastomeric Decks cell, and when the pointer changes 
to a black right-pointing arrow, drag downward to select all the cells in the Item 
column except the TOTAL cell. 



	 11.	 On the Design tab, in the Table Styles group, click the Shading arrow, and 
under Theme Colors, click the third box in the blue column (Blue, Accent 1, 
Lighter 40%).

	 12.	 Select all the cells containing amounts in the Cost, $ column, including the cell with 
the total. Then on the Layout tab, in the Alignment group, click the Align Center 
Right button.

Tip  If the first row of your table has several long headings that make it difficult to fit the 
table on one page, you can turn the headings sideways. Simply select the heading row 
and click the Text Direction button in the Alignment group on the Layout tab.

Now you can judge how well the table displays its data.

The total now stands out better, and the amounts are easier to read.

Tip  If you will need to use this formatted table with different data in the future, you can 
save it as a Quick Table. For information about saving customized tables for future use, 
see the sidebar “Quick Tables” on the next page.

CLEAN UP  Save the RepairCosts document, and then close it.
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Quick Tables

With Word 2010, you can create Quick Tables—preformatted tables with sample 
data that you can customize. To create a Quick Table:

	 1.	 On the Insert tab, in the Tables group, click the Table button, and then point 
to Quick Tables.

The Quick Tables gallery appears.

The predefined Quick Tables meet several common needs.

	 2.	 Scroll through the gallery, noticing the types of tables that are available, and 
then click the one you want.

For example, this is the Matrix Quick Table.

The Matrix Quick Table includes row and column headings, placeholder data, and no 
summary data, such as totals.



	 3.	 On the Design tab, apply formatting to tailor the Quick Table to your needs.

For example, here’s the Matrix Quick Table after we formatted it.

It is easy to customize a Quick Table for your own needs.

If you will use the table again, you can save it in the Quick Tables gallery. Select 
the table, display the Quick Tables gallery, and click Save Selection To Quick Tables 
Gallery. Then in the Create New Building Block dialog box, assign a name to the table, 
and click OK. Provided you save the Building Blocks template when Word prompts 
you to, the table will be available in the Quick Tables gallery for future use.

See Also  For information about building blocks, see “Inserting Building Blocks” in 
Chapter 6, “Add Simple Graphic Elements.”

Key Points
●	 To vary the layout of a document, you can divide text into columns. You can 

control the number of columns, the width of the columns, and the space between 
the columns.

●	 To clearly present a simple set of data, you can use tabs to create a tabbed list, 
with custom tab stops controlling the width and alignment of columns.

●	 You can create a table from scratch, or convert existing text to a table. You can 
control the size of the table and its individual structural elements.

●	 By using the built-in table styles, you can quickly apply professional-looking cell 
and character formatting to a table and its contents.

●	 You can enhance a table and its contents by applying text attributes, borders, and 
shading.
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	11	 Change Workbook 
		  Appearance

In this chapter, you will learn how to
✔	 Format cells.
✔	 Define styles.
✔	 Apply workbook themes and Excel table styles.
✔	 Make numbers easier to read.
✔	 Change the appearance of data based on its value.
✔	 Add images to worksheets.

Entering data into a workbook efficiently saves you time, but you must also ensure  
that your data is easy to read. Microsoft Excel 2010 gives you a wide variety of ways  
to make your data easier to understand; for example, you can change the font, character 
size, or color used to present a cell’s contents. Changing how data appears on a work-
sheet helps set the contents of a cell apart from the contents of surrounding cells. The 
simplest example of that concept is a data label. If a column on your worksheet contains 
a list of days, you can easily set apart a label (for example, Day) by presenting it in bold 
type that’s noticeably larger than the type used to present the data to which it refers. To 
save time, you can define a number of custom formats and then apply them quickly 
to the desired cells.

You might also want to specially format a cell’s contents to reflect the value in that cell. 
For example, Lori Penor, the chief operating officer of Consolidated Messenger, might 
want to create a worksheet that displays the percentage of improperly delivered packages 
from each regional distribution center. If that percentage exceeds a threshold, she could 
have Excel display a red traffic light icon, indicating that the center’s performance is out 
of tolerance and requires attention. 
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In this chapter, you’ll learn how to change the appearance of data, apply existing formats 
to data, make numbers easier to read, change data’s appearance based on its value, and 
add images to worksheets.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter11 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Formatting Cells
Excel spreadsheets can hold and process lots of data, but when you manage numerous 
spreadsheets it can be hard to remember from a worksheet’s title exactly what data is 
kept in that worksheet. Data labels give you and your colleagues information about data 
in a worksheet, but it’s important to format the labels so that they stand out visually. To 
make your data labels or any other data stand out, you can change the format of the 
cells that hold your data.

Include data labels to identify the data in a worksheet.



Most of the tools you need to change a cell’s format can be found on the Home tab. You 
can apply the formatting represented on a button by selecting the cells you want to apply 
the style to and then clicking that button. If you want to set your data labels apart by 
making them appear bold, click the Bold button. If you have already made a cell’s con-
tents bold, selecting the cell and clicking the Bold button will remove the formatting.

Tip  Deleting a cell’s contents doesn’t delete the cell’s formatting. To delete a selected cell’s 
formatting, on the Home tab, in the Editing group, click the Clear button (which looks like an 
eraser), and then click Clear Formats. Clicking Clear All from the same list will remove the cell’s 
contents and formatting.

Buttons in the Home tab’s Font group that give you choices, such as the Font Color 
button, have an arrow at the right edge of the button. Clicking the arrow displays a list 
of options accessible for that button, such as the fonts available on your system or the 
colors you can assign to a cell.

The Font Color gallery.
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Another way you can make a cell stand apart from its neighbors is to add a border around 
the cell. To place a border around one or more cells, select the cells, and then choose the 
border type you want by selecting from the Border list in the Font group. Excel does 
provide more options: To display the full range of border types and styles, in the Border 
list, click More Borders. The Format Cells dialog box opens, displaying the Border page.

The Border page of the Format Cells dialog box contains the full range of tools you can use to  
define your cells’ borders.

You can also make a group of cells stand apart from its neighbors by changing its shading, 
which is the color that fills the cells. On a worksheet that tracks total package volume for 
the past month, Lori Penor could change the fill color of the cells holding her data labels 
to make the labels stand out even more than by changing the labels’ text formatting.

Tip  You can display the most commonly used formatting controls by right-clicking a selected 
range. When you do, a Mini Toolbar containing a subset of the Home tab formatting tools 
appears above the shortcut menu.

If you want to change the attributes of every cell in a row or column, you can click the 
header of the row or column you want to modify and then select your desired format.



One task you can’t perform by using the tools on the Home tab is to change the stan-
dard font for a workbook, which is used in the Name box and on the formula bar. The 
standard font when you install Excel is Calibri, a simple font that is easy to read on a 
computer screen and on the printed page. If you want to choose another font, click the  
File tab, and then click Options. On the General page of the Excel Options dialog box, set 
the values in the Use This Font and Font Size list boxes to pick your new display font.

Important  The new standard font doesn’t take effect until you exit Excel and restart the 
program.

In this exercise, you’ll emphasize a worksheet’s title by changing the format of cell data, 
adding a border to a cell range, and then changing a cell range’s fill color. After those 
tasks are complete, you’ll change the default font for the workbook.

SET UP  You need the VehicleMileSummary_start workbook located in your 
Chapter11 practice file folder to complete this exercise. Start Excel, open the 
VehicleMileSummary_start workbook, and save it as VehicleMileSummary. Then 
follow the steps. 

	 1.	 Click cell D2.

	 2.	 On the Home tab, in the Font group, click the Bold button.

Excel displays the cell’s contents in bold type.

	 3.	 In the Font group, click the Font Size arrow, and then in the list, click 18.

Excel increases the size of the text in cell D2.

Larger text simulates a page header.
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	 4.	 Click cell B5, hold down the Ctrl key, and click cell C4 to select the non-contiguous 
cells.

	 5.	 On the Home tab, in the Font group, click the Bold button.

Excel displays the cells’ contents in bold type.

	 6.	 Select the cell ranges B6:B15 and C5:H5.

	 7.	 In the Font group, click the Italic button.

Excel displays the cells’ contents in italic type.

Local formatting such as bold and italic emphasizes cell content.

	 8.	 Select the cell range C6:H15.

	 9.	 In the Font group, click the Border arrow, and then in the list, click Outside 
Borders.

Excel places a border around the outside edge of the selected cells.

	 10.	 Select the cell range B4:H15.

	 11.	 In the Border list, click Thick Box Border.

Excel places a thick border around the outside edge of the selected cells.

	 12.	 Select the cell ranges B4:B15 and C4:H5.

	 13.	 In the Font group, click the Fill Color arrow, and then in the Standard Colors area 
of the color palette, click the yellow button.

Excel changes the selected cells’ background color to yellow.



You can distinguish header cells from other cells by applying a background color.

Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.

	 14.	 Click the File tab, and then click Options.

The Excel Options dialog box opens.

	 15.	 If necessary, click General to display the General page.

	 16.	 In the When creating new workbooks area, in the Use this font list, click Verdana.

Verdana appears in the Use This Font field.

	 17.	 Click Cancel.

The Excel Options dialog box closes without saving your change.

CLEAN UP  Save the VehicleMileSummary workbook, and then close it.
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Defining Styles
As you work with Excel, you will probably develop preferred formats for data labels, 
titles, and other worksheet elements. Instead of adding a format’s characteristics one 
element at a time to the target cells, you can have Excel store the format and recall it 
as needed. You can find the predefined formats by displaying the Home tab, and then  
in the Styles group, clicking Cell Styles.

You can choose a style from the Cell Styles gallery, or create a custom style.

Clicking a style from the Cell Styles gallery applies the style to the selected cells, 
but Excel also displays a live preview of a format when you point to it. If none of the 
existing styles is what you want, you can create your own style by clicking New Cell 
Style at the bottom of the gallery to display the Style dialog box. In the Style dialog 
box, type the name of your new style in the Style Name field, and then click Format. 
The Format Cells dialog box opens.



A custom style can include number, alignment, font, and border formatting.

After you set the characteristics of your new style, click OK to make your style available 
in the Cell Styles gallery. If you ever want to delete a custom style, display the Cell Styles 
gallery, right-click the style, and then click Delete.

If all you want to do is apply formatting from one cell to the contents of another cell, use 
the Format Painter tool in the Clipboard group on the Home tab. Just click the cell that 
has the format you want to copy, click the Format Painter button, and then click the cells 
to which you want to apply the copied format. To apply the same formatting to multiple 
cells, double-click the Format Painter button and then click the target cells. When you’re 
done applying the formatting, press the Esc key.

In this exercise, you’ll create a style and apply the new style to a data label. 

SET UP  You need the HourlyExceptions_start workbook located in your Chapter11 
practice file folder to complete this exercise. Open the HourlyExceptions_start 
workbook, and save it as HourlyExceptions. Then follow the steps. 

	 1.	 On the Home tab, in the Styles group, click Cell Styles, and then click New Cell Style.

The Style dialog box opens.
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The elements of the current style are described in the Cell Style dialog box.

	 2.	 In the Style name field, type Crosstab Column Heading.

	 3.	 Click the Format button. In the Format Cells dialog box, click the Alignment tab.

You can specify the alignment and direction of text.



	 4.	 In the Horizontal list, click Center.

	 5.	 Click the Font tab.

	 6.	 In the Font style list, click Italic.

The text in the Preview pane appears in italicized text.

You can make changes on multiple pages of the Format Cells dialog box before closing it.

	 7.	 Click the Number tab.

The Number page of the Format Cells dialog box is displayed.

	 8.	 In the Category list, click Time.

The available time formats appear.

	 9.	 In the Type pane, click 1:30 PM.

	 10.	 Click OK to save your changes.

The Format Cells dialog box closes, and your new style’s definition appears in the 
Style dialog box.

	 11.	 Click OK.

The Style dialog box closes.

	 12.	 Select cells C4:N4.
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	 13.	 On the Home tab, in the Styles group, click Cell Styles.

The Cell Styles gallery opens.

Your new style appears at the top of the gallery, in the Custom group.

	 14.	 Click the Crosstab Column Heading style.

Excel applies your new style to the selected cells.

CLEAN UP  Save the HourlyExceptions workbook, and then close it.

Applying Workbook Themes and Excel Table Styles
Microsoft Office 2010 includes powerful design tools that enable you to create attractive, 
professional documents quickly. The Excel product team implemented the new design 
capabilities by defining workbook themes and Excel table styles. A theme is a way to 
specify the fonts, colors, and graphic effects that appear in a workbook. Excel comes 
with many themes installed.

To apply an existing workbook theme, display the Page Layout tab. Then, in the Themes 
group, click Themes, and click the theme you want to apply to your workbook. By default, 
Excel applies the Office theme to your workbooks. 



You can choose from among dozens of preformatted visual themes.

When you want to format a workbook element, Excel displays colors that are available 
within the active theme. For example, selecting a worksheet cell and then clicking the Font 
Color arrow displays a palette of colors. The theme colors appear at the top of the color 
palette—the standard colors and the More Colors link, which displays the Colors dialog 
box, appear at the bottom of the palette.

If you format workbook elements by using colors from the Theme Colors area, applying a 
different theme changes that object’s colors.
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You can change a theme’s colors, fonts, and graphic effects by displaying the Page Layout 
tab and then, in the Themes group, selecting new values from the Colors, Fonts, and 
Effects lists. To save your changes as a new theme, display the Page Layout tab, and in the 
Themes group, click Themes, and then click Save Current Theme. Use the controls in the 
Save Current Theme dialog box that opens to record your theme for later use. Later, when 
you click the Themes button, your custom theme will appear at the top of the gallery.

Tip  When you save a theme, you save it as an Office Theme file. You can apply the theme to 
other Office 2010 documents as well.

Just as you can define and apply themes to entire workbooks, you can apply and 
define Excel table styles. You select an Excel table’s initial style when you create it; 
to create a new style, display the Home tab, and in the Styles group, click Format As 
Table. In the Format As Table gallery, click New Table Style to display the New Table 
Quick Style dialog box.

You can apply a standard Excel table style or create a custom table style.



Type a name for the new style, select the first table element you want to format, and 
then click Format to display the Format Cells dialog box. Define the element’s formatting, 
and then click OK. When the New Table Quick Style dialog box reopens, its Preview pane 
displays the overall table style and the Element Formatting area describes the selected 
element’s appearance. Also, in the Table Element list, Excel displays the element’s name 
in bold to indicate it has been changed. To make the new style the default for new Excel 
tables created in the current workbook, select the Set As Default Table Quick Style For 
This Document check box. When you click OK, Excel saves the new table style.

Tip  To remove formatting from a table element, click the name of the table element and then 
click the Clear button.

In this exercise, you’ll create a new workbook theme, change a workbook’s theme, create 
a new table style, and apply the new style to an Excel table.

SET UP  You need the HourlyTracking_start workbook located in your Chapter11 
practice file folder to complete this exercise. Open the HourlyTracking_start 
workbook, and save it as HourlyTracking. Then follow the steps. 

	 1.	 If necessary, click any cell in the Excel table.

	 2.	 On the Home tab, in the Styles group, click Format as Table, and then click the 
style at the upper-left corner of the Table Styles gallery.

Excel applies the style to the table.

	 3.	 On the Home tab, in the Styles group, click Format as Table, and then click New 
Table Style.

The New Table Quick Style dialog box opens.

	 4.	 In the Name field, type Exception Default.

	 5.	 In the Table Element list, click Header Row.

	 6.	 Click Format.

The Format Cells dialog box opens.
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	 7.	 Click the Fill tab.

The Fill page is displayed.

The fill colors shown in the palette are specific to the currently applied theme.

	 8.	 In the first row of color squares, just below the No Color button, click the third 
square from the left.

The new background color appears in the Sample pane of the dialog box.

	 9.	 Click OK.



The Format Cells dialog box closes. When the New Table Quick Style dialog box 
reopens, the Header Row table element appears in bold, and the Preview pane’s 
header row is shaded.

	 10.	 In the Table Element list, click Second Row Stripe, and then click Format.

The Format Cells dialog box opens.

	 11.	 Just below the No Color button, click the third square from the left again.

The new background color appears in the Sample pane of the dialog box.

	 12.	 Click OK.

The Format Cells dialog box closes. When the New Table Quick Style dialog box 
reopens, the Second Row Stripe table element appears in bold, and every second 
row is shaded in the Preview pane.

The effect of your changes is shown in the Preview area.
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	 13.	 Click OK.

The New Table Quick Style dialog box closes.

	 14.	 On the Home tab, in the Styles group, click Format as Table. In the gallery, in the 
Custom area, click the new format.

Excel applies the new format.

	 15.	 On the Page Layout tab, in the Themes group, click the Fonts arrow, and then in 
the list, click Verdana.

Excel changes the theme’s font to Verdana (which is part of the Aspect font set).

After changing a theme’s colors, fonts, or effects, you can save the theme for reuse as a  
custom theme.

	 16.	 In the Themes group, click the Themes button, and then click Save Current 
Theme.

The Save Current Theme dialog box opens.



Custom themes are stored with other Office templates.

	 17.	 In the File name field, type Verdana Office, and then click Save.

Excel saves your theme.

	 18.	 In the Themes group, click the Themes button, and then click Origin.

Excel applies the new theme to your workbook.

CLEAN UP  Save the HourlyTracking workbook, and then close it.

Making Numbers Easier to Read
Changing the format of the cells in your worksheet can make your data much easier to read, 
both by setting data labels apart from the actual data and by adding borders to define the 
boundaries between labels and data even more clearly. Of course, using formatting options 
to change the font and appearance of a cell’s contents doesn’t help with idiosyncratic data 
types such as dates, phone numbers, or currency values.
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As an example, consider U.S. phone numbers. These numbers are 10 digits long and have 
a 3-digit area code, a 3-digit exchange, and a 4-digit line number written in the form (###) 
###-####. Although it’s certainly possible to type a phone number with the expected for-
matting in a cell, it’s much simpler to type a sequence of 10 digits and have Excel change 
the data’s appearance.

You can tell Excel to expect a phone number in a cell by opening the Format Cells 
dialog box to the Number page and displaying the formats available for the Special 
category.

The Type list displays special formats that are specific to the location selected in the Locale list.

Clicking Phone Number in the Type list tells Excel to format 10-digit numbers in the 
standard phone number format. You can see this in operation if you compare the con-
tents of the active cell and the contents of the formula box for a cell with the Phone 
Number formatting.

Troubleshooting  If you type a 9-digit number in a field that expects a phone number, you 
won’t see an error message; instead, you’ll see a 2-digit area code. For example, the number 
425550012 would be displayed as (42) 555-0012. An 11-digit number would be displayed with 
a 4-digit area code. If the phone number doesn’t look right, you probably left out a digit or 
included an extra one, so you should make sure your entry is correct.



The Phone Number format applied to the number shown in the formula box.

Just as you can instruct Excel to expect a phone number in a cell, you can also have it 
expect a date or a currency amount. You can make those changes from the Format Cells 
dialog box by choosing either the Date category or the Currency category. The Date 
category enables you to pick the format for the date (and determine whether the date’s 
appearance changes due to the Locale setting of the operating system on the computer 
viewing the workbook). In a similar vein, selecting the Currency category displays controls 
to set the number of places after the decimal point, the currency symbol to use, and the 
way in which Excel should display negative numbers.

Tip  The Excel user interface enables you to make the most common format changes by 
displaying the Home tab of the ribbon and then, in the Number group, either clicking a 
button representing a built-in format or selecting a format from the Number Format list.

You can also create a custom numeric format to add a word or phrase to a number 
in a cell. For example, you can add the phrase per month to a cell with a formula that 
calculates average monthly sales for a year to ensure that you and your colleagues will 
recognize the figure as a monthly average. To create a custom number format, click the 
Home tab, and then click the Number dialog box launcher (found at the bottom right 
corner of the Number group on the ribbon) to display the Format Cells dialog box. 
Then, if necessary, click the Number tab.

In the Category list, click Custom to display the available custom number formats in the 
Type list. You can then click the base format you want and modify it in the Type box. For 
example, clicking the 0.00 format causes Excel to format any number in a cell with two 
digits to the right of the decimal point.

Tip  The zeros in the format indicate that the position in the format can accept any number as 
a valid value.

To customize the format, click in the Type box and add any symbols or text you want to 
the format. For example, typing a dollar ($) sign to the left of the existing format and then 
typing “per month” (including quote marks) to the right of the existing format causes the 
number 1500 to be displayed as $1500.00 per month.
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Important  You need to enclose any text to be displayed as part of the format in quotes so 
that Excel recognizes the text as a string to be displayed in the cell.

In this exercise, you’ll assign date, phone number, and currency formats to ranges of cells. 

SET UP  You need the ExecutiveSearch_start workbook located in your Chapter11 
practice file folder to complete this exercise. Open the ExecutiveSearch_start 
workbook, and save it as ExecutiveSearch. Then follow the steps. 

	 1.	 Click cell A3.

	 2.	 On the Home tab, click the Font dialog box launcher.

The Format Cells dialog box opens.

	 3.	 If necessary, click the Number tab.

	 4.	 In the Category list, click Date.

The Type list appears with a list of date formats.

The Type list displays date formats that are specific to the location selected in the Locale list.

	 5.	 In the Type list, click 3/14/01.

	 6.	 Click OK to assign the chosen format to the cell.

Excel displays the contents of cell A3 to reflect the new format.



	 7.	 Click cell G3.

	 8.	 On the Home tab, in the Number group, click the Number Format button’s down 
arrow and then click More Number Formats.

	 9.	 If necessary, click the Number tab in the Format Cells dialog box.

	 10.	 In the Category list, click Special.

The Type list appears with a list of special formats.

	 11.	 In the Type list, click Phone Number, and then click OK.

Excel displays the contents of the cell as (425) 555-0102, matching the format you 
selected, and the Format Cells dialog box closes.

	 12.	 Click cell H3.

	 13.	 Click the Font dialog box launcher.

	 14.	 In the Format Cells dialog box that opens, click the Number tab.

	 15.	 In the Category list, click Custom.

The contents of the Type list are updated to reflect your choice.

The Sample area displays a preview of the currently selected number format.

	 16.	 In the Type list, click the #,##0 item.
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	 17.	 In the Type box, click to the left of the existing format, and type $. Then click to 
the right of the format, and type “ before bonuses” (note the space after the 
opening quote).

	 18.	 Click OK.

The Format Cells dialog box closes.

The custom number formatting is applied to the value in the active cell.

CLEAN UP  Save the ExecutiveSearch workbook, and then close it.

Changing the Appearance of Data  
Based on Its Value

Recording package volumes, vehicle miles, and other business data in a worksheet enables 
you to make important decisions about your operations. And as you saw earlier in this 
chapter, you can change the appearance of data labels and the worksheet itself to make 
interpreting your data easier.

Another way you can make your data easier to interpret is to have Excel change the 
appearance of your data based on its value. These formats are called conditional for-
mats because the data must meet certain conditions, defined in conditional formatting 
rules, to have a format applied to it. For example, if chief operating officer Lori Penor 
wanted to highlight any Thursdays with higher-than-average weekday package volumes, 
she could define a conditional format that tests the value in the cell recording total sales 
and changes the format of the cell’s contents when the condition is met.

To create a conditional format, you select the cells to which you want to apply the format, 
display the Home tab, and then in the Styles group, click Conditional Formatting to display 
a menu of possible conditional formats. In Excel, you can define conditional formats that 
change how the program displays data in cells that contain values above or below the aver-
age values of the related cells, that contain values near the top or bottom of the value range, 
or that contain values duplicated elsewhere in the selected range.



When you select which kind of condition to create, Excel displays a dialog box that contains 
fields and controls you can use to define your rule. To display all of the rules for the selected 
cells, display the Home tab, and then in the Styles group, click Conditional Formatting. On 
the menu, click Manage Rules to display the Conditional Formatting Rules Manager.

The Conditional Formatting Rules Manager.

The Conditional Formatting Rules Manager enables you to control your conditional formats 
in the following ways:

●	 Create a new rule by clicking the New Rule button.

●	 Change a rule by clicking the rule and then clicking the Edit Rule button.

●	 Remove a rule by clicking the rule and then clicking the Delete Rule button.

●	 Move a rule up or down in the order by clicking the rule and then clicking the 
Move Up button or Move Down button.

●	 Control whether Excel continues evaluating conditional formats after it finds a rule 
to apply by selecting or clearing a rule’s Stop If True check box.

●	 Save any new rules and close the Conditional Formatting Rules Manager by 
clicking OK.

●	 Save any new rules without closing the Conditional Formatting Rules Manager by 
clicking Apply.

●	 Discard any unsaved changes by clicking Cancel.

Tip  Clicking the New Rule button in the Conditional Formatting Rules Manager opens the New 
Formatting Rule dialog box. The commands in the New Formatting Rule dialog box duplicate the 
options displayed when you click the Conditional Formatting button in the Styles group on the 
Home tab.
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After you create a rule, you can change the format applied if the rule is true by clicking 
the rule and then clicking the Edit Rule button to display the Edit Formatting Rule dialog 
box. In that dialog box, click the Format button to display the Format Cells dialog box. 
After you define your format, click OK to display the rule.

A basic conditional formatting rule. Rules can include multiple criteria.

Important  Excel doesn’t check to make sure that your conditions are logically consistent, so 
you need to be sure that you plan and enter your conditions correctly.

Excel also enables you to create three other types of conditional formats: data bars, 
color scales, and icon sets.

Data bars summarize the relative magnitude of values in a cell range by extending a band of color 
across the cell.

When data bars were introduced in Excel 2007, they filled cells with a color band that 
decreased in intensity as it moved across the cell. This gradient fill pattern made it a bit 
difficult to determine the relative length of two data bars because the end points weren’t 
as distinct as they would have been if the bars were a solid color. Excel 2010 enables you 
to choose between a solid fill pattern, which makes the right edge of the bars easier 



to discern, and a gradient fill, which you can use if you share your workbook with col-
leagues who use Excel 2007.

Excel also draws data bars differently than was done in Excel 2007. Excel 2007 drew a very 
short data bar for the lowest value in a range and a very long data bar for the highest 
value. The problem was that similar values could be represented by data bars of very 
different lengths if there wasn’t much variance among the values in the conditionally 
formatted range. In Excel 2010, data bars compare values based on their distance from 
zero, so similar values are summarized using data bars of similar lengths.

Tip  Excel 2010 data bars summarize negative values by using bars that extend to the left of 
a baseline that the program draws in a cell. You can control how your data bars summarize 
negative values by clicking the Negative Value And Axis button, which can be accessed from 
either the New Formatting Rule dialog box or the Edit Formatting Rule dialog box.

Color scales compare the relative magnitude of values in a cell range by applying colors 
from a two-color or three-color set to your cells.

The intensity of a cell’s color reflects the value’s tendency toward the top or bottom of the values in 
the range.

Icon sets are collections of images that Excel displays when certain rules are met. 

An icon set can consist of three, four, or five images.

When icon sets were introduced in Excel 2007, you could apply an icon set as a whole, 
but you couldn’t create custom icon sets or choose to have Excel 2007 display no icon if 
the value in a cell met a criterion. In Excel 2010, you can display any icon from any set for 
any criterion or display no icon.

When you click a color scale or icon set in the Conditional Formatting Rules Manager 
and then click the Edit Rule button, you can control when Excel applies a color or icon 
to your data.
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Important  Be sure to not include cells that contain summary formulas in your conditionally 
formatted ranges. The values, which could be much higher or lower than your regular cell 
data, could throw off your comparisons.

In this exercise, you’ll create a series of conditional formats to change the appearance of 
data in worksheet cells displaying the package volume and delivery exception rates of a 
regional distribution center.

SET UP  You need the Dashboard_start workbook located in your Chapter11 practice 
file folder to complete this exercise. Open the Dashboard_start workbook, and save it 
as Dashboard. Then follow the steps. 

	 1.	 Select cells C4:C12.

	 2.	 On the Home tab, in the Styles group, click Conditional Formatting. On the menu, 
point to Color Scales, and then in the top row of the palette, click the second pattern 
from the left.

Excel formats the selected range.

Color Scales conditional formatting applied to the first data range.

	 3.	 Select cells F4:F12.



	 4.	 On the Home tab, in the Styles group, click Conditional Formatting. On the 
menu, point to Data Bars, and then, in the Solid Fill group, click the orange data 
bar format.

Excel formats the selected range.

	 5.	 Select cells I4:I12.

	 6.	 On the Home tab, in the Styles group, click Conditional Formatting. On the 
menu, point to Icon Sets, and then in the left column of the list of formats, click 
the three traffic lights with black borders.

Excel formats the selected cells.

Three types of conditional formatting applied to the same data range.

	 7.	 With the range I4:I12 still selected, on the Home tab, in the Styles group, click 
Conditional Formatting, and then click Manage Rules.

The Conditional Formatting Rules Manager opens.

	 8.	 Click the Icon Set rule, and then click Edit Rule.

The Edit Formatting Rule dialog box opens.

	 Changing the Appearance of Data Based on Its Value    337



338    Chapter 11  Change Workbook Appearance

In the Edit Formatting Rule dialog box, you can customize conditional formatting.

	 9.	 Click the Reverse Icon Order button.

Excel reconfigures the rules so the red light icon is at the top and the green light 
icon is at the bottom.

	 10.	 In the red light icon’s row, in the Type list, click Number.

	 11.	 In the red light icon’s Value field, type 0.7.

	 12.	 In the yellow light icon’s row, in the Type list, click Number.

	 13.	 In the yellow light icon Value field, type 0.5.

	 14.	 Click OK twice to close the Edit Formatting Rule dialog box and the Conditional 
Formatting Rules Manager.

Excel formats the selected cell range.

	 15.	 Click cell C15.

	 16.	 On the Home tab, in the Styles group, click Conditional Formatting. On the 
menu, point to Highlight Cells Rules, and then click Less Than.

The Less Than dialog box opens.

	 17.	 In the left field, type 96%.

	 18.	 In the With list, click Red text.



	 19.	 Click OK.

The Less Than dialog box closes, and Excel displays the text in cell C15 in red.

Custom conditional formatting includes cell and text colors.

CLEAN UP  Save the Dashboard workbook, and then close it.

Adding Images to Worksheets
Establishing a strong corporate identity helps customers remember your organization  
as well as the products and services you offer. Setting aside the obvious need for sound 
management, two important physical attributes of a strong retail business are a well-
conceived shop space and an eye-catching, easy-to-remember logo. After you or your 
graphic artist has created a logo, you should add the logo to all your documents, especially 
any that might be seen by your customers. Not only does the logo mark the documents 
as coming from your company but it also serves as an advertisement, encouraging anyone 
who sees your worksheets to call or visit your company.

One way to add a picture to a worksheet is to display the Insert tab, and then in the 
Illustrations group, click Picture. Clicking Picture displays the Insert Picture dialog box, 
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from which you can locate the picture you want to add from your hard disk. When you 
insert a picture, the Picture Tools Format contextual tab appears on the ribbon. You can 
use the tools on the Format contextual tab to change the picture’s contrast, brightness, 
and other attributes. With the controls in the Picture Styles group, you can place a bor-
der around the picture, change the picture’s shape, or change a picture’s effects (such as 
shadow, reflection, or three-dimensional effects). Other tools, found in the Arrange and 
Size groups, enable you to rotate, reposition, and resize the picture. 

You can place an image anywhere on a worksheet.

You can also resize a picture by clicking it and then dragging one of the handles that 
appears on the graphic. If you accidentally resize a graphic by dragging a handle, just 
click the Undo button to remove your change. 



Excel 2010 includes a new built-in capability that you can use to remove the background 
of an image you insert into a workbook. To do so, click the image and then, on the Format 
contextual tab of the ribbon, in the Adjust group, click Remove Background. When you do, 
Excel attempts to identify the foreground and background of the image. 

You can display only the image subject by removing the image background.

You can drag the handles on the inner square of the background removal tool to change  
how the tool analyzes the image. When you have adjusted the outline to identify 
the elements of the image you want to keep, click the Keep Changes button on the 
Background Removal contextual tab of the ribbon to complete the operation.

If you want to generate a repeating image in the background of a worksheet to form a 
tiled pattern behind your worksheet’s data, you can display the Page Layout tab, and 
then in the Page Setup group, click Background. In the Sheet Background dialog box, 
click the image that you want to serve as the background pattern for your worksheet, 
and click OK.

Tip  To remove a background image from a worksheet, display the Page Layout tab, and then 
in the Page Setup group, click Delete Background.

To achieve a watermark-type effect with words displayed behind the worksheet data, save 
the watermark information as an image, and then use the image as the sheet background; 
you could also insert the image in the header or footer, and then resize or scale it to  
position the watermark information where you want it.
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In this exercise, you’ll add an image to an existing worksheet, change its location on 
the worksheet, reduce the size of the image, and then set another image as a repeating 
background for the worksheet.

SET UP  You need the CallCenter_start workbook and the Phone and Texture images 
located in your Chapter11 practice file folder to complete this exercise. Open the 
CallCenter_start workbook, and save it as CallCenter. Then follow the steps. 

	 1.	 On the Insert tab, in the Illustrations group, click Picture.

The Insert Picture dialog box opens.

	 2.	 Navigate to the Chapter11 practice file folder, and then double-click the Phone 
image file.

The image appears on your worksheet.

	 3.	 On the Format contextual tab, in the Adjust group, click Remove Background.

Excel attempts to separate the image’s foreground from its background.

	 4.	 Drag the handles at the upper-left and bottom-right corners of the outline until 
the entire phone, including the cord, is within the frame.

You resize an image on a worksheet by using the same techniques you do in a document.

	 5.	 On the Background Removal tab, click Keep Changes.

Excel removes the highlighted image elements.



	 6.	 Move the image to the upper-left corner of the worksheet, click and hold the handle 
at the lower-right corner of the image, and drag it up and to the left until the image 
no longer obscures the Call Volume label.

Images on worksheets are independent of worksheet cells.

	 7.	 On the Page Layout tab, in the Page Setup group, click Background.

The Sheet Background dialog box opens.

	 8.	 Navigate to the Chapter11 practice file folder, and then double-click the Texture 
image file.

Excel repeats the image to form a background pattern.
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You can use an image file to create a worksheet background.

	 9.	 On the Page Layout tab, in the Page Setup group, click Delete Background.

Excel removes the background image.

CLEAN UP  Save the CallCenter workbook, and then close it. If you are not continuing 
directly to the next chapter, exit Excel.



Key Points
●	 If you don’t like the default font in which Excel displays your data, you can change it.

●	 You can use cell formatting, including borders, alignment, and fill colors, to 
emphasize certain cells in your worksheets. This emphasis is particularly useful 
for making column and row labels stand out from the data.

●	 Excel comes with a number of existing styles that enable you to change the 
appearance of individual cells. You can also create new styles to make format-
ting your workbooks easier.

●	 If you want to apply the formatting from one cell to another cell, use the Format 
Painter to copy the format quickly.

●	 There are quite a few built-in document themes and Excel table formats you can 
apply to groups of cells. If you see one you like, use it and save yourself lots of 
formatting time.

●	 Conditional formats enable you to set rules so that Excel changes the appearance 
of a cell’s contents based on its value.

●	 Adding images can make your worksheets more visually appealing and make your 
data easier to understand. Excel 2010 greatly enhances your ability to manage 
your images without leaving Excel.
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Symbols & 
Numbers
$ (dollar sign) in absolute references, 294
= (equal sign) in formulas, 286
##### error code, 301
#DIV/0! error code, 301
#NAME? error code, 301
#REF! error code, 301
#VALUE! error code, 301
[ ] (square brackets) in formulas, 289, 299
3-D borders, 128
35mm slides, 486
100% button (Publisher), 904, 978

A
A3 Paper slide size, 486
A4 Paper slide size, 486
absolute references in formulas, 307

changing to relative references, 294
dollar sign ($) in, 294

.accdb file extension, 753, 791
accent colors, 426
Accept button (Outlook), 733
accepting meeting requests, 698
accepting tasks, 733
Access 2010

closing, 757
starting, 748

Access Help button, 751
Access icon, 750
Access Options dialog box, 792
Access Services, 795
accessibility, checking, 219, 503
accounts. See e-mail accounts
active cells, 260

in cell group, 261
in filtering, 349

active document, closing, 48
Active view (Calendar), 701
ActiveSync icon (OneNote), 550
Add Holidays to Calendar dialog box, 686
add-ins (Word), 24

adding values together, 286
Address Block button (Publisher), 970
address blocks, 970
Address Book button, 648, 658-659
address books

accessing, 647
adding contacts to, 621
adding to default search list, 602
Contacts, 646
contacts, adding, 664
creating, 647
custom, 647
Global Address List (GAL), 648
Mobile Address Book, 646
organizing, 647
overview of, 646
printing, 667-668
search order, changing, 602
Suggested Contacts, 646
viewing, 659
views, selecting, 660

addressing e-mail messages, 605, 658
AutoComplete, 601, 615
comma-separating addresses, 601

adjusting columns to fit contents, 805
adjusting shapes, 470
Advanced Filter dialog box, 358-359
Advanced Filter Options button, 857, 860
Advanced Filter/Sort command, 859
Advanced View Settings dialog box, 661
advanced options (Word), 22
advertisement building blocks, 945
Advertisements button (Publisher), 945
AGGREGATE function, 357-359
Align button (Publisher), 926
Align Center button (Word), 155
Align Center Right button (Word), 156, 163
Align Text Left button (PowerPoint), 438
Align Text Right button (PowerPoint), 438
aligning borders, 943
aligning labels in forms, 838
aligning pictures, 926, 928
aligning WordArt, 911
aligning text, 121-122, 125-126, 438

around pictures, 169
with tab stops, 121
in tables, 155-156, 163
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alignment, cell, 318
alphabet bar, 662
alphabetical sorting, 846, 847
alt text in tables, 159
alternative words. See Thesaurus
And option in filters, 353
angle of text in text boxes, 394, 900
animation, turning off, 490
annotating graphics, 393
application parts, 789. See also templates

adding to databases, 794
viewing, 794

Application Parts button, 794
applications, database. See database applications
Apply To button (Publisher), 982
Apply To All button (PowerPoint), 481
Appointment button, 696
Appointment page, 691
Appointment Recurrence dialog box, 684, 689
appointments

availability during, marking, 680, 682
creating, 605
creating from e-mail messages, 688
defined, 680
editing, 682
location, setting, 682
moving, 681
private, 682
recurring, 680, 684
reminders for, 680, 682
scheduling, 680, 681
time zones, specifying, 681

appointment windows, 680-682
arguments, 296

defined, 288
error codes for, 301

Arrange All button, 59
Arrange Windows dialog box (Excel), 243, 251
arranging graphics in group, 945
arranging slides, 386
arranging workbook windows, 243
arrows

button, 8, 311, 751
filter, 348, 350-351
tracer, 301-302, 304-305

Artistic Effects button (Word), 173
Ascending button, 849
aspect ratio, 927
assigning tasks, 730-731, 733
Assign Task button, 731, 733
asterisk as wildcard, 857, 859
asterisk icon, 797
Attach File button (OneNote), 565, 575
Attach File button (Outlook), 615

attachments (OneNote)
inserting, 565, 572, 575
keyboard shortcut for, 565

attachments (Outlook)
business cards as, 621
contact records as, 621
forwarding e-mail messages as, 635
inserting, 615, 616
opening, 620, 626
pictures, resizing when sending, 617
previewing in Reading Pane, 620, 624
in replies, 639
saving to hard disk, 620
ScreenTips for, 623
viewing number of, 623
warning before previewing, 624
Word documents as, 615, 624

Attachments tab, 620
attendees (meeting requests)

adding, 693-695
availability, checking, 693
optional, 691
required, 695

attributes (PowerPoint), applying, 439
audio input devices, 585
audio notes (OneNote)

appearance of, 586
playing, 588
recording, 586, 587
rewinding, 588
searchability, activating, 585

Audio Search dialog box (OneNote), 586
Audio Search (OneNote), 585-586
Audio & Video Recording contextual tab 

(OneNote), 586
auditing errors, 300
author name, viewing, 220
authors (OneNote), hiding names, 548
AutoCalculate, 355, 359
AutoComplete, 257, 615
AutoCorrect

adding to, 91
customizing, 406
fixing spelling errors with, 88-89
limitations of, 407
modifying, 409
options, setting, 20, 89
synonyms, 416

AutoCorrect dialog box (Word), 89, 136
AutoCorrect Options button (Excel), 275
AutoExpansion (Excel), 275
AutoFill (Excel)

defined, 257
entering data series, 256
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AutoFill Options button (Excel), 258, 260
AutoFilter, 348
AutoFit

changing default settings , 406
reducing text size with, 411

AutoFit Options button (PowerPoint), 406, 410
AutoFormatting options, 136
automatic slide shows, 491
AutoRecover options (Word), 20, 41
AutoText, 190
availability, marking, 680, 682
AVERAGE function, 287, 355
AVERAGEIF function, 297-298, 300
AVERAGEIFS function, 297, 299
averages

calculating, 297
viewing with AutoCalculate, 355, 359

B
B4 (ISO) Paper slide size, 486
B5 (ISO) Paper slide size, 486
Background button (Publisher), 981
Background Styles button (Excel), 430
Background Styles gallery (Excel), 430
backgrounds, document

appropriate use of, 176
color, applying, 176
gradients, applying, 177
overview of, 168
pictures as, applying, 179
textures, applying, 178

backgrounds, OneNote notebook, 571
backgrounds, publication

applying, 982
formatting, 975
textures for, 975

backgrounds, slide
applying, 433
changing , 429, 433
colors, 426
formatting placeholder, 436

backgrounds, worksheet
deleting images from, 341-342, 344
patterns, creating, 341, 343
repeating images in, 341, 343
watermarks, 341

Backspace key, 64, 390
Backstage view

displaying, 6
Backstage view (OneNote), 522
Backstage view (PowerPoint), 493, 502

Backstage view (Publisher), 868
displaying, 748, 750, 753
New page, 749
overview of, 748

Backstage view (Word), 18, 38, 43, 208, 217
displaying, 48
Help page, 16
Info page, 15
New page, 16
opening documents from, 46
Print page, 16
Recent page, 16
Share page, 16

banded rows in tables, 161
Banner slide size, 486
banners, 488
Bcc field, 658
bilingual dictionary, 83, 87
Bing decision engine, 270
birthday, adding to contact records, 653
bitmaps, 455
Black And White button (PowerPoint), 492
black and white, printing in, 492-493
black numbered steps in book, xx
black screen, removing from end of PowerPoint 

presentation, 510
blank documents, creating, 38, 41
blank OneNote pages, 551, 558
Blank Page button (Word), 183
blank pages, inserting, 183
blind courtesy copies. See Bcc field
blocking content in Word, 25
blog posts, creating, 39
blue numbered steps in book, xx
Blue Pen (.05 mm) button (OneNote), 577
BMP file format, 455
Bold button (Word), 18-19, 113, 148
bolding text, 18-19, 113, 148, 311, 313, 439, 833
book exercise format, xviii, xxvi
book help, xxv
book practice files, xxi, xxix
booklets, printing, 208, 667
Borders button (Word), 123, 128, 162
Borders And Shading dialog box (Word), 124, 128, 

162, 181
borders, document

3-D, 128
adding, 123-124, 128
around cells, 162
page, 181

borders, PowerPoint text box, 395, 398
borders, publication

adding to graphics, 920
aligning, 943
preformatted, 941, 942
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borders, worksheet
adding to cells, 312, 314
adding to images, 340

Borders & Accents button (Publisher), 941
Borders & Accents gallery, 941
bound documents, previewing, 209
Breaks button (Word), 120, 125, 146, 216
breaks, column, 140, 146
breaks, line

inserting, 120, 125, 439
keyboard shortcut for, 121

breaks, page
deleting, 214
inserting, 212
keyboard shortcut for, 215
soft, 212

breaks, section
for columns, 140, 142
deleting, 214
formatting mark for, 214, 216
inserting, 214, 216
overview of, 214

brightness, adjusting, 171
Bring Forward button (Publisher), 962
Browse button, 792
Browse By Page button, 50
Browse dialog box (PowerPoint), 376
browsers. See Web browsers
browsing objects, 50
Building Block Library, 940
Building Block Library dialog box, 942, 946
building blocks. See also headers/footers; 

Quick Parts
borders and accents, 942
cover pages, 183, 186
creating, 94, 194
defined, 93
deleting, 185
entering in existing text, 96
gallery of, 184, 190
inserting, 94, 942, 946
keyboard shortcuts for, 94
overview of, 93, 168, 940
page numbers, 183, 189, 190
properties, viewing, 185
saving, 95
sizing, 944
text boxes, 183, 191, 196

Building Blocks Organizer, 184, 190
bullet points in slides. See also subpoints

changing into diagrams, 462
collapsing on Outline tab, 402
converting to regular text, 442

bulleted lists in documents, 69, 71, 131-133.  
See also lists

bulleted lists in messages
Bullets gallery, 607
creating, 607
demoting/promoting list items, 609

Bullets button (Outlook), 607
Bullets button (PowerPoint), 437, 442
Bullets button (Word), 131-132
Bullets gallery (Outlook), 607
Bullets gallery (PowerPoint), 437, 442
Business Card view (contact records), 660-661
business cards

as attachments, 621
in publications, 880

Business Information button (Publisher), 886
Business Information dialog box (Publisher),  

883, 884
buttons. See also specific button names

adding to Quick Access Toolbar, 32, 244, 251
arrows on, 8, 311, 751
default action, changing, 8
inactive, 11
moving, 32
pictures of, xx
ScreenTips for. See ScreenTips
separator between, 32-33

C
Cached Exchange Mode, 633
Calculate Now button (Excel), 287
calculations. See formulas
calendar items, grouping, 701
Calendar module

day/week/month, displaying by, 702
default view, 701
details, displaying, 709
displaying current day, 705
holidays, adding, 686
switching arrangements, 702
view, resetting, 706
views in, 701
week numbers, displaying, 703
work week, displaying, 705

Calendar view, 701
calendars

backgrounds, applying, 982
background textures, 975
color schemes, setting, 978
creating, 974
font size, changing, 981
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picture captions, setting, 979
pictures, inserting, 979
previewing, 977
templates for, 977
time range, specifying, 974
zooming in/out, 978

calling contacts, 657
Cancel Assignment button, 733
capitalization, 118-119. See also uppercase

changing, 439
searching for, 266

Caption button (Publisher), 979
captions, 812, 829, 836, 979
Card button, 662
card stock, printing cards on, 950
Card view (contact records), 660, 662
cards. See also postcards

color schemes, applying, 954, 957
creating, 952, 954
greeting lines, inserting, 972
layout, changing, 953
layout settings, 950
navigating, 956
orientation, changing, 955
page size, setting, 950
placeholder text, 956
printing contacts as, 667
printing on card stock, 950
size, changing, 955
suggested text, inserting, 956
templates for, 950, 952, 953
text formatting, 959

cascading workbook windows, 243, 251
case, 118-119

changing, 439
searching for, 266

catalog merge, 964
catalog templates, 964
categories. See galleries
category axes in charts, 463
Cc field, 599, 658
cell addresses, 463
cell groups, 261
Cell Margins button, 159
Cell Styles gallery, 316-317
cells, Word table

borders, 162
deleting, 153
inserting, 153
merging, 153, 155
setting width of, 159
shading, 162
splitting, 154

cells, worksheet. See also ranges
absolute references, 294, 307
active, 260-261, 349
aligning, 318
borders, 312, 314
contiguous, in formulas, 290
copying, 258, 261
deleting, 238, 240
deleting contents/formatting of, 311
entering data in, 256, 258
filtering. See filters, Excel
finding sum of, 286
formatting, copying, 258, 260
individual, selecting, 260
inserting, 238, 240
monitoring values in, 303, 304
moving, 238, 240
moving to, 260
noncontiguous, adding to formulas, 290
noncontiguous, formatting, 314
number formatting in, 319
pasting formulas in, 291
references, 294-295, 301
shading, 312-314, 324
visible, summarizing, 355, 357

Center button (PowerPoint), 438
Center button (Word), 125, 129, 143, 189, 198
Center Tab button (Word), 148
centering text, 121-122, 125, 143

with Click And Type, 121
in header/footers, 189
keyboard shortcut for, 121, 143
in tables, 155
in WordArt objects, 198

certification, xii, xvi
Change Case button (PowerPoint), 439
Change Colors button (PowerPoint), 460
Change Colors gallery (PowerPoint), 460
Change Shape button, 913
Change Shape gallery, 913
Change Styles button (Word), 101, 104
Change Template dialog box (Publisher), 876
Change View button, 622, 738
Change View gallery, 619, 736, 738
changes, redoing/undoing, 270, 402
chapter thumb tabs, xix
character formatting, 438. See also fonts; text 

formatting
appropriate use of, 119
bolding, 18-19, 113, 148, 311, 313, 439
case, 118
clearing, 118, 439
copying, 114, 173, 258, 260
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character formatting (continued)
for individual characters, 439
in Publisher, 901
underlining, 113, 149

character spacing, 111
changing, 117, 439

Character Spacing button (Publisher), 907
Character Spacing list, 439
character styles, 100, 130. See also Quick Styles
characters, non-printing, 53, 56. See also 

formatting marks
Chart button (PowerPoint), 462
charts

adding to slides, 462
associated Excel worksheets, 462
category axes, 463
copying Excel data, 466
data markers, 463
data points, 463
data series, 256-258, 276, 463
editing data, 467
entering data, 464
excluding data from, 466
hiding data, 466
legends, 463
selecting for automatic updates, 468
series axes, 463
sizing, 467
switching rows/columns, 469
tick-mark labels, 463
value axes, 463

chatting. See instant messages
Check Accessibility tool (PowerPoint), 503
Check Address dialog box, 656
Check Compatibility tool (PowerPoint), 503
Check Names dialog box, 600
checkerboard transition, 479
checking spelling, 42, 269, 272, 412, 415, 520

adding new words to dictionary, 269, 272
with AutoCorrect, 88-89
with shortcut menu, 88, 90
with Spelling and Grammar dialog box, 88
turning off, 412
typos, 63

Choose A File Or A Set Of Files To Insert dialog 
box (OneNote), 575

Choose A SmartArt Graphic dialog box 
(PowerPoint), 456

Choose Document To Insert dialog box 
(OneNote), 572

circles, drawing, 933
CLEAN UP paragraphs, xx
Clear All Formatting button (PowerPoint), 439, 441
Clear Formatting button (Word), 118

clearing
filters, 350-353
formatting, 118, 439
table styles, 323
validation rules, 363

Click And Type
centering text with, 121

clip art. See also graphics; pictures
borders, adding, 925
free from Office.com, 448
icons for, 922
image information, viewing, 922
inserting, 168, 174, 920
inserting in notes, 569
inserting in slides, 448
keywords, editing, 923
overview of, 919
restricting searches for, 924
saving, 174
searching for, 174, 452, 919-920
styles, applying, 925

Clip Art button (PowerPoint), 448, 452
Clip Art button (Publisher), 920
Clip Art button (Word), 168, 174
Clip Art task pane (PowerPoint), 448, 452
Clipboard, 66, 72, 401, 405
clippings (OneNote), 579

adding to notebooks, 581
capturing, 581
displaying, 582
options for, 580
sending to new page, 581

cloning contact records, 645, 653
Close button, xxviii, xxxvi, 5, 757, 764, 801
Close button (Excel), 467
Close button (OneNote), 557
Close button (Word), 48, 51
Close Header and Footer button (Word), 190, 216
Close Master Page button (Publisher), 977, 982
Close Print Preview button, 786
Close Task Pane button (PowerPoint), 378
closing

Access 2010, 757
Clipboard task pane, 72
database objects, 773
databases, 757
dialog boxes, 12
documents, 48, 51
Help window, xxviii, xxxvi
master pages, 982
program window, 750
programs, 5
tables, 757, 764, 801

collaborating on OneNote notebooks, 543
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Collapse button (Access), 764
Collapse button (OneNote), 528, 559
Collapse Page Tabs button (OneNote), 529
Collapse Section button (PowerPoint), 385
collapsing

bullet points, 402
OneNote notebooks, 528
OneNote Page Tabs Bar, 529
OneNote subpages, 559
ribbon, 757
subdatasheets, 764

collating printed documents, 217, 493
Color button (Word), 171
Color gallery (Word), 171
color gradients, 429, 975
Color Model dialog box (Publisher), 889
color of pen, 509
color of Word user interface, 18
color palettes, 426
color scales, 335, 336
color schemes, 951

applying, 958
applying to cards, 954
applying to slides, 426
creating, 426, 444, 951
for calendars, 978
for cards, 957
in templates, 965
previewing, 951
switching, 951
viewing, 426
viewing all, 958

coloring backgrounds, 176, 426
coloring pictures, 171
coloring shapes, 934, 961-962
coloring text boxes, 905
colors

adding to publications, 952
changing, 835

Colors button (Access), 829
Colors button (PowerPoint), 427
Colors dialog box (Access), 835
Colors dialog box (Excel), 321
Colors dialog box (PowerPoint), 444
Colors dialog box (Publisher), 960
Colors gallery (PowerPoint), 426
column breaks, 140, 146
column headers, 261, 356
column width in views, 665
Columns button (Word), 141
Columns dialog box (Word), 144
columns, document, 139. See also table columns

applying to entire document, 141
formatting, 140
hyphenating text in, 141, 145

indenting text in, 145
justifying, 141-142
margins, 143
overview of, 140
section/column breaks in, 140, 142
separated by tab stops, 147-148
spacing, changing, 144

columns, form, 838
Columns gallery, 140, 141
columns, publication, 760

adjusting to fit contents, 805
hiding, 806, 807
resizing, 763
selecting multiple, 849

columns, table
deleting, 153
inserting, 153
resizing, 153
setting width of, 159

columns, worksheet
changing multiple, 237
copying, 261
deleting, 238
##### error code, 301
filtering. See filters
formatting, 312
hiding, 238-239
inserting, 237, 239
labels, and filtering, 349
labels, as range names, 283
labels, hiding, 249
moving, 261
selecting, 261
unhiding, 238
width, changing, 237
width errors, 301

combining cells, 153-155
commands. See also ribbon

adding to Quick Access Toolbar, 32, 244, 251
from previous versions, adding, 7

comments
in worksheet ranges, 282
printing, 493

commercial print settings, 888
Compact view (Inbox), 619
company contact information in Publisher, 879

creating, 882
editing, 884, 887

comparing worksheet values, 335-337
compatibility

checking, before distributing document, 219
with earlier versions of PowerPoint, 503
with earlier versions of Word, 44

Compatibility Mode, 45
completing records, 798
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completing tasks. See marking tasks as complete
compressing graphics, 920, 922
compressing pictures, 930
Compress Pictures button, 930
Compress Pictures dialog box, 930
conditional formatting, 332-338
Conditional Formatting Rules Manager, 333, 

335, 337
conditional formulas, 296
conditional functions, 297
conditions, setting. See validation rules
connecting shapes on slides, 478
connection points for shapes, 932, 935-937
connection points on slides, 478
contact cards

expanding, 631
overview of, 630

contact groups, 605
contact records

addresses, entering, 656
addresses, specifying default, 651
addressing e-mail messages from, 657
as attachments, 621
birthdays, adding, 653
cloning, 645, 653
creating, 649, 655
details, displaying, 652
Display As field, 649
e-mail addresses, entering, 650
filing order, 645
filling in, 649
filtering, 661
follow-up flags, assigning, 652
linking items to, 652
mailing address, specifying, 651
meeting requests, creating from, 657
overview of, 644
phone numbers, entering, 648
printing, 667, 668, 675
reordering, 645
saving, 652
searching, 661
sorting, 663
spouse/partner, adding, 652
types of information in, 644
views, customizing, 664
views, selecting, 660, 661
zooming in/out, 662

contacts
adding to address book, 664
addresses, mapping, 657
addressing e-mail messages to, 658
automatically adding, 646
creating, 605
displaying all communications with, 633

listing, 659
message recipients, adding as, 658
scrolling to, 658
tasks, creating from, 718

Contacts address book, 646
Contacts module, 660
content placeholders on slides, 448, 451
content templates (OneNote), 552, 556
contextual tabs, 609
contiguous cells, adding to formulas, 290
continuous slide shows, 490
contrast, adjusting, 171
contributors to OneNote notebooks, 548
Control Margins button, 840
controls. See also label controls; text box controls

moving, 841
overview of, 821
properties, changing, 835
resizing, 839
selecting, 824
selecting all, 834, 840
tab order, changing, 842

Controls button, 772
Controls gallery, 772
control source, 829
Conversation view, 627
Convert button, 45
Convert Text To Table dialog box (Word), 156
Convert To Text button (Word), 152
converting bullet points to regular text, 442
converting bulleted lists to diagrams, 462
converting Excel tables to ranges, 277
converting tables to text, 152
converting text to tables, 152, 156
converting Word documents to Web pages, 23
Copy button (Access), 802
Copy button (PowerPoint), 401, 466
Copy button (Word), 66, 70
copying

cells, 258, 261
character formatting, 114
chart data from Excel, 466
data, 263
formatting, 114, 173, 258, 260, 907, 960
formulas, 291, 294
pictures, 173
ranges, 261
shape formatting, 471, 478
shapes, 471, 931
slides from other presentations, 375
tables, 798, 802
text, 66-67, 401-402
text boxes, 394, 900
worksheet columns/rows, 261
worksheets, 233-235
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copyrights, 448, 974
correcting mistakes automatically, 406
Corrections button (Word), 171
COUNT function, 287, 297
COUNTA function, 297
COUNTBLANK function, 297
COUNTIF function, 297
COUNTIFS function, 297, 299
counting entries, 287
counts, viewing with AutoCalculate, 355, 359
courtesy copies. See Cc field
Cover Page button (Word), 185
cover pages, 183, 186
Create button (Access), 793, 799
Create button (Publisher), 901
Create button (Word), 39
Create Names From Selection dialog box 

(Excel), 283
Create New Building Block dialog box (Word), 

94, 194
Create New Business Information Set dialog 

box (Publisher), 882
Create New Color Scheme dialog box 

(Publisher), 951
Create New Section button (OneNote), 559
Create New Theme Colors dialog box 

(PowerPoint), 426
Create New Theme Fonts dialog box 

(PowerPoint), 426
Create Notebook button (OneNote), 542, 547
Create tab, 755, 756
crediting pictures, 451
criteria, function, 299
Crop button (Word), 170
cropping pictures, 170, 920
currency, in Excel worksheets, 329, 331
cursor

function of, 38
keyboard shortcuts for, 47, 49
moving, 49-50
paging up or down with, 47
placing, 47
status bar display for, 47

Custom AutoFilter dialog box (Excel), 353
Custom Filter dialog box, 853
custom slide sizes, 486
custom themes, 830, 835
Custom XML Data check box, 506
CUSTOM.DIC dictionary, 412, 415
Customize Quick Access Toolbar button, 33
Customize Ribbon page, 27
Customize Status Bar menu, 8
Cut button (PowerPoint), 401, 404
Cut button (Word), 66, 70, 193

cutting text, 66, 70, 193, 263
vs. copying, 67
keyboard shortcut for, 67, 193, 402

cycle diagrams, 454

D
Daily Task List, 707
Daily Task List button, 707
data bars, 337

gradient fill in, 334
and negative values, 335

data entry
ensuring accuracy of, 361
in multiple cells, 257
techniques, summarized, 257

data entry tools
AutoComplete, 257
AutoFill, 256
AutoFill Options button, 258, 260
Fill Series, 256
overview of, 255
Pick From Drop-Down List, 257, 259

data fields for mail merge, 964
data markers, 463
data organization, 796
data points, 463
data series, 463

entering, 256-258
in Excel tables, 276
types of, 257

data source for mail merge, 964, 967
Data Type column, 809
data types, 348, 809-811
Data Validation dialog box (Excel), 361, 364
database application templates. See templates
database design, 804
database objects. See also forms; queries; 

reports; tables
closing all, 773
creating, 755
defined, 747

groups of. See application parts
listing all, 794
printing, 782
uses for, 760
in Web databases, 795

databases. See also Web databases
adding to trusted locations, 759
closing, 757
creating, 749, 793, 799
default location of, 792
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databases (continued)
default name, 799
file extension for, 791
naming, 791
opening, 749, 752
overview of, 845
page setup, changing, 784
path, default, 792
populating, 789
printing, 782
structure of, 760, 761
publishing. See publishing databases

database templates. See templates
Database Tools tab, 757
Datasheet Formatting dialog box, 755
datasheets, 762. See also subdatasheets
Datasheet view (forms), 768
Datasheet view (tables), 761-762
date and time (OneNote), 584
Date Navigator

components of, 703
expanding, 704
month display in, 704
navigating in, 681, 703, 711
overview of, 703

dates
filtering, 348, 351, 855
in footers, 487
formatting, 329, 330

Day view (Calendar), 701
days, filling cells with series, 258
decimal alignment, 121, 127
Decimal Tab button (Word), 127
Decline button, 733
declining meeting requests, 698
declining tasks, 731, 733
Decrease Font Size button (PowerPoint), 438
Decrease Font Size button (Publisher), 905, 961, 981
Decrease Indent button (Word), 120, 129
Decrease List Level button (PowerPoint), 392
Default Database Path dialog box, 792
defining filter rules, 350
defining table structure, 797
delegating tasks. See assigning tasks
Delete button (Access), 802
Delete button (Word), 153
Delete dialog box (Excel), 238, 240
Delete key, 64
Delete Rows button (Access), 810
deleting

background images, 341, 344
building blocks, 185
cells, 238, 240
Clipboard items, 405
columns, 238

conditional formatting rules, 333
custom styles, 317
data, 311
fields, 810
flagged items from task lists, 730
page/section breaks, 214
ranges, 284
rows, 238
sections, 386
slides, 371
tab stops, 122
table rows/columns/cells, 153
tables, 802
text, 64, 66, 68, 71, 403
watches, 303, 307
worksheets, 234, 236

delivering presentations, 495, 512
demoting

list items, 609
text, 392

dependents, 302
Descending button, 848
Description column, 809
deselecting

text, 66
text boxes, 395

Design Checker (Publisher), 888, 890
Design contextual tab, 277, 766
design grid

filtering criteria, entering, 860-862
queries in, 776

design templates. See templates (OneNote); 
templates (PowerPoint); templates 
(Publisher); templates (Word)

Design View button, 765, 775, 780
Design view (forms)

creating forms in, 822
overview of, 768
switching to Form view from, 771

Design view (queries), 775-776
Design view (reports), 777, 780
Design view (tables), 761, 765, 808, 810
designing databases, 804
Details button, 652
diagrams

adding text, 457
changing colors, 460
creating from bulleted list, 462
cycle, 454
hierarchy, 454
moving, 456, 459
in notes pages, 498
opening Text pane, 458
predefined sets of formatting, 455
process, 454

994    database templates



relationship, 455
sizing, 456, 459
in slides, 455-456
viewing layouts, 459

dialog box launcher, 7, 751
dialog boxes

closing, 12
displaying, 7, 751
displaying errors in, 302
filtering criteria, 349
Help buttons, xxv
moving, 419

dictionaries
adding words to, 269, 272
bilingual, 83, 87
in PowerPoint, 412
supplemental, 412, 415

disability accessibility, 503
disabling macros, 759
Display As field in contact records, 649
display effects. See transitions
distributing documents

electronically, 219
in XPS format, 223

distributing pictures horizontally, 928
distribution lists. See contact groups
dividing cells, 154
dividing presentations into sections, 380
Dock to Desktop button (OneNote), 532
docking OneNote window, 532
docking Side Notes to desktop, 591
document format, setting default, 20
document headings, 51
document history, 16
Document Inspector (PowerPoint), 502, 505
Document Inspector (Word), 219, 221
document navigation, 78
document outlines, 52
Document Panel, 502
document properties, 15, 219-220
Document Properties panel, 229-231
document statistics, 93
document summaries, 221
Document Themes folder, 107
documents. See also saving documents

blank, creating, 41
blank, opening, 38
closing, 48, 51
compatibility with earlier versions, 44
creating, 38-41
default format, setting, 20
e-mailing, 615
formatting in columns, 141. See also columns, 

document
full-screen display, 52, 56

inserting in other documents, 97
location, specifying, 23
maximizing, 59
moving to top, 55
navigating, 47, 56-57, 71
opening, 46, 48
printing with default settings, 34
read-only, opening as, 46
recently opened, 16, 46
renaming when saving, 43
repairing, 46
scrolling through, 47, 50
selecting, 65
sharing, 16
side-by-side display, 55
splitting into two panes, 53
switching between, 53, 59
translating, 84
viewing multiple, 59
zooming in/out, 53

Documents library, 46
.docx format, 43-45
dollar sign ($) in absolute references, 294
double-clicking tabs, 757
Draft button, 58
Draft view, 52
drafts

automatic deletion of, 605
resuming, 605, 607
save location, changing, 605
saving, 605
viewing, 606

Drafts folder, 605-606
drag-and-drop editing, 66, 71, 401
dragging in Excel

to copy formulas, 292
to fill cells, 256
to resize images, 340
to select cells, 260

Draw tab (OneNote ribbon), 520
Draw Text Box button (Publisher), 902
drawing objects, 167
drawing pictures in OneNote, 577
drawing shapes, 470, 933
drawing tables in Word, 151. See also tables
drawing text boxes, 196, 902-903
Drawing Tools Format contextual tab, 903, 

931, 959
Drop Cap dialog box (Word), 202
drop caps, inserting, 202
drop shadows, 918
duplex printing, 217
duplicating shapes, 471, 474
duplicating slides, 375, 378
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E
Edit Data button (PowerPoint), 467
Edit Formatting Rule dialog box (Excel), 334-337
Edit Name dialog box (Excel), 284
Edit Relationships dialog box, 817
Edit Shape button (PowerPoint), 476
Edit WordArt Text dialog box, 909
editing meetings, 697
Effect Options button (PowerPoint), 481
effects. See text effects
Effects button (PowerPoint), 427
effects schemes, 427
efficiency, improving, 6, 227
e-mail accounts, 614
e-mail addresses for contacts, entering, 650
e-mail attachments. See attachments
e-mail etiquette, 635
e-mail headers. See headers, e-mail
e-mail messages. See also drafts; sent messages

addressing, 605, 658
Bcc field, 658
calendar items, creating from, 688
Cc field, 658
creating, 605
entering text, 607
flagging for follow-up, 718, 719
HTML format, 603
mail merging, 617
opening, 619, 626
personalizing, 603
Plain Text format, 603
recalling, 641
replacing, 641
resending, 641
RTF format, 603
saving as drafts, 604-605
scrolling through, 629
tasks, creating from, 718-719
unread, 619
viewing text of, 619

e-mail signatures. See signatures
e-mailing link to OneNote notebook, 546
embedded datasheets. See subdatasheets
embedded fonts in Word, 21
embedding fonts in publications, 889
Enable Content button, 759
Encarta dictionary, 270
enforcing referential integrity, 817
enhanced handouts, 501
entering data series, 256
entering Excel data, 255-256
entering ranges in formulas, 295

entering text, 41, 64
in OneNote, 565, 572
on Outline tab, 390
in Slide pane, 390
in text boxes, 394

equal sign (=) in formulas, 286
erasing slide markup, 511
errata page, xxv, xxxiii
Error button (Excel), 301
Error Checking dialog box (Excel), 302, 305
error codes

#####, 301
common, summarized, 301
#DIV/0!, 301
#NAME?, 301
#REF!, 301
#VALUE!, 301

error messages
adding icons to, 365
Cancel button, 366
displaying default, 366
displaying with validation rules, 363, 364
Retry button, 366

errors, Excel
auditing, 300
changing settings for, 302
deleting, 390
displaying custom messages, 298
displaying in dialog box, 302, 305
finding information about, 301, 305
ignoring, 302
ignoring in AGGREGATE function, 358
messages, 298
reference, 301
settings, changing, 302
tracing dependents to identify, 301
tracing precedents to identify, 301
ways to reduce, 412

errors, spelling, 42, 88-90
etiquette, e-mail, 635
Evaluate Formula dialog box (Excel), 303, 306
events

creating, 688-689
defined, 689
entering details, 689
private, 682
recurring, 689, 690

examining formulas, 303, 306
Excel 2007

data bars in, 334
icon sets in, 335

Excel 2010
data bars in, 334
ease of use, improving, 227
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file formats, 44
icon sets in, 335
online version, xi, xv
program window, customizing, 241
starting, 4, 227, 229
user interface, customizing, 241

Excel, earlier versions of. See also Excel 2007
Paste Options button , 261
pasting in, 261

Excel formats, 229
Excel Options dialog box

Customize The Quick Access Toolbar page, 244, 251
Customize The Ribbon page, 246, 252

Excel table styles. See table styles
Excel tables

AutoExpansion, 275
columns, adding/removing, 276
converting to range, 277
creating, 275, 277
data, adding, 275, 277
data series in, 276
Design contextual tab, 277
fill color, 324
filtering. See filters
formatting, 322
formulas in, 276, 277, 293
in formulas, 289
names, adding to formulas, 295
overview of, 255
renaming, 276, 278
resize handle, 276
rows, adding/removing, 276
summarizing data in, 276, 277
table style gallery, 275
Total row, 276

Excel workbooks
arranging multiple windows, 243, 251
copying worksheets, 233, 235
creating, 228, 230
default, 228
display font, changing, 313, 315
displaying side by side, 243
Document Properties panel, 229
filtering ranges, 284
properties, 229-232
saving, 229, 232
switching between, 227, 243, 251
themes. See themes, Excel

Excel worksheets
backgrounds, 341-344
columns. See columns, worksheet
copying, 233, 235
creating, 233
deleting, 234, 236

displaying, 233
filtering. See filters
hiding, 234, 235
images, adding, 339, 342
purpose of, 233
renaming, 233, 235
reordering, 234-235
rows. See rows, worksheet
searching, 264
tab color, changing, 234-235
unhiding, 234, 236

Exchange address list. See Global Address List (GAL)
exiting. See closing
Expand button (Access), 764
Expand button (Mini Translator), 87
Expand Contact Card button, 631
Expand Navigation Bar button (OneNote), 527
Expand Section button (PowerPoint), 386
Expand The Ribbon button, 8, 33, 751
expanding ribbon, 8, 33
exporting presentations as outlines, 380
extensions, file name, 617, 791
External Data tab, 756
external files, linking in OneNote, 565, 572

F
fancy effects. See WordArt objects
faxes, creating, 605
Field Chooser dialog box, 664
field codes for mail merges, 971
Field Name column, 809
field names, 829
Field Properties area, 810
fields

captions, changing, 812
customizing, 664, 666
data type, changing, 809-810
deleting, 810
description of, 809-810
filtering records by, 851
freezing, 807
hiding, 806
inserting, 812
moving, 808
naming, 809-810
naming conventions, 800
properties, viewing, 810
Quick Start, 799, 803
renaming, 798, 800
resizing, 805
selecting, 806-807, 809
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fields (continued)
size, specifying, 811
sizing to fit contents, 763
unfreezing, 807
unhiding, 806

file attachments. See attachments
file extensions, 617, 791
file formats

converting, 45
overview of, 44
saving Word documents as, 21
setting default, 20

file information
for documents, 15
for PowerPoint presentations, 502-506
for workbooks, 229-232

file locations of Word documents, specifying, 23
file name conventions, 791
file name extensions, 43-44
File New Database dialog box, 792
File Printout button (OneNote), 565-566, 572
File tab, 6, 15
files

inserting in documents, 97i
inserting in text boxes, 904
switching between, 53

fill color
adding to cells, 312, 314
adding to Excel table, 324
data bars, 334

Fill Days option, 258
Fill Effects dialog box (Word), 176
Fill Effects dialog box (Publisher), 916
fill handle, 256

controlling data series entry, 257
copying formulas with, 292
repeating values with, 257, 259

fill operations, 258
Fill Weekdays option, 258
FillSeries

defined, 257
entering data series, 256

filter arrows, 348, 350-351
Filter button, 852, 853
filter panel, 349
filtering

contact records, 661
Navigation pane, 753
OneNote page tabs, 518
ranges, 284

filtering records, 851
advanced options for, 857
customizing filters, 853
date filtering options, 855
in forms, 851

with forms, 855-857
on design grid criteria, 860-862
on multiple criteria, 859
options for, 853
specifying criteria for, 852-853
toggling filter, 852
with multiple criteria, 858

filters, 347-348
active cells in, 349
and AVERAGE function, 355
AutoFilter, 348
clearing, 350, 352-353
creating, 348, 353
and data types, 348
date, 348, 351
defined, 348
filter panel display, 349
for highest or lowest value, 349
labels in, 349
options menu, 348
removing, 350, 352-353
rules, defining, 350
Search box, 349, 352
search filter, defined, 349
and SUBTOTAL function, 357
and SUM function, 355
summarizing data, 355, 357
Top 10 filter, 349
turning off, 350

finalizing
documents, 219, 223
presentations, 503

Find And Replace dialog box, 48, 75, 264, 266, 854
clearing formatting from, 269
Go To tab, displaying, 48
options summarized, 265
Replace tab, displaying, 76

Find button (Access), 854
Find button (PowerPoint), 418
Find button (Word), 73, 76
Find dialog box (PowerPoint), 418
Find Format dialog box (Excel), 265, 267
Find text, 420
finding fonts, 420
finding formatting, 130
finding information about errors, 301
finding maximum/minimum value in 

worksheets, 287
finding text, 73, 76, 418. See also Navigation 

task pane
advanced options for, 74, 77
in bilingual dictionary, 83
keyboard shortcut for, 73
matching case when, 75
and replacing, 75, 78
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ScreenTips with page numbers for, 74
search direction, specifying, 75
sound-alikes, 75
wildcards in searches, 75

finding values, 854
finding worksheet data, 264-266
first line indent, 120
First Page button, 784
Fit Text button (Publisher), 905
fitting slides to page when printing, 493
flagging messages for follow-up, 718-719
flat databases, 760
flipping shapes, 473, 933
flying onto slide effect, 480
folded cards. See cards
folders 

as address books. See address books
creating, when saving documents, 40, 43
for tasks, 742

follow-up flags, 729
followed hyperlink colors, 426
Font arrow (Publisher), 905
Font box, 438
Font button (Word), 114
font color, changing, 905
Font Color arrow (Publisher), 905, 959
Font Color button (PowerPoint), 426, 439-440, 444
Font Color button (Word), 117
Font dialog box (Publisher), 906
Font dialog box (Word), 112, 116
font effects. See text effects
Font gallery, 114
font schemes in PowerPoint, 426, 428
font size

changing, 111, 116, 313, 831
decreasing, 905
increasing, 905-906
incrementing, 116
keyboard shortcuts for adjusting, 116

Font Size arrow, 831
Font Size box, 438
font style, 111, 901
font weight, 833
fonts. See also character formatting

applying, 115
attributes for, 111
available, 111
changing, 319, 438, 905
color, 111, 117
default, 111
defined, 99
embedding in Word documents, 21
overview of, 901
replacing, 418, 420
in themes, changing, 109

Fonts button (Access), 829
Fonts button (PowerPoint), 428
Fonts gallery (PowerPoint), 426, 428
footers in slides, 487. See also header/footers in 

documents
adding to notes pages, 499
adding to slides, 489
editing before printing, 493
excluding from title slide, 489

foreign keys, 813
foreign languages, specifying in Word, 21
Form button, 822-824
Form Design Tools contextual tabs, 771
Format As Table dialog box (Excel), 275, 277
Format AutoShape dialog box, 933
Format Background dialog box (PowerPoint), 431
Format Cells dialog box (Excel), 312, 316
Format Painter button, 114, 173, 317, 471, 478
Format Painter button (Publisher), 907, 932, 960
Format Picture dialog box, 926
Format Shape dialog box, 394
Format WordArt dialog box, 912
formats

Excel, 229
conditional, 332-338
default, setting, 20
Rich Text Format (RTF), 374, 380

formatting. See also character formatting; fonts; 
text formatting; themes (Excel); themes 
(PowerPoint); themes (Word)

alignment, 318
automatically, 136
in bold, 18-19, 113, 148, 311, 313, 439
buttons, 311-312
cell, 258, 260, 311
clearing, 269, 311
columns, 140, 312
conditional, 332-338
copying, 173, 317, 907, 960
currency, 329, 331
dates, 329-330
finding/replacing, 130
fonts, 313, 319
with Format Painter, 317
ignoring, in cell copying, 258
inserting and, 237, 239
italics, 314
labels, 309-310
Mini Toolbar, 312
noncontiguous cells, 314
numbers, 319, 327, 329, 331
OneNote notes, 569
pasting and, 263
phone numbers, 328, 331
placeholder backgrounds, 436
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formatting (continued)
previewing, 10
retaining for reused slides , 378
row, changing, 312
searching for, 265, 267
shapes, 471, 478, 931-933
Special formats, 328
tables, 160
text, 901
text boxes, 900
time, in cells, 319
tools for, 311-312
WordArt, 912

formatting marks
displaying, 56
keyboard shortcut for, 68
section break indicator, 214, 216
showing/hiding, 68, 149

forms
aligning labels in, 838
basing on tables, 824
bound to tables, 829
control source, 829
creating, , 822, 824, 768
customizing layout, 837
default layout, 837
entering data in, 826
filtering records in, 851
filtering records with, 855-857
font size, changing, 831
font weight, changing, 833
in Layout view, 824, 830, 837
label captions, changing, 836
layout, removing, 841
Layout view, switching to, 838
margins, setting, 840
navigating, 825, 827-828
opening, 768
overview of, 768
printing, 786
properties in, 829, 832
Property Sheet, displaying, 832
record source, 829
saving, 828, 836
selecting all controls on, 834
selecting columns in, 838
shadow effects, 835
sorting records in, 846
Stacked layout, 837
subforms, 768
synchronizing with tables, 828
tabular layout, 837
viewing list of, 768

views for, 768, 771
tab order, changing, 842
for Web databases, 822

Form view, 768, 771, 825
Form View button, 825
Formula AutoComplete, 288, 295-296
formula bar

changing data in, 266
contents of, 260
Excel display font, changing, 313, 315
hiding, 249

formula box
editing formulas in, 286
phone numbers in, 328

Formula button (Word), 158
Formula dialog box (Word), 158
formulas, Excel

absolute references in, 307
conditional, 296
contiguous cells in, 290
copying and pasting, 291, 294
creating, 286, 288, 295
defined, 286
details, displaying, 303
displaying messages with, 296
editing, 286
entering ranges in, 295
equal sign (=) in, 286
erroneously treated as text, 286
errors. See errors, Excel
examining, 303, 306
Excel tables in, 289, 293, 295
in Excel tables, 276, 277
Formula AutoComplete, 288, 295-296
functions in, 286
ignoring values in, 357
making ranges available for, 282
multiple worksheets and, 243
noncontiguous cells in, 290
ranges in, 282, 288
relative references in, 291, 307
revising, 286
searching in, 266
square brackets in, 289
troubleshooting, 286
unrecognized text in, 301

formulas, Word, 158
constructing, 158
referencing cells in, 158

Forward button, 57, 639, 711, 733
forwarding e-mail messages

closing original message after, 635
prefix used by Outlook for, 639
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forwarding tasks, 733
framing pictures, 926
French dictionary, 412
freezing fields, 807
frequently misspelled words, correcting, 88
From button, 614
full name. See user name
Full Page View button (OneNote), 533-534
Full Screen Reading button, 56
Full Screen Reading view, 52, 56
Function Arguments dialog box (Excel), 296-297
functions

adding to formulas, 286
AGGREGATE, 357, 359
arguments, 296
arguments, defined, 288
and AutoCalculate, 355
automatic recalculation of, 354
AVERAGE, 287
AVERAGEIF, 297, 298, 300
AVERAGEIFS, 297, 299
conditional, 297
constructing, 158
COUNT, 287, 297
COUNTA, 297
COUNTBLANK, 297
COUNTIF, 297
COUNTIFS, 297, 299
defined, 286
IF, 296, 360
IFERROR, 297
MAX, 287
MIN, 287
multiple criteria in, 299
NOW(), 287
PMT(), 287
RAND, 354, 360
RANDBETWEEN, 354
SUBTOTAL, 355
SUM, 287, 295
SUMIF, 297
SUMIFS, 297, 299, 300
volatile, 354

funnel icon in filter arrow, 350

G
galleries

closing without making selection, 13
of thumbnails, 10

GIF file format, 455
Global Address List (GAL), 648
Go To Footer button (Word), 189

Gradient gallery, 435, 915
grammar checker, 91. See also spelling, checking
graphic placeholders, 920
graphics. See building blocks; clip art; drawing 

objects; images (Excel); images (OneNote); 
images (PowerPoint); images (Publisher); 
images (Word); shapes; SmartArt graphics

graphics file formats
BMP, 455
GIF, 455
JPEG, 455
PNG, 455
TIFF, 455

grayed-out buttons, 11
grayscale

previewing before printing in, 492
printing in, 493

Grayscale button (PowerPoint), 492
greeting cards. See cards
Greeting Line button (Publisher), 971
greeting lines, inserting, 972
gridlines (OneNote), 571
Group button (PowerPoint), 476
Group button (Publisher), 938
grouping

calendar items, 701
images, 945
OneNote sections. See section groups (OneNote)
records, 846. See also sorting records
related data, 282
shapes, 476, 932, 937-938

groups, ribbon, 7
customizing, 27
removing, 30

Grow Font button (Word), 116

H
handles, 450

around shapes, 470
Handout masters, 495
handouts

creating in Word, 501
enhanced, 501
printing, 492

handwritten notes (OneNote), 520, 567, 577
hanging indent, 120,

adjusting, 126
in columns, adjusting, 145

Header And Footer dialog box (PowerPoint), 487, 
488, 493, 499

Header button (Word), 188, 216
Header & Footer button (PowerPoint), 488, 499
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headers/footers in documents.  
See also footers in slides

centering text in, 189
closing, 190, 216
different first page, 216
editing, 216
hiding, 54
inserting, 188
moving to, 189
navigating between, 188
overview of, 183
settings inheritance, 183, 216

headers, column and row
changing formatting with, 312
displaying unique values, 359, 360
filter arrow in, 351
and SUBTOTAL function, 356

headers, e-mail
Attached box, 616
icons in, 618
information in, 618

headers, slide
adding to notes pages, 499
editing before printing, 493

headings, document, 51
height, row, 237, 806
Help button, xxv, xxxiii, 8, 751
Help, on Office Online Web site, xxvii, xxxv
Help page (OneNote Backstage view), 525
Help page (Word), 16
Help window

closing, xxviii, xxxvi
displaying, 8
navigating, xxviii, xxxvi
opening, xxvi, xxxiii, xxxiv
printing from, xxix, xxxvii
searching in, xxviii, xxxvi
showing all of topics, xxix, xxxvii
table of contents, displaying, xxvii, xxxv
topics, displaying, xxvii, xxxv

help with book, xxv, xxxiii
hidden characters, displaying, 53
hidden formatting marks, displaying, 68
hidden rows, ignoring in AGGREGATE function, 358
hidden text, clearing before distributing 

document, 219
hidden worksheets, displaying, 234, 236
hiding

author names in OneNote, 548
columns, 238-239, 806-807
Document Properties panel, 230
fields, 806
formatting marks, 149
formula bar, 249
headers/footers in Word, 54

labels, 249
Mini Toolbar in Word, 18
non-printing characters, 56
ribbon, 59, 249
ribbon commands, 751
rows, 238
subdatasheets, 764
text, 53
tracer arrows, 302, 305-306
worksheets, 234-235

hierarchy diagrams, 454
highlighting during presentations, 509
highlighting objects. See selecting
highlighting text. See also selecting text

color selection for, 117
removing highlighting, 118

holidays, adding to calendar, 686
Home tab, 6
Home tab (Access), 753-754
Home tab (OneNote), 519
Home tab (Word), 10
horizontal scroll bar, 47
hyperlinks, 426
hyphenating text in columns, 141, 145
Hyphenation button (Word), 145

I
icon sets

in Excel, 335
rules, changing, 335, 337

ID field, 809
IF function, 296-297, 299, 360
IFERROR function, 297
ignoring errors, 302
IM. See instant messages
images (Excel)

attributes, changing, 340
background, 341-344
borders, adding, 340
moving, 343
position, changing, 340
resizing, 340, 343
shape, changing, 340
worksheets, adding to, 339, 342

images (OneNote)
attaching to files, 575
displaying ScreenTips, 576
inserting, 568, 572-574
opening, 576
resizing, 569
scaling, 568

images (Outlook), resizing
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images (PowerPoint), 448
annotating, 393
crediting, 451
linking for automatic updating, 449
moving, 450
notes pages, adding to, 496
sizing, 450-451
slides, adding to, 448-449

images (Publisher)
aligning, 926, 928
aspect ratio, locking, 927
borders, adding, 925
brightness, adjusting, 920
captions, adding, 979
compressing, 920, 922, 930
copyright considerations, 974
cropping, 920
defined, 919
distributing horizontally, 928
file size, decreasing, 922
frame effects, adding, 920
inserting, 926
modifying, 920
optimizing for Web, 930
overview of, 919
placeholders for, 920
resizing, 927
rotating, 920
sending backwards in group, 945
sizing, 926
transparent, creating, 920

images (Word)
and line spacing, 169
artistic effects, adding, 173
as backgrounds, 179
brightness, adjusting, 171
contrast, adjusting, 171
copying, 173
correcting, 171
cropping, 170
incomplete display, 169
inserting, 168-169, 173
modifying, 168
overview of, 167
recoloring, 171
resizing, 170
styles, applying, 172
text alignment around, 169
troubleshooting, 169

Import Word Document dialog box (Publisher), 878
Import Word Documents gallery (Publisher), 877
Important paragraphs, xx
importing outlines, 374
importing publications from Word documents, 

871, 876, 878

inactive buttons, 11
Inbox

Compact view, 619
icons in, 619
Preview view, 619, 622
Single view, 619, 622
viewing, 613

Increase Font Size button (PowerPoint), 438, 441
Increase Font Size button (Publisher), 906
Increase Indent button (Word), 120, 126, 133, 148
Increase List Level button (PowerPoint), 392
increasing/decreasing space between letters, 439
indent markers, 120, 126
indenting columns, 145
indenting lists, 132-133
indenting text

first line, 120
hanging indent, 120, 126, 145
left, 120, 126
right, 120, 126

Info page (OneNote Backstage view), 502, 522
information sets (Publisher)

creating, 882
editing, 883, 884, 887

initials. See user name
Insert Above button (Word), 153
Insert Address Block dialog box (Publisher), 970
Insert Below button (Word), 153, 155
Insert Cells dialog box (Word), 153
Insert Chart button (PowerPoint), 462, 465
Insert Chart dialog box (PowerPoint), 465
Insert dialog box (Excel), 238, 240
Insert File button (Publisher), 904
Insert File dialog box, 615, 616
Insert Function dialog box (Excel), 276, 286, 296
Insert Greeting Line button (Publisher), 972
Insert Left button (Word), 153
Insert Options button (Excel), 237, 239
Insert Outline dialog box (PowerPoint), 375
Insert Picture dialog box (Access), 831, 882
Insert Picture dialog box (Excel), 339, 342
Insert Picture dialog box (OneNote), 568, 573
Insert Picture dialog box (PowerPoint), 448, 449, 451
Insert Picture dialog box (Publisher), 926, 979
Insert Picture dialog box (Word), 169
Insert Picture From File button (PowerPoint), 

448, 449
Insert Right button (Word), 153
Insert SmartArt Graphic button (PowerPoint), 

455, 456
Insert tab (OneNote), 519
Insert tab (Word), 11
Insert Table dialog box (Word), 150
Insert Table gallery (Word), 150
Insert Text dialog box (Publisher), 904
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Insert Worksheet button (Excel), 233
inserting

cells, 238, 240
columns, 237, 239
line breaks, 439
rows, 237, 239
shapes, 932
slides, 448
text, 64

inspecting documents, 219, 221, 502, 505
instant messages, 636, 657
Instant Search, 661, 742
international languages, specifying in Word, 21
Internet Explorer. See Web browsers
Internet links, 426
invitation cards. See cards
invitations. See meeting requests
Italic button (PowerPoint), 440
italicizing text, 314, 439

J
jelly beans. See presence icons
journal entries, 657
JPEG file format, 455
Justify button (PowerPoint), 438
Justify button (Word), 125, 142
justifying text, 121, 125

in columns, 141, 142
keyboard shortcut for, 121, 142
in PowerPoint, 438

K
Keep On Top button (OneNote), 592
Keep Text Only button (Word), 87
Keyboard Shortcut paragraphs, xx
keyboard shortcuts

for attaching documents, 565
for bolding text, 113
for building blocks, 94
for centering text, 121, 143
for clearing formatting, 118
for copying text, 67
for creating blank OneNote pages, 558
for creating OneNote sections, 559
for creating OneNote subpages, 558, 559
for cursor movement, 47
for cursor placement, 49
for cutting text, 67, 193
for docking OneNote window, 532

for document navigation, 55, 71, 78
for editing text, 402
for finding text, 73
for Font dialog box display, 116
for font size, 116
for formatting marks, 68
for Go To tab of Find And Replace dialog box, 48
for Help window display, 8
for hiding/displaying rule lines in OneNote, 571
for inserting date and time, 584
for inserting documents in OneNote, 565
for inserting page breaks, 215
for justifying text, 121, 142
for left-aligning text, 121
for line breaks, 121
for minimizing/expanding ribbon, 8
for Month view in Calendar, 708
for moving to end of message, 609
moving cursor with, 47
for navigating, 765
for navigating OneNote, 534
for OneNote tags, 579
for opening OneNote windows, 518
for opening Side Notes, 591
for outline levels in OneNote, 570
for Page Tabs Bar, 518
for pasting text, 67
for printing, 208
for Property Sheet display, 831
for repeating editing, 67, 146
for replacing text, 76, 130
for Research task pane, 79
for rewinding audio/video notes, 588
for right-aligning text, 121
for saving document, 41
for Screen Clipping tool in OneNote, 581
for selecting all, 65, 142, 905
for sending e-mail messages, 605, 612
for underlining text, 113
for undoing editing, 67
for Work Week view in Calendar, 705

keywords, 221, 229, 231, 923
Keywords dialog box, 923

L
label controls, 821
labels

changing names, 836
creating, 778
font size, changing, 831
font weight, changing, 833
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labels, row and column
in filters, 349
formatting, 309-310
hiding, 249
as range names, 283

Landscape button, 784
Landscape orientation, 208, 672, 784
Language button (PowerPoint), 413
Language dialog box (PowerPoint), 413
languages, specifying additional in Word, 21
languages, translating, 271, 273, 417
Last Page button, 780
Last Record button, 828
launcher, dialog box, 7
layout, form, 837, 841
layout, publication, 873, 876
layout, slide

applying, 374
changing existing slides, 372
diagram, 459
selecting from New Slide gallery, 371

Layout arrow (Publisher), 873
Layout button (PowerPoint), 374
Layout dialog box (Word), 200
Layout gallery (PowerPoint), 372
layout templates for cards, 950
Layout view (forms)

creating forms in, 822
opening forms in, 830
overview of, 824, 837
switching to, 838
theme customization, 830

Layout view (reports), 777
Ledger Paper slide size, 486
left indent, adjusting, 120, 126
Left Tab button (Word), 126
left-aligning text, 121
legacy commands, 7, 27
legacy compatibility, 44
legends, in charts, 463
Letter Paper slide size, 486
libraries, slide, 379
Line And Paragraph Spacing button (Word), 122
line breaks

inserting, 120, 125, 439
keyboard shortcut for, 121

line drawings. See shapes
line spacing

changing, 438
pictures and, 169

Line Spacing button (PowerPoint), 438, 442
Line Spacing button (Word), 127
lines, selecting, 65, 103
Link button (OneNote), 565

linking
to external files in OneNote, 565, 572
text boxes, 196

links, 426
links between tables. See relationships
list boxes. See galleries
List view (Calendar), 701
List view (contact records), 660
lists. See also bulleted lists; tabbed lists

converting text into, 131-132
ending, 131
indenting, 132-133
modifying, 131
multiple levels, creating, 131, 135
overview of, 130
sorting, 131, 135
undoing formatting of, 131

Live Preview, 10, 424
disabling, 18
Paste, 262
of styles, 316

loan payments, calculating with PMT() function, 288
local OneNote notebooks, 541
Location Information dialog box, 648
Logo button, 831
logos

changing, 882
inserting, 831

lowercase. See case

M
machine translator, 84
macros, 758-759, 793
magnification level, 249

adjusting, 53, 102
displaying multiple pages, 55, 209
to full page, 176
overview of, 242
by percentage, 56
specific zoom level, 242

mail merge, 967
for catalogs, 964
for e-mail messages, 617
overview of, 963

Mail Merge arrow (Publisher), 967
Mail Merge Recipients dialog box (Publisher), 968
Mail Merge Wizard (Publisher), 967, 969, 973
mailing addresses, specifying in contact records, 651
mailing label reports, 778
Mailings tab (Word), 14
managing ranges, 284
many-to-many relationships, 814
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margins
changing, 206, 208, 211, 216
of columns, 143
in forms, 840
gallery of, 209
mirroring, 210
specifying, 119
in tables, 159

Margins button (Word), 12, 119, 216
Mark Complete button, 729
marking documents as final, 223
marking messages as read, 628-629
marking presentations as final, 503
marking slides, 509
marking tasks as complete, 717, 721, 729
Master Page button (Publisher), 976, 981
master pages in publications, 975

closing, 982
editing, 976
modifying, 976
switching to, 981

masters, 495
mathematical functions in tables. See formulas, 

Excel; functions
MAX function, 287
Maximize button, 59
maximizing documents, 59
maximum field size, specifying, 811
maximum value in worksheets

advantage of identifying, 281
finding, 287

.mdb file extension, 753
Meeting button, 657
Meeting Properties dialog box (PowerPoint), 505
meeting requests

accepting, 698
Appointment page, 691
attendees, 691-695
checking availability for, 699
components of, 692, 695
creating, 694
declining, 698
editing, 697
overview of, 691
replying to, 637
required attendees, 695
responding to, 698-700
Room Finder, 693
scheduling, 693, 695
Scheduling Assistant page, 692-693, 695
sending, 696
suggesting times in, 693, 696, 698, 700
Tentative time, 693

meetings
creating from e-mail messages, 688
duration, changing, 693
private, 682
proposing new time for, 700
replying to e-mail messages with invitation, 634
start time, changing, 693
updating, 697

memos, printing contacts as, 667
Merge Cells button (Word), 153, 155-156
Merge List button (Word), 70
merging

bullet points, 71
cells, 153, 155

Message button, 623
message headers. See headers, e-mail
message list. See Inbox
message window, 605
messages, e-mail. See e-mail messages
messages, entry, 363-364
messages, error

adding icons to, 365
displaying custom, 298, 363-364
displaying default, 366
displaying with validation rules, 363-364

microphones, configuring, 585
Microsoft Access 2010. See Access 2010
Microsoft Bing decision engine, 270
Microsoft certification, xii, xvi
Microsoft Clip Organizer, 919
Microsoft Encarta dictionary, 270
Microsoft Excel 2010

data bars in, 334
ease of use, improving, 227
file formats, 44
icon sets in, 335
online version, xi
program window, customizing, 241
starting, 4, 227, 229
user interface, customizing, 241

Microsoft Knowledge Base, xxix, xxxvii
Microsoft Office 2010

common user interface, 3
compatibility with earlier versions, 44
online applications, xi
software suite comparison, xi
themes in, 322

Microsoft Office Clipboard, 66, 72, 401, 405
Microsoft Office Compatibility Pack, 45
Microsoft Office Online Web site

clip art images, 448
Help from, xxvii
templates on, 39
themes from, 107
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Microsoft Office Security Options dialog box, 759
Microsoft Office Specialist (MOS), xii, xvi
Microsoft Office Trusted Location dialog box, 759
Microsoft OneNote 2010. See also notebooks 

(OneNote)
advanced options, 536
audio/video options, 536
Backstage view, 522
customizing, 535
display options, 536
docking to desktop, 532-533
docking window, 532
drawing pictures in, 577
entering text in, 572
external files, inserting, 572
Full Page View, 533
handwritten content, 520
Help, accessing, 525
inserting content in, 519
language options, 536
Navigation Bar, 517, 526-527
navigation keyboard shortcuts, 534
online version, xi
opening images from, 576
Page Tabs Bar, collapsing, 529
Page Tabs Bar, default location of, 526
Pages tab, expanding, 533
page titles, displaying, 529
paragraph formatting, 569
printing from, 525
product activation, 525
program window, 516, 521, 526, 527
proofing options, 536
ribbon, 519, 531
saving options, 536
saving pages, 524
screen clippings from, 579-582
sending items to, 580
sending pages to Outlook/Word, 524
Side Notes, 591
starting, 4, 526
storage structure, 516
tags, 578-579
translating content, 520
undocking, 533
Unfiled Notes section, 528

Microsoft Outlook dialog box, 665
Microsoft PowerPoint presentations, previewing in 

Reading Pane, 624
Microsoft Press Technical Support, xxxiii
Microsoft Product Support Services, xxix, xxxvii
Microsoft Publisher 2010. See Publisher 2010
Microsoft SharePoint

file location, setting default, 20
sharing notebooks from, 545, 547

Microsoft Translator service, 84
Microsoft Update service, 10
Microsoft Visual Basic for Applications (VBA) 

macros, 758, 759
Microsoft Word 2010. See also documents

compatibility with earlier versions, 44
file formats, 44
first time starting, 10
handouts, creating, 501
Help button, xxvi
Help window, opening, xxvi
OneNote pages, sending to, 524
online version, xi
starting, 4, 10
views in, 52

Microsoft Word Help button, xxxiv
MIN function, 287
Mini Toolbar, 65, 312, 439, 440

character formatting with, 111
hiding, 18

Mini Translator, 82, 84, 417
Minimize button, 5
Minimize The Ribbon button, 8, 59, 751
Minimize The To-Do Bar button, 613
minimizing

documents, 5
ribbon, 8, 59, 751

minimum value in worksheets
advantage of identifying, 281
finding, 287

mirroring margins, 210
misspellings. See spelling, checking
mistakes, correcting automatically. See AutoCorrect
Mobile Address Book, 646
mobile device messaging. See text messages
mobile devices, OneNote on, 593
monitoring values in cells, 303-304
monitors, multiple, 508
Month button, 708
Month view (Calendar), 702, 704, 708-709
months, entering series with AutoFill, 256
More button (Access), 772, 806
More button (PowerPoint), 424
More Fields button, 803
MOS (Microsoft Office Specialist), xii, xvi
Move or Copy dialog box (Excel), 233, 235
Move Up button (Word), 28
moving

cells, 238, 240
to cells, 260
diagrams, 456, 459
dialog boxes, 419
fields, 808
images, 343
pictures, 450

	 moving    1007



moving (continued)
program window, 750
shapes, 471, 931
slides, 384
tables, 152-153
text, 401
text boxes, 394, 397
worksheet columns, 261

Multilevel List button (Word), 131
multi-line text boxes, 393
multiple criteria in functions, 299

N
Name box, creating ranges with, 283, 285
Name Manager dialog box (Excel), 284-285
named ranges. See ranges
naming

databases, 791
documents, 43
fields, 809-810
OneNote pages/sections, 554-555

narration in slides, turning off, 490
national holidays, adding to calendar, 686
navigating

documents, 71
e-mail messages, 609
forms, 825, 827-828
Help window, xxviii, xxxvi
OneNote, 534
OneNote page tabs, 518
publications, 878
records, 765
reports, 780
tables, 152, 797, 799

Navigation Bar (OneNote), 517
collapsing, 517
default location of, 526
expanding, 517, 527

Navigation button (OneNote), 510
Navigation task pane, 77, 751, 753, 793. See also 

finding text
displaying, 50, 752
editing while open, 74
filtering, 753
opening, 763, 793
Search tab, displaying, 73

navigation toolbar, 509-510
New (Blank) Record button, 825
New Column dialog box, 666
New Contact button, 649
New E-mail button, 605, 615
New Folder button (Word), 40, 43
New Formatting Rule dialog box (Excel), 333, 335

New icon, 797
New Items button, 605, 717
New Meeting button, 694
New Name dialog box (Excel), 282, 286
New page (Publisher), 871
New Page arrow (OneNote), 555, 559
New Page button (OneNote), 557
New page (OneNote Backstage view), 522, 541
New Side Note button (OneNote), 591
New Slide button (PowerPoint), 372-373, 375
New Slide gallery (PowerPoint), 371, 373
New Table Quick Style dialog box (Excel), 322, 323
New Task button, 716, 725
Next button (PowerPoint), 625
Next Page button, 47, 50, 56
Next Page button (OneNote), 534
Next Page button (Print Page), 493
Next Record button, , 765, 770
Next Slide button (PowerPoint), 497, 625
noncontiguous cells, adding to formulas, 290
nonprinting characters

displaying, 53
keyboard shortcut for, 68
section break indicator, 214, 216
showing/hiding, 56, 68, 149

nonstandard color schemes, 444
Normal button (PowerPoint), 382, 498
Normal view

creating slide sections in, 384
in PowerPoint, 53

Normal View button (OneNote), 533
normalization, 804
note containers (OneNote), 564

automatic creation of, 572
contents of, 564
inserting, 564
modifying, 564-565
object selectors for, 564

notebook headers, 518
notebooks (OneNote), 516. See also pages 

(OneNote); sections (OneNote)
appearance of, 517
authors, 548
backgrounds, changing, 571
backup copies, opening, 522
closing, 518
collaboration on, 543
collapsing, 528
creating, 522, 540-542, 547
e-mailing link to, 546
entering text in, 565
green check mark icon, 550
hierarchy, displaying, 517
images, inserting, 568
local, creating, 541
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moving sections, 516
multiple, working with, 518
multiuser, 520
offline copies, 543
opening, 518, 522, 530, 546
organizing, 551
Personal, 516, 526
pinning to Recently Closed list, 530
populating, 540
printing, 525
properties, viewing, 522
red slashed circle icon, 550
saving, 524, 567
screen clippings, 579-582
scrolling pages in, 565
sending Web pages to, 579
settings, 530
setup of, 516
sharing, 520, 523, 540, 544-547
spelling/grammar checks, 520
storing, 540
synchronizing, 543, 549-550
templates, 552
Web sharing, 544, 547
yellow caution triangle icon, 550

Notes masters, 495
notes (OneNote)

audio, 585
clip art, inserting, 569
formatting, 569
handwritten, 577
images, inserting, 568
outline levels, 570
Tablet PC, entering with, 567
video, 585
from Web pages, 579-583

Notes Page button (PowerPoint), 495, 496
Notes Page view (PowerPoint), 53, 494
notes pages (PowerPoint)

adding to slides, 495, 497
adding diagrams, 498
adding headers/footers, 499
adding pictures, 496
handwritten, 567
printing, 492, 499

notes, PowerPoint. See notes pages (PowerPoint)
NOW() function, 287
numbered lists. See also lists

creating, 131, 133
numbering value, setting, 134
number style, changing, 132
restarting numbering, 133

numbered steps, xx
Numbering button (PowerPoint), 437
Numbering button (Word), 131, 133

numbers. See also values
adding text to values, 329, 332
currency, formatting, 329, 331
dates, formatting, 329, 330
displaying visually, 462
formatting, 319, 327, 329, 331
negative, and data bars, 335
negative, displaying, 329
phone numbers, formatting, 328, 331
sorting, 850
specifying in validation rules, 364

O
object commands. See contextual tabs
object selectors (OneNote), 564
Office 2010

common user interface, 3
compatibility with earlier versions, 44
online applications, xi, xv
software suite comparison, xi, xv
themes in, 322

Office Online Web site
clip art images, 448
Help from, xxvii, xxxv
templates on, 39
themes from, 107

Office Open XML formats, 44
Office Professional Plus, xi, xv
Office Standard, xi, xv
Office theme, 320, 829
Office Themes

copying worksheets, 234
Office Web Apps, xi, xv
one-to-many relationships, 813
one-to-one relationships, 814
OneNote 2010. See also notebooks (OneNote)

advanced options, 536
audio/video options, 536
Backstage view, 522
customizing, 535
display options, 536
docking to desktop, 532-533
docking window, 532
drawing pictures in, 577
entering text in, 572
external files, inserting, 572
Full Page View, 533
handwritten content, 520
Help, accessing, 525
inserting content in, 519
language options, 536
Navigation Bar, 517, 526-527
navigation keyboard shortcuts, 534

	 OneNote 2010    1009



OneNote 2010 (continued)
online version, xi, xv
opening images from, 576
Page Tabs Bar, collapsing, 529
Page Tabs Bar, default location of, 526
page titles, displaying, 529
Pages tab, expanding, 533
paragraph formatting, 569
printing from, 525
product activation, 525
program window, 516, 521, 526, 527
proofing options, 536
ribbon, 519, 531
saving options, 536
saving pages, 524
screen clippings from, 579-582
sending items to, 580
sending pages to Outlook/Word, 524
Side Notes, 591
starting, 4, 526
storage structure, 516
tags, 578-579
translating content, 520
undocking, 533
Unfiled Notes section, 528

OneNote icon, 581
action associated with, changing, 593
activating, 590
missing, 590

OneNote Mobile 2010, 593
OneNote Options dialog box, 535-536, 579, 590
OneNote Web App, 593
online applications, xi, xv
online bilingual dictionary, 83, 87
On-screen Show slide size, 486
Open button (Publisher), 871
Open dialog box, 46, 48, 752
Open Notebook button (OneNote), 518, 526
Open Notebook dialog box (OneNote), 526
Open page (OneNote Backstage view), 522
Open Publication dialog box (Publisher), 871
Open XML formats, 44
opening

Access 2010, 748, 752
databases, 749, 752
diagram Text pane, 458
documents, 46, 48
forms, 768
OneNote notebooks, 518, 522, 526, 530, 546
publications, 868
tables, 753, 761-762, 805, 808, 810
Trust Center, 759

optimizing pictures for Web publishing, 930
optional attendees, 691
Options button (Publisher), 956
Options dialog box, 7, 17
order of conditional formatting rules, 333
order of worksheets, 234-235
organizing OneNote notebooks, 551
orientation, page, 672

changing, 206, 208
orphans

defined, 212
setting options for, 212, 215

Out of Office, marking time as, 682
Outline button, 57
outline levels, assigning in OneNote, 570
outline, shapes, 435
Outline tab, 392
Outline view (Word), 52
outlines, PowerPoint

exporting presentations as, 380
importing into slides, 375
opening as presentations, 376
printing, 492

outlines, Word, importing to PowerPoint, 374
Outlining tab, 57
Outlook Mobile Service account, 646
Outlook Options dialog box, 645
Outlook Today page, 735
Overhead slide size, 486
overlapping windows, 766
overwriting documents when saving, 41

P
page borders, applying, 181
Page Borders button (Word), 181
Page Break button (Word), 215
Page Break Preview (Excel), 52
page breaks

deleting, 214
inserting, 212
keyboard shortcut for, 215
soft, 212

Page Color button (Word), 13, 176
page colors (Word), 13
Page Layout tab (Word), 11
Page Layout view (Excel), 52
page length, defining. See margins
Page Number button (Word), 189
page numbers

formatting, 190
inserting, 183, 189
in publications, 896
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page orientation, changing, 206, 208, 672, 784
page setup, customizing, 671
Page Setup button (PowerPoint), 487
Page Setup dialog box (PowerPoint), 486-487
Page Setup dialog box (Word), 12, 206, 208
Page Tabs area (OneNote), 571
Page Tabs Bar (OneNote), 518, 554

collapsing, 529
collapsing/expanding, 518
default location of, 526
expanding, 554
keyboard shortcut for, 518

page tabs (OneNote)
filtering, 518
navigating, 518
ScreenTips on, 529
selecting, 529
truncating names on, 529

pages (OneNote)
blank, 551, 558
creating, 552, 555, 558
keyboard shortcuts for creating, 558
naming, 554-555
organizing, 551
subpages, creating, 558-559
templates, applying, 556
titles, entering, 554

pagination, 212, 215
paper size, changing, 206, 208
Paragraph dialog box (PowerPoint), 438, 442
Paragraph dialog box (Word), 212, 214

opening, 123
tab alignment, 122

paragraph formatting (OneNote), 569-570
paragraph formatting (Outlook), 607
paragraph formatting (PowerPoint), 437
paragraph formatting (Word)

aligning, 120-122, 125-126
borders, 123-124, 128
defined, 119
shading, 128

paragraph indenting
first line, 120
hanging indent, 120, 126, 145
left, 120, 126
right, 120, 126

paragraph marks, 56. See also non-printing 
characters

paragraph spacing, 122, 127, 148, 438
paragraph styles, 100. See also Quick Styles

finding/replacing, 130
paragraphs

aligning, 121
first letter, formatting, 202

keeping lines together, 215
keeping with next, 212
overview of, 119
selecting, 65, 71
width, defining. See margins

partner, adding to contact records, 652
Paste All button (Word), 72
Paste button (Access), 802
Paste button (PowerPoint), 401, 404, 466
Paste button (Word), 66, 70
Paste gallery, 261
Paste Live Preview, 261-262
Paste Options button (Excel), 261-262
Paste Options button (PowerPoint), 402
Paste Options button (Word), 67
Paste Special dialog box (Excel), 262
Paste Table As dialog box, 802
pasting tables, 798, 802
pasting text, 66, 70, 263, 401

from Clipboard, 404-405
in earlier versions of Excel, 261
formulas in cells, 291
keyboard shortcut for, 67, 402
options for, 70
Paste Live Preview, 261
previewing, 261
specialized, 263
undoing, 262
without formatting, 191

paths, 792
pattern, background, 341, 343
Pause button (OneNote), 589
pausing video notes (OneNote), 589
Pen button (PowerPoint), 511
pen color, 509
pen tool (OneNote), 567, 577
pencil icon, 797
People Pane

expanding, 632
filtering item list, 633
toggling between simple/detailed view, 632
troubleshooting, 633

personal information, clearing before distributing 
document, 219, 222

personal information in Publisher, 879
creating, 882
editing, 884, 887

Personal notebook (OneNote), 516, 526
Phone button, 663
phone directory, printing contacts as, 667
phone numbers

in contact records, 648
formatting, 328, 331
troubleshooting, 328
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Phone view (contact records), 660, 663
photos. See images (Excel); images (OneNote); 

images (Outlook); images (PowerPoint); 
images (Publisher); images (Word)

Pick From Drop-Down List
data entry, 257, 259
defined, 257

Picture Border arrow, 925
Picture button (OneNote), 568, 573
Picture button (PowerPoint), 448, 451, 496
Picture button (Publisher), 926
Picture button (Word), 168, 169
Picture Shape button, 928
Picture Styles gallery, 172, 924
Picture Tools Format contextual tab, 340
pictures. See images (Excel); images (OneNote); 

images (Outlook); images (PowerPoint); 
images (Publisher); images (Word)

pinning OneNote notebooks to Recently Closed 
list, 530

placeholders in slides, 393
AutoFit settings, 406
content, 448
effects, 436
filling with color, 434
formatting, 434
formatting background, 436
outline, 435
selecting all text in, 441
size/position of, 393
sizing to fit text, 439

Play button (OneNote), 587-589
playing audio notes (OneNote), 588
points (font), 901
plus signs between keys, xx
PMT() function, 287
PNG file format, 455
points (unit of measure), 436
populating databases, 789
populating OneNote notebooks, 540
populating tables, 797-798, 800
Portrait orientation, 208
Position button (Word), 198
position of placeholders, 393
postcards

address blocks, inserting, 970
categories for, 965
color schemes, applying, 966
creating, 966
greeting lines, inserting, 972
mail merging, 967, 973
templates for, 963, 965
text, entering, 969

PowerPoint 2010
file formats, 45
online version, xi, xv
starting, 4

PowerPoint Options dialog box, 407
PowerPoint presentations. See presentations 
practice files, xxi, xxix
precedents, Excel

defined, 301
tracing, to identify errors, 301

preformatted tables. See Quick Tables
preparing presentations for delivery, 491
presence icons, 630
presentations. See also templates (PowerPoint)

controlling audience view, 508
delivering, 495, 512
displaying properties, 503
dividing into sections, 380
exporting as outlines, 380
highlighting during, 509
looping continuously, 490
marking as final, 503
marking slides during, 509
preparing for delivery, 491
previewing, 495, 624
printing, 492, 495
rearrange, 384
removing ending black screen, 510
removing information from, 502, 506
saving as.rtf file, 380
themes, 423-425
transitions. See transitions
for Web page banners, 488

Presenter view, 495, 508
Preview Results button (Publisher), 972
Preview view (Calendar), 701
Preview view (Inbox), 619, 622
previewing

calendars, 977
Paste Live Preview, 261
color effects (Word), 13
cut or copied items before pasting, 402
documents, 52, 57, 207-210
OneNote templates, 552
presentations, 491, 495
printing, 672
publications, 888
table styles, 161
Word templates, 39

Previous Page button, 47, 780
Previous Record button, 827
Previous Screen button, 57
Primary Key button, 809
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Primary Key icon, 809
primary keys, 813

designating, 809
icon for, 809
overview of, 797
removing, 809

Print button, xxix, xxxvii, 217, 218, 492, 495, 673, 785
Print dialog box (OneNote), 525, 671, 674, 782, 785
Print Layout view, 52, 54, 207
Print page (Access Backstage view), 783
Print page (OneNote Backstage view), 493, 525
Print page (Word Backstage view), 208, 217
Print Preview (reports), 777-778
Print Preview (tables), 783
Print Preview And Settings dialog box 

(OneNote), 525
Print Preview button (OneNote), 525
print previewing, 52, 57, 207-210
print quality, 493
printers, 217-218
printing

address books, 667-668
booklets, 208
cards, 950
collating, 217
contact records, 667-668
database objects, 782
databases, 782
with default settings, 217, 218
duplex, 217
forms, 786
frames around slides, 493
Help topics, xxix, xxxvii
keyboard shortcut for, 208
mail merged publications, 964
number of copies, setting, 218
OneNote items, 525, 580
pages per sheet, setting, 208
presentations, 491-492, 495
publications, 888-889, 893
from Quick Access Toolbar, 34
selected items, 675
settings for, 217
speaker notes, 499
Word documents, 34

Private button, 682
private calendar items, 682
process diagrams, 454
processing queries. See running queries
product activation (OneNote), 525
product support, xxix
professionally designed color schemes, 426
program icon, 5

program user. See user name
program window, 750

manipulating, 5
minimizing, 5
overview of, 5, 8, 10
resizing, 5
scrolling contents of, 47

program window (Excel)
customizing, 241
maximizing space, 249

programs
closing, 5
previous versions, adding commands from, 7
starting, 4

promoting list items, 609
promoting text, 392
proofreading, importance of, 87, 92
properties

for documents, 15
for fields, 810
for forms, 829, 832
for PowerPoint presentations, 502-506
for workbooks, 229-232

Properties dialog box, 221, 229, 231, 502
Property Sheet

displaying, 832
keyboard shortcut for, 831
resizing, 833

Property Sheet button, 831
Propose New Time dialog box, 700
proposing new meeting time, 700
protecting documents by marking as final, 223
Publication Registration Settings dialog box 

(Publisher), 889
publications

addresses, inserting, 970
alternative text, adding, 892
backgrounds, formatting, 975
background textures, 975
basing on existing publications, 869
blank, creating, 869
business cards, 880
color schemes, 951, 958
colors, adding, 952
colors, defining, 889
company contact information in, 879
copying formatting, 960
creating, 901
design problems, fixing, 891
file types, changing, 870
fonts, embedding, 889
importing from Word documents, 869, 871, 876, 878
layout options, 873, 876
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publications (continued)
logos, changing, 882
mail merge recipients, adding, 968
mail merging, 964, 967, 973
master pages, 975-976, 981-982
navigating, 878
objects off page, fixing, 891
objects, selecting, 961
opening, 868
page numbers, displaying, 896
personal information in, 879
picture captions, adding, 979
picture placeholders, inserting, 875
placeholder text, 952
previewing, 888
printing, 888-889, 893, 897
Quick Publications, 871
registration settings, 889
saving as templates, 870
shapes, coloring, 961, 962
size, selecting, 901
starting, 868
templates for, 869-870, 872, 875-876
text color, changing, 960
text formatting, 959
text size, changing, 961
title pages, including, 877
ungrouping objects, 962

Publisher 2010
Design Checker, 888
starting, 871

text, entering. See also text boxes (Publisher)
units of measurement, changing, 905

publishers, trusting, 758
publishing databases, 795
pull quotes. See quote boxes

Q
queries

creating, 773, 860, 861-862
in design grid, 776
in Design view, 775
list of, displaying, 774
overview of, 773
properties, displaying, 774
relationships and, 776
running, 773, 775
saving, 773

Query Tools Design contextual tab, 775
Query wizard, 773
question mark character in searches, 859

Quick Access Toolbar, 750
buttons, adding, 31-32, 244, 251
buttons, positioning, 245
customizing, 5, 32, 521
exporting customizations, 245
improving efficiency with, 6
legacy commands, adding, 7
location, 244
moving, 5
overview of, 3
printing from, 34
removing buttons, 245
resetting, 32-34, 245
specifying for active document, 33

Quick Parts. See building blocks
Quick Parts button (Word), 95, 190, 194
Quick Parts gallery, 194
Quick Print button, 34
Quick Publications, 871
Quick Start fields, 799, 803
Quick Styles, 100. See also style sets

applying, 103-104
changing style set, 100
live preview of, 102

Quick Styles button (Word), 200
Quick Styles gallery, 100

displaying, 103
navigating in, 102

Quick Tables. See also tables, Word
inserting, 164
overview of, 151, 163-164

Quick Tables gallery, 164
quote boxes

inserting, 191
replacing text in, 191

quotes (quotation marks) in text strings, 330-332

R
RAND function, 354, 360
RANDBETWEEN function, 354
random rows, selecting, 354
random values, generating, 354
ranges

cell, defined, 260, 282
changing definition of, 284
comments, 282
copying, 261
creating, 282-284
deleting, 284
displaying, 283
editing, 284-285
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filtering, 284
in formulas, 282, 295
managing, 284
names, in formulas, 283, 288
selecting, 260
setting availability of, 282

Reading Pane, 619
closing, 622
displaying, in task lists, 737
magnification level, changing, 627
marking messages as read, 628-629
previewing attachments in, 620, 624
scrolling in, 629
Single Key Reading, 629

Reading Pane dialog box, 629
Reading View button (Outlook), 621
Reading View button (PowerPoint), 482, 490
Reading view (Outlook), 621
Reading view (PowerPoint), 53
read-only, 503

opening documents as, 46
rearranging

presentations, 384
slides, 386

recalculation time, displaying/updating, 287
Recall This Message dialog box, 641
recalling e-mail messages, 641
Recent page, opening documents from, 46
recent Word documents, displaying, 16
recipients

adding contacts as, 658
invisible. See Bcc field
online status, 630
presence icons, 630
thumbnails for, 632
validating. See validating e-mail addresses

recoloring pictures, 171
Record Audio button (OneNote), 586
record selector icons, 797
record source, 829
Record Video button (OneNote), 588
recording notes. See audio notes (OneNote); video 

notes (OneNote)
records

completing, 798
filtering. See filtering records
grouping, 846
incrementing ID value for, 798
jumping to, 765
marking as finished, 798
navigating, 765
removing sort, 848
saving, 798, 799
sorting, 846-849

Recurrence button, 684, 689
recurring appointments, 680, 684
recurring events, 689-690
recurring tasks, 729
red wavy lines under words, 42
Redo button, 5, 68, 402, 404, 750
redoing editing, 67, 270, 402
reducing text size using AutoFit, 411
reference materials, specifying, 81
references

absolute, 294, 307
errors, 301
relative, 291-294, 307
types of, 294-295

References tab (Word), 14
referential integrity, 814, 817
Refresh All button, 828
refreshing table data, 828
registration settings for publications, 889
related data, grouping, 282
relational databases, 760
relationship diagrams, 455
Relationship Tools contextual tab, 816
relationships

creating, 814-815
editing, 817-818
enforcing referential integrity, 817
many-to-many, 814
one-to-many, 813
one-to-one, 814
overview of, 813

Relationships button, 814, 815
Relationships page, 816
relative references, 307

changing to absolute references, 294, 295
defined, 291
usefulness of, 292

Reminder button, 682
reminders for tasks, 717
Remove Sort button, 848
removing. See deleting
Rename dialog box (Word), 30
Rename Section dialog box (PowerPoint), 382
renaming

Excel tables, 276, 278
fields, 798
sections, 382
tables, 802
tabs, 30
worksheets, 233, 235

repairing documents, 46
Repeat button (Word), 68, 113
Repeat Insertion button (Word), 146
repeating background images, 341, 343
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repeating editing, 68, 113, 146
repeating values with fill handle, 257, 259
Replace button (PowerPoint), 418, 420
Replace dialog box (PowerPoint), 418
Replace Font dialog box (PowerPoint), 418, 420
replacing data, 264, 268
replacing e-mail messages, 641
replacing fonts, 418
replacing text

keyboard shortcut for, 76, 130
options for, 76
in PowerPoint, 401, 418, 420
in Word, 75, 78

Reply button, 638, 733
replying to e-mail messages, 634, 638

closing original message after, 635
etiquette of, 635
with instant messages, 636, 657
with meeting invitation, 634
prefix used by Outlook for, 639
with voting buttons, 637

replying to task requests, 733
Report Design Tools contextual tabs, 780
Report view, 777
Report View button, 786
reports

in Design view, 780
list of, displaying, 778
navigating, 780
overview of, 777
in Print Preview, 778
views for, 777
zooming in, 778-779

Required Attendee icon, 695
required attendees (meeting requests), 695
Research button (PowerPoint), 417
Research button (Word), 80
Research Options dialog box (Word), 81
Research task pane, 79, 270, 412, 415, 417

Bing decision engine, 270
Encarta dictionary, 270
keyboard shortcuts for, 79
opening, 81, 86
Thesaurus, 270, 273
translation tools, 271, 273

researching information, 417
resending e-mail messages, 641
Reset View button, 706
resetting

Calendar view, 706
Quick Access Toolbar customization, 34
ribbon customization, 31
views, 665

resize handle, 276
resizing

columns, 763
controls, 839
fields, 805
images in Excel, 340, 343
images in OneNote, 569, 574
pictures, 170, 617, 927
program window, 5
rows, 805-806
shapes, 939
table elements, 153
tables, 152, 157
task panes, 833
text boxes, 900, 905
WordArt, 911-912

resolution. See screen resolution
resolving e-mail addresses. See validating e-mail 

addresses
responding to meeting requests, 698-700
Restore Down/Maximize button, 5
restoring data, 270
resuming drafts, 605, 607
retaining formatting for reused slides, 378
Return To Task List button, 732
Reuse Slides task pane, 376
reusing slides, 375, 378
revealing hidden fields, 806
reversing changes, 402
Review tab (OneNote ribbon), 520
Review tab (Word), 14
revising formulas, 286
revisions, clearing before distributing document, 219
Rewind 10 Seconds button (OneNote), 588
rewinding audio notes (OneNote), 588
ribbon

button appearance, xiv, xxii
button separators, 32
character formatting with, 112
collapsing, 757
commands, adding to, 33
commands no longer on, 27
commands on, xiii, xxi
customizing, 3, 26-29, 32
decreasing width of, xiv, xxii
dynamic nature of, xiv, xxii
expanding, 8, 33, 531, 751
exporting customizations, 248
groups, 7, 750
groups, removing, 27-28, 30
hiding and displaying, 249
hiding commands, 751
legacy commands, 27
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location of, 5
Main Tabs, 246
minimizing, 8, 59, 751
moving commands on, 28
in OneNote, 519
overview of, xiii, xxi, 3, 750
resetting, 31, 245
restoring, 249
tabs, 6, 246-247, 252, 750
tabs, removing, 27-28
Tool Tabs, 246

ribbon tabs, 6
adding groups to, 247
changing groups on, 247
changing order of, 246, 252
customizing, 247, 252
hiding, 246
removing, 27-28
removing groups from, 247

Rich Text Format (RTF)
defined, 603
outlines, importing, 374
saving presentations as, 380

right indent, 120, 126
right-aligning labels, 838
right-aligning text, 121-122
Right Tab button (Word), 149
ripple slide transition, 479
Room Finder, 693
Rotate button (PowerPoint), 473
Rotate button (Publisher), 900, 933
rotating effect in slide transitions, 480
rotating graphics, 920
rotating shapes, 470, 473, 931, 933
rotating text, 394, 397
rotating text boxes, 900
row headings, 261
Row Height dialog box, 806
rows, Excel table

adding and removing, 276
creating, 275

rows, form, 840
rows, Word table

deleting, 153
inserting, 153
resizing, 153
setting properties of, 159

rows, worksheet
changing height, 237
changing multiple, 237
copying, 261
deleting, 238
filtering. See filters
formatting, 312

hidden, and SUM and AVERAGE functions, 355
hidden, in AGGREGATE function, 358
hiding, 238
inserting, 237, 239
labels, as range names, 283
labels, hiding, 249
random, selecting, 354
selecting, 261
unhiding, 238

RTF (Rich Text Format) files. See Rich Text 
Format (RTF)

rule lines (OneNote), 571
Ruler check box, 450
rulers and gridlines

displaying, 53, 120
hiding, 56
markers on, 120
setting tab stops with, 121

rules
conditional formatting, 332-338
filter, defining, 350

rules, validation
creating, 361
entry messages with, 363, 364
error messages with, 363, 364
and existing data, 362
overview of, 361
requiring numeric values, 362
setting for multiple cells, 362
specifying minimum and maximum, 364
specifying whole numbers, 364
turning off, 363
validation circles, 362, 366
violations, displaying, 362, 366

Run button, 776
Run Design Checker button (Publisher), 890
running

Access 2010, 748, 752
Excel 2010, 4, 227, 229
OneNote 2010, 4, 526
PowerPoint 2010, 4
programs, 4
Word 2010, 4, 10

running heads, xix
running queries, 773, 775-776

S
sample data, creating with RANDBETWEEN 

function, 354
sample templates, 39
Save As command, 41, 229, 231
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Save As dialog box (Access), 801
Save As dialog box (Excel), 231
Save As dialog box (PowerPoint), 380
Save As dialog box (Word), 39, 42-43
Save As page (OneNote Backstage view), 524
Save As Type arrow (Word), 40
Save button (Access), 750, 798, 815
Save button (Outlook), 604
Save button (PowerPoint), 391
Save button (Word), 5, 39, 41-42
Save & Close button, 652, 683, 725, 728
Save & New arrow, 653
Save Current Theme dialog box (Excel), 322, 326
saving conditional formatting rules, 333
saving documents, 39, 42

automatically, 41
creating folders for, 43
as earlier format, 45
folders, creating for, 40
in new location, 40, 43
as new version, 41
keyboard shortcut for, 41
overwriting when, 41

saving e-mail messages, 605
saving forms, 828, 836
saving message drafts, 604
saving OneNote items, 524, 567
saving presentations, 380
saving publications, 870
saving queries, 773
saving records, 798, 799
saving tables, 798, 801, 815
saving themes, 107, 109, 829
saving workbooks, 229-232
scaling

OneNote images, 568
printed pages, 208
slides when printing, 493

Schedule view (Calendar), 702
Scheduling Assistant button, 695
Scheduling Assistant page, 692-693, 695
scheduling meeting requests, 693, 695
Schemes gallery, 958
Screen Clipping button (OneNote), 581
screen clippings from OneNote, 579

adding to notebooks, 581
capturing, 581
displaying, 582
options for, 580
sending to new page, 581

Screen Clipping tool, 569, 581
ScreenTips

for attachments, 623
for clip art, 922

customizing display of, 7, 751
displaying, xxv, 7, 10, 18
feature descriptions, hiding in, 19
language, specifying, 21
for OneNote images, 576
overview of, xxxiii
for search results, 74
viewing, 751

scroll bar, navigating with, 47
scrolling in Reading Pane, 629
scrolling pages in OneNote, 565
Search box, filtering and, 349, 352
searching. See also finding text

in audio notes, 585
for clip art images, 452, 919-920, 924
filters for, 349
in Help window, xxviii, xxxvi
for Publisher templates, 869
wildcards for, 75, 857, 859
for Word templates, 39
in worksheets, 264-266

section breaks
for columns, 140, 142
deleting, 214
formatting mark for, 214, 216
inserting, 214, 216
overview of, 214

Section button (PowerPoint), 381, 383
section groups (OneNote), 555

adding sections to, 560
creating, 559
opening, 560

section tabs (OneNote), 571
sections (OneNote)

color, changing, 555
creating, 555, 559
grouping. See section groups (OneNote)
keyboard shortcut for creating, 559
naming, 554-555

sections (PowerPoint)
creating in Slide Sorter view, 382
deleting, 386
dividing presentations into, 380, 384
rearranging, 386

sections (Word), changing margins, 208
security warnings, 752, 758
See Also paragraphs, xx
Select All button, 834, 840
Select Browse Object button, 48, 50
Select button (PowerPoint), 441
Select button (Publisher), 905
Select button (Word), 142, 153
Select Column button, 838
Select Data Source dialog box (Publisher), 967
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Select Location In OneNote dialog box, 582-583
Select Name dialog box, 658-659
Select Row button, 840
Select Table dialog box (Publisher), 967
Select & Type button (OneNote), 577
select queries, 773
selecting

adjacent fields, 806-807
all controls, 834, 840
cells, 260
controls, 824
fields, 809
multiple columns, 849
outline levels in OneNote, 570
ranges, 260
shapes, 931
tables, 153, 802
text, 905
text boxes, 907
WordArt, 915
worksheet columns/rows, 261

selecting all, 142
keyboard shortcut for, 65
in placeholders, 441
with Select button, 214

selecting text, 65, 68, 71, 141, 401
by line, 103
deselecting, 66
in tables, 155

selection area, 65
Selection button, 851
selections, creating ranges from, 283
selector, 809
Send Backward button (Publisher), 945
Send button, 605, 612, 696, 734
Send page (OneNote Backstage view), 524
Send Status Report button, 733
senders, creating contacts from, 655
sending e-mail messages, 605, 612, 614, 641
sending meeting requests, 696
Sent Items folder, 605, 613
sent messages

save location, changing, 605
viewing, 613

sentences, selecting, 65
series axis, 463
series, data, 463

entering, 256-258
in Excel tables, 276
types of, 257

Set Numbering Value dialog box (Word), 134
Set Quick Click dialog box, 719
SET UP paragraphs, xx

Set Up Show dialog box (PowerPoint), 487, 490, 508
Set Up Slide Show button (PowerPoint), 490
setting a watch, 303-304
setting up automatic slide shows, 491
setting up presentations, 491
setting workbook properties, 229, 231
Shading button (tables), 163
shading cells in Excel worksheets, 312, 314, 324, 334
shading cells in Word tables, 162
shading paragraphs, 128
shadow effects, 439

in forms, 835
for WordArt, 918

Shadow Effects button, 918
Shape Effects button (PowerPoint), 436
Shape Fill arrow (Publisher), 905, 962, 982
Shape Fill button (PowerPoint), 434
Shape Fill button (Publisher), 915
Shape Fill gallery, 915
Shape Outline arrow (Publisher), 937, 961
Shape Outline button (PowerPoint), 435
Shapes button (PowerPoint), 470-471
Shapes gallery (PowerPoint), 471
shapes, PowerPoint

adjusting, 470
connecting, 478
copying, 471, 473
copying formatting, 471, 478
drawing, 470
duplicating, 471, 474
effects, changing, 436
filling with color, 434
flipping, 473
formatting, 434, 471
grouping, 476
moving, 471
outline, changing, 435
rotating, 470, 473
setting default formatting, 471
sizing, 470, 474
text, adding, 471, 474

shapes, Publisher
applying to pictures, 928
circles, drawing, 933
coloring, 934, 961-962
connecting, 932, 935-936
connecting, changing line color when, 937
copying, 931
copying formatting to, 932
creating, 931
default settings, 932
drawing, 933
flipping, 933
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formatting, 931, 933
grouping, 932, 937-938
inserting, 932
layout, changing, 931
line weight, changing, 937
moving, 931, 939
outlines, applying, 962
overview of, 931
resizing, 939
rotating, 931, 933
selecting, 931
sizing, 931
squares, drawing, 933
text in, 931

Shapes button (Publisher), 932
Shapes gallery, 932
Share button (OneNote), 546
Share page (OneNote Backstage view), 523
Share tab (OneNote ribbon), 520
Share This Notebook button (OneNote), 544
Shared Notebook Synchronization dialog box 

(OneNote), 549
SharePoint

file location, setting default, 20
sharing notebooks from, 545, 547

sharing OneNote notebooks, 520, 523, 540, 544, 547
e-mailing link to, 546
from SharePoint, 545, 547
on internal network, 545, 547
on Web, 544, 547

sharing Word documents, 16
Sheet Background dialog box (Excel), 341, 343
shortcuts. See keyboard shortcuts
Show As button, 682
Show Hidden Icons button (OneNote), 590
Show/Hide ¶ button (Word), 53, 68, 149
Show Page Numbers button (Publisher), 896
Show Table button, 818
Show Table dialog box, 815, 818
Show Table of Contents button, xxvii, xxxv
Shrink Font button (Word), 116
shrinking text to fit text box, 395
Shutter Bar Open/Close button, 752
Shutter Close button, 762
shutter effect for slide transitions, 479
Shutter Open button, 763, 793
sidebars, Word

inserting, 192
resizing, 193

Side Notes
docking to desktop, 591
keeping on top, 592
keyboard shortcut for, 591

modifying, 591
opening, 591
resizing, 592

side-by-side page display, 55
signatures, e-mail, 604
Single Key Reading, 629
Single view (Inbox), 619, 622
single-line text boxes, 393
size of placeholders, 393, 439
size of slides, 486
size of text, 438
sizing

building blocks, 944
cards, 955
charts, 467
diagrams, 456, 459
pictures, 170, 450-451, 926
program window, 750
shapes, 470, 474, 931
slides, 488
text boxes, 394

slide backgrounds
applying, 433
changing , 429, 433
colors, 426
formatting placeholder, 436

slide layouts
applying, 374
changing existing slides, 372
diagram, 459
selecting from New Slide gallery, 371

slide libraries, 379
slide markup

erasing, 511
printing, 493

slide numbers in footers, 487
Slide Orientation button (PowerPoint), 488
Slide pane, adding text in, 390
Slide Show button (PowerPoint), 509-510
Slide Show view (PowerPoint), 485, 491
slide shows

looping continuously, 490
starting automatic, 491

slide size, changing, 486
Slide Sorter button (PowerPoint), 381, 482
Slide Sorter view (PowerPoint), 53, 482

creating sections in, 382
rearranging slides in, 385

slide transitions
adding to presentations, 479, 483
animating, 481
dynamic content, 480
exciting, 479
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removing animation, 481
sounds, adding, 482
subtle, 479
timing, 483
viewing, 482

slides
adding, 371, 374
applying color scheme to selected, 426
changing order within presentations, 386
charts in, 462
clip art images in, 448
copying from other presentations, 375
date/time in, 489
deleting, 371, 374
diagrams in, 455-456
displaying full screen, 509
displaying preview, 494
dividing into sections, 384
duplicating, 375, 378
footers, 489
highlighting during presentations, 512
importing outlines, 374, 375
in slide libraries, 379
libraries, 379
moving, 384
notes in. See notes pages (PowerPoint)
number, adding, 489
pictures in. See images (PowerPoint)
previewing, 494
printing, 492
rearranging, 386
rearranging in Slide Sorter view, 385
renaming sections, 382
reusing, 378
saving as pictures, 448
size, changing, 486
sizing, 488
text, adding, 390
titles, 390

Slides tab, 384
SmartArt button (PowerPoint), 455, 497
SmartArt graphics, 454. See also diagrams
SmartArt Styles gallery, 460
smart cut and paste, 69
SMS messages. See text messages
soft page breaks, 212
software support, xxix
Some Data May Not Be Displayed message, 778
Sort button (Word), 131, 135, 154
Sort Text dialog box (Word), 137
sorting

in Access, 850
contact records, 663

lists, 131, 135
tables, 154
text, 137

sorting records, 846, 848
alphabetically, 847
in descending order, 848
in forms, 846
on multiple fields, 846, 849
with numbers, 850
removing sort, 848

sounds, associating with slide transitions, 482
spaces, automatic insertion of, 69
spacing

character, 439
between columns, 144
paragraph, 122, 127, 148, 438

Spanish dictionary, 412
speaker notes

adding diagrams, 498
adding headers/footers, 499
adding to slides, 495, 497
preparing, 501
printing, 492, 499

Special formats (number), 328
special text. See text effects
Spelling And Grammar dialog box (Word), 88, 91
Spelling button (PowerPoint), 412, 414
spelling, checking, 42, 269, 272, 412, 415, 520

adding new words to dictionary, 269, 272
with AutoCorrect, 88-89
with shortcut menu, 88, 90
with Spelling and Grammar dialog box, 88
turning off, 412
typos, 63

Spelling dialog box (Excel), 272
Spelling & Grammar button (Word), 88, 91
Split Cells button (Word), 154
splitting cells, 154
splitting documents, 53
spouse, adding to contact records, 652
spreadsheets. See worksheets
square brackets [ ] in formulas, 289, 299
squares, drawing, 933
Stacked layout, 837
stacking

text, 394
windows, 59

Start button, 4, 748
Start menu, 4, 748
starting

Access 2010, 748, 752
Excel 2010, 4, 227, 229
OneNote 2010, 4, 526
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starting (continued)
PowerPoint 2010, 4
programs, 4
publications, 868
Publisher, 871
Word 2010, 4, 10

statistics, document, 93
status bar

AutoCalculate on, 355
cursor location on, 47
customizing, 8, 752
default items on, 9

status reports, 733
Stop button (OneNote), 587, 589
stories (Publisher), 900
storing OneNote notebooks, 540
street addresses, entering in contact records, 656
strikethrough effect, 439
strings, text, 330-332
Style dialog box (Excel), 316-317
style sets. See also Quick Styles

changing, 100, 104
displaying list of, 101
live preview of, 101

styles, picture, 172
styles, table

adding to Cell Styles gallery, 317
applying, 316, 323
clearing, 323
creating, 316-317, 322-323
default, changing, 323
deleting, 317
overview of, 316
previewing, 161, 316

subdatasheets, 762, 764
subforms, 768
subpages (OneNote)

collapsing, 559
creating, 558
keyboard shortcut for, 558-559

SUBTOTAL function
and column headers, 356
and filters, 357
AVERAGE operation, 356
compared to AGGREGATE, 357
COUNT operation, 356
COUNTA operation, 356
function_num argument, defined, 355
ignoring in AGGREGATE function, 358
introduced, 355
limitations of, 357
MAX operation, 356
MIN operation, 356
operations, summarized, 356
PRODUCT operation, 356

STDEV.P operation, 356
STDEV.S operation, 356
SUM operation, 356
syntax, 355
VAR.P operation, 356
VAR.S operation, 356

SUM function, 287, 295, 355
SUMIF function, 297
SUMIFS function, 297, 299-300
summaries, viewing, 221
summarizing data. See also formulas, Excel; 

functions
with AutoCalculate, 355, 359
in Excel tables, 276, 277

summary formulas and conditional formatting, 336
supplemental dictionaries, 412, 415
Switch Row/Column button (PowerPoint), 469
Switch Windows button (PowerPoint), 425
switching

documents, 59
effect of, 321
files, 53
presentations, 425
rows/columns in charts, 469
views, 765, 771
workbooks, 227

Sync Now button (OneNote), 550
synchronizing forms and tables, 828
synchronizing OneNote notebooks, 543, 549-550
synonyms, 412, 415-416. See also Thesaurus

defined, 79
displaying more, 416
searching for, 79, 85

T
tab bar, 233
Tab Index property, 842
Tab Order button, 842
Tab Order dialog box, 842
tab stops. See also tabbed lists

center-aligned, setting, 148
default, 121
deleting, 122
moving, 122
precisely placing, 122
right-aligned, setting, 149
setting, 121, 122

tabbed lists. See also tab stops
entering text for, 147
formatting text in, 148
overview of, 147
setting up, 147
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tabbed pages, 766
Table button (Access), 798, 803, 815
Table button (Outlook), 609
Table button (Word), 154, 164
table cells

borders, 162
deleting, 153
inserting, 153
merging, 153, 155
setting width of, 159
shading, 162
splitting, 154

table columns
deleting, 153
inserting, 153
resizing, 153
setting width of, 159

Table gallery, 609
Table Properties dialog box (Word), 159
table relationships. See relationships
table styles

adding to Cell Styles gallery, 317
applying, 316, 323
clearing, 323
creating, 316-317, 322-323
default, changing, 323
deleting, 317
overview of, 316
previewing, 161, 316

Table Styles gallery, 160-161, 611
Table Tools contextual tabs, 753, 796
tables, Access, 789. See also columns, tables; 

fields; rows
closing, 757, 764, 801
copying/pasting, 798, 802
creating, 798, 815
creating forms from, 824
in Datasheet view, 762
defining structure of, 797
deleting, 802
in Design view, 808
fields, renaming, 798, 800
navigating, 797, 799
newly created, 796
opening, 753, 794, 762, 805
opening in Datasheet view, 761
opening, in Design view, 761, 808, 810
overview of, 761
populating, 797, 798, 800
primary key field, 797. See also primary keys
in Print Preview, 783
refreshing data in, 828
renaming, 802

saving, 798, 801, 815
selecting, 802
switching between, 825
undoing data entry, 798
views for, 761

tables, Excel. See also rows, Excel table
AutoExpansion, 275
columns, adding/removing, 276
converting to range, 277
creating, 275, 277
data, adding, 275, 277
data series in, 276
Design contextual tab, 277
fill color, 324
filtering. See filters
formatting, 322
formulas in, 276, 277, 293
in formulas, 289
names, adding to formulas, 295
overview of, 255
renaming, 276, 278
resize handle, 276
rows, adding/removing, 276
summarizing data in, 276, 277
table style gallery, 275
Total row, 276

tables of contents for Help window, xxvii, xxxv
tables, Outlook

entering text in, 610
formatting, 612
inserting, 609
layout, selecting, 609
printing contacts as, 667
style, changing, 611

tables, Word, 139. See also Quick Tables; rows, 
Word table

aligning text in, 156, 163
alt text, entering, 159
banded rows, 161
borders around cells, 162
calculations in, 158
cell width, setting, 159
centering text in, 155
column width, setting, 157, 159
components of, 152
converting to/from regular text, 152, 156
creating, 150, 154
cutting and pasting, 153
deleting rows/columns/cells, 153
drawing, 151
entering text, 152, 155
formatting, 160
formatting text in, 155
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tables, Word (continued)
headings, rotating, 163
inserting rows/columns/cells, 153, 155-156
margin settings, 159
merging cells, 153, 155
move handle, 152, 153, 157
moving, 153
navigating in, 152
overview of, 149
previewing, 154
resizing, 153, 157
row properties, setting, 159
saving as Quick Tables, 165
selecting elements in, 153, 155
shading cells, 162
size handle, 152, 157
sorting, 154
splitting cells, 154
total rows, 161
width, setting, 159

Tablet PC, entering notes with, 567
tabs, 6, 750, 753, 757

contextual, 609
customizing, 26
keyboard, 56. See also nonprinting characters
Outline, 392
Overview pane, 392
removing, 27, 28
renaming, 30
Slides, 384

tabular layout, 837
Tag Image File Format (TIFF), 455
tagging documents, 221
tags (OneNote)

applying, 579
keyboard shortcuts for, 579
overview of, 578

task assignments, replying to, 637
task folders, 742
task lists. See also To-Do List

Daily Task List, 735
default view, 737
flagged messages in, 719
multiple, 716
Reading Pane, displaying, 737
viewing, 715
views, 736, 740

task panes
opening, 793
resizing, 833

task windows, 718

tasks
accepting, 733
assigning, 730, 731, 733
assigning to contacts, 657
Category, 718
colors, changing, 742
creating, 605, 716, 718-719, 725
declined, processing, 731
declining, 733
deleting, 717, 730
due date, 717, 719, 722-725, 727
due today, viewing, 735
filtering, 742
finding, 742
forwarding, 733
icons for, 723
information in, 717
Instant Search, 742
marking as complete, 717, 721, 729
notes, adding, 724
notes in, 727
opening, 720, 727
options, 717
Priority, 717
Privacy, 718
Quick Click flag, 719
recurrence, 717, 729
reminders, setting, 717-718, 725, 727
reordering, 737
start date, changing, 717, 722, 727
status, changing, 717, 726, 727
status reports, sending, 733
status, viewing, 731
view, changing, 738

Tasks button, 722
Tasks List

changing to, 736
fields in, 717
viewing, 735

Tasks module
creating tasks in, 716
opening, 723
views, switching, 736

technology certification, xii, xvi
telephone numbers. See phone numbers
Template Category dialog box (Publisher), 870
templates (Access)

creating databases from, 791
modifying, 790
overview of, 790
viewing, 791
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templates (OneNote)
creating pages from, 552, 556
previewing, 552

templates (Publisher). See also application parts
for calendars, 977
for cards, 950, 952, 953
for catalogs, 964
color scheme applied to, 965
keywords for, 869
for postcards, 963, 965
for publications, 868-870, 872, 875-876
saving publications as, 870
searching for, 869

Templates task pane (OneNote), 552, 556
templates (Word)

displaying, 16
previewing, 39
recently used, 39
sample, installed with Word, 39
searching for, 39

Tentative availability, 693
text

aligning, 438, 838
applying attributes to, 439
capitalization, changing, 439
character spacing, changing, 439
color, changing, 439
deleting, 403
in diagrams, 457
direction, changing, 394
editing, 404
entering, 390
entering/editing in text boxes, 394
finding, 418
finding/replacing, 420
formatting effects, 444
formatting in columns, 140
line spacing, changing, 438
in numbers, 329, 332
outside of placeholders, 393
placeholders for, 393
promoting/demoting, 392
replacing, 418
rotating, 394, 397
selecting all in placeholder, 441
in shapes, 471, 474
shrinking to fit text box, 395
size, changing, 438
sizing to fit placeholder, 406
stacking, 394
in templates, 437
wrapping in text boxes, 395

Text Box button, 393, 396, 451, 474

text box controls
overview of, 821
properties of, 829
resizing, 839

Text Box Tools Format contextual tab, 903, 959
text boxes, 393

adding borders, 395, 398
adding to slides, 451
angle, changing, 900
changing effect, 436
changing outline, 435
character spacing, changing, 907
coloring, 905
copying, 394, 900
creating, 400, 902-903
default font,changing, 400
deselecting, 395
drawing, 196
entering/editing text, 394
filling with color, 434
font color, changing, 905
font effects, applying, 907
fonts, changing, 905
formatting, 900
inserting, 191
inserting files in, 904
linking, 196
manipulating, 394
moving, 394, 397, 900
multi-line, 393
overview of, 183, 900
positioning, 196
replacing text in, 191
resizing, 900, 905
rotating, 900
saving to Quick Parts Gallery, 194
selecting, 907
selecting text in, 825, 905
sidebars, inserting, 192
sidebars, resizing, 193
single-line, 393
sizing, 394
stories in, 900
text direction, changing, 900
wrapping text within, 395

text boxes (OneNote). See note containers 
(OneNote)

Text button, 812
text colors, 426
Text Direction button (Publisher), 900
Text Direction button (Word), 163
text effects, 901, 907. See also WordArt

applying, 101, 105, 116
live preview of, 105
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Text Effects button (Word), 101, 105
text, entering, 41, 64

in OneNote, 565, 572
on Outline tab, 390
in Slide pane, 390
in text boxes, 394

Text Fit button (Publisher), 908
Text Formatting dialog box launcher, 755
text, hiding, 53
Text Highlight Color arrow (Word), 34
Text Highlight Color button (Word), 117
text messages, forwarding e-mail messages as, 635
Text Pane button (PowerPoint), 457
text, selecting, 65, 68, 71, 141, 401

by line, 103
deselecting, 66
in tables, 155

text size
changing, 111, 116, 313
incrementing, 116
keyboard shortcuts for adjusting, 116

text strings, quotation marks in, 330, 332
text wrapping

in text boxes, 395
around WordArt, 199

textured backgrounds, 178, 430
Theme Colors button (Word), 107
theme colors (Word)

changing, 107, 117
previewing effects of, 13

Theme Fonts button (Word), 108
themes (Access)

applying, 831
changing, 829
customizing, 830, 835
mixing and matching, 829
overview of, 829
saving, 829

Themes button (Access), 829-830
Themes button (Word), 13, 106-107
themes (Excel)

active, and available colors, 321
applying, 320
changing, 322, 326
colors in palette, 321
creating, 322
default, 320
defined, 320
in other Office programs, 322
Office theme, 320
switching, effect of, 321

Themes gallery, 424

themes (PowerPoint), 423
applying different, 425
live previews of, 424
switching , 424

themes (Word)
applying, 106, 107
color set, changing, 108
font set, changing, 109
from Microsoft Office Online Web site, 107
gallery of, 13
live preview of, 107
mixing and matching, 107
overview of, 106
saving, 107, 109

Thesaurus, 270, 273, 412, 416
finding synonyms in, 85
overview of, 79

Thesaurus button (PowerPoint), 415
Thesaurus button (Word), 79, 85
threaded message view. See Conversation view
three-dimensional borders, 128
thumb tabs, xix
thumbnails, 384

galleries of, 10
tick-mark labels in charts, 463
TIFF file format, 455
time

in footers, 487
formatting cells for, 319
in OneNote, inserting, 584

time of recalculation, using NOW() function to 
display, 287

time zones, specifying for appointments, 681
Tip paragraphs, xx
title bars, 5, 750
title pages for publications, 877
titles

document, 220
slide, 390

To-Do Bar. See also task lists
closing, 613
creating tasks in, 717, 722
dragging messages to, 719, 721
minimizing, 707
Task List, 715
views, switching, 735

To-Do Bar button, 707
To-Do Bar Tasks List, 735
To-Do List

creating tasks in, 716
overview of, 715
resizing, 721
viewing, 735
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Today button, 705
Toggle button, 632
Toggle Filter button, 852, 854, 857, 861
toggling filters, 852
Toolbar, Mini, 65, 312, 439, 440

character formatting with, 111
hiding, 18

toolbar, navigation, 509-510
Toolbar, Quick Access

buttons, adding, 31-32, 244, 251
buttons, positioning, 245
customizing, 5, 32, 521
exporting customizations, 245
improving efficiency with, 6
legacy commands, adding, 7
location, 244
moving, 5
overview of, 3
printing from, 34
removing buttons, 245
resetting, 32-34, 245
specifying for active document, 33

tools, data entry
AutoComplete, 257
AutoFill, 256
AutoFill Options button, 258, 260
FillSeries, 256
overview, 255
Pick From Drop-Down List, 257, 259

tools, formatting. See formatting
tools, research, 270. See also Research task pane
Top 10 AutoFilter dialog box (Excel), 349, 352
Top 10 filter, 349
total rows in tables, 161, 276
totals, viewing with AutoCalculate, 355, 359
tracer arrows, 301-302, 304, 306

hiding, 302, 305-306
tracing dependents to identify errors, 302
tracing precedents to identify errors, 301, 304
transitions

adding to presentations, 479, 483
animating, 481
dynamic content, 480
exciting, 479
removing animation, 481
sounds, adding, 482
subtle, 479
timing, 483
viewing, 482

Translate button (PowerPoint), 417
Translate button (Word), 82, 86
translating text, 271, 273, 417

entire documents, 84
in Excel, 271

in OneNote, 520
options for, 86
in Word, 82, 86

Translation Language Options dialog box 
(Word), 84

transparencies, 486
transparent graphics, 920
transposing data in paste operations, 263
troubleshooting formulas, 286
Troubleshooting paragraphs, xx
troubleshooting People Pane, 633
Trust Center (Access), 759
Trust Center dialog box (Word), 25
Trust Center (Word), 24-25
trusted locations, setting, 25, 758-759
turning effect in slide transitions, 479
two monitors, 508
typos. See spelling, checking

U
Underline button (Word), 113
underlining text, 113, 439
undo actions, changing default number of, 403
Undo button, 5, 68, 70, 270, 353, 402, 404, 750
undocking OneNote, 533
undoing editing

keyboard shortcut for, 67, 402
procedure for, 68, 70, 270, 402, 837

undoing table data, 798
Unfiled Notes section (OneNote), 528
unfreezing fields, 807
Ungroup button (Publisher), 962
ungrouping publication objects, 962
ungrouping shapes, 478
Unhide Columns dialog box, 807
Unhide dialog box (Excel), 234, 236
unhiding fields, 806
unhiding rows/columns, 238
unique identifiers, 823. See also primary keys
unique values

displaying, 358, 359
and headers, 359, 360

units of measurement, 905
unread messages, 619
updating charts automatically, 468
updating meetings, 697
updating pictures automatically, 449
updating task status, 726
uppercase. See case
user-defined fields, 666
user input in exercises, xx
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user input, validating. See validation rules
user interface. See also ribbon

color scheme, changing, 18
common to Office programs, 3
customizing, 241
elements, navigating, 48

user interface objects in text, xx
user name

AutoText for, changing, 190
common to Office programs, 3
entering, 10
setting, 19

V
validating e-mail addresses

address book search order, customizing, 602
keyboard shortcut for, 599

validation circles
displaying, 362, 366
hiding, 363, 366

validation rules
creating, 361
entry messages with, 363-364
error messages with, 363-364
and existing data, 362
minimum and maximum, specifying, 364
overview of, 361
requiring numeric values, 362
setting for multiple cells, 362
turning off, 363
validation circles, 362-363, 366
violations, displaying, 362, 366
whole numbers, specifying, 364

value axes in charts, 463
values. See also numbers

adding together, 286
average, viewing with AutoCalculate, 355, 359
comparing , 334-337
count, viewing with AutoCalculate, 355, 359
filtering for highest or lowest, 349, 353
finding, 854
ignoring in calculations, 357
maximum and minimum, 281, 287
monitoring, 303, 304
replacing, 264
searching for, 264
searching in, 266
sum of, 286
testing, 332-338
total, viewing with AutoCalculate, 355, 359
unique, displaying, 358-359

VBA macros, 758, 759
vertical scroll bar, 47
video notes (OneNote)

appearance of, 586
manipulating video in, 585
pausing, 589
playing, 588
recording, 585, 588
rewinding, 588
searchability, activating, 585

View arrow, 761
View button, 771, 812
View Multiple Sheets button (Publisher), 894
View Ruler button (Word), 120
View Shortcuts toolbar, 9, 52, 752, 761
View Sync Status button (OneNote), 549
View tab (Excel), 242
View tab (OneNote), 521
View tab (Word), 14, 52
viewing color schemes, 426
viewing workbook properties, 229
views

advanced settings for, 661
column width, changing, 665
customizing, 661, 664
resetting, 665
switching, 761, 765, 771

views, Normal
creating slide sections in, 384
in PowerPoint, 53

views, Notes Page, 53, 494
views, Reading, 53, 482, 490
views, Slide Sorter, 53, 482

creating sections in, 382
rearranging slides in, 385

views, Web Layout, 52
visible cells, summarizing, 355, 357
volatile functions, 354
Vote button, 637
voting buttons, 637

W
watch

deleting, 303, 307
setting, 303-304

Watch Window
defined, 303
deleting a watch, 303, 307
setting a watch, 303, 304

watermarks as background images, 341
Web App (OneNote), 593
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Web Apps (Office), xi
Web browsers, previewing documents in, 52, 57
Web databases, 795

creating, 795
forms for, 822
objects in, 795
publishing databases as, 795

Web Layout button, 57
Web Layout view (Word), 52
Web notes (OneNote), 579

capturing, 583
creating, 583
default location for, 581
options for, 580

Web page banner presentations, 486, 488
Web Page button, 657
Web pages

converting Word documents into, 23
sending to OneNote notebooks, 579

Week view (Calendar), 702, 703, 708
white space between Word pages, hiding, 54
wide margins, 210, 216
widows

defined, 212
setting options for, 212, 215

width, column, 237
wildcards in searches, 75, 857, 859
Windows Live Translator, 84
Windows Photo Viewer, 576
windows, overlapping, 766
windows, stacking, 59
windows, workbook

arranging multiple, 243, 251
cascading, 243, 251

wipe transition effect, 479
Word 97-2003, saving documents as, 21
Word 2010. See also Word documents

compatibility with earlier versions, 44
file formats, 44
first time starting, 10
handouts, creating, 501
Help window, opening, xxvi, xxxiv
OneNote pages, sending to, 524
online version, xi, xv
starting, 4, 10
views in, 52

word choice, researching, 270
word count, 93
Word Count button (Word), 93
Word Count dialog box (Word), 93
Word documents. See also saving documents

blank, creating, 41
blank, opening, 38
closing, 48, 51

compatibility with earlier versions, 44
creating, 38-41
default format, setting, 20
e-mailing, 615
formatting in columns, 141. See also columns, 

document
full-screen display, 52, 56
inserting in other documents, 97
location, specifying, 23
maximizing, 59
moving to top, 55
navigating, 47, 56-57, 71
opening, 46, 48
printing with default settings, 34
read-only, opening as, 46
recently opened, 16, 46
renaming when saving, 43
repairing, 46
scrolling through, 47, 50
selecting, 65
sharing, 16
side-by-side display, 55
splitting into two panes, 53
switching between, 53, 59
translating, 84
viewing multiple, 59
zooming in/out, 53

Word Options dialog box (Word), 17, 19
AutoRecover settings, 41
Recent page options, changing, 16

Word outlines, importing to PowerPoint, 374
Word tables, 139. See also Quick Tables

aligning text in, 156, 163
alt text, entering, 159
banded rows, 161
borders around cells, 162
calculations in, 158
cell width, setting, 159
centering text in, 155
column width, setting, 157, 159
components of, 152
converting to/from regular text, 152, 156
creating, 150, 154
cutting and pasting, 153
deleting rows/columns/cells, 153
drawing, 151
entering text, 152, 155
formatting, 160
formatting text in, 155
headings, rotating, 163
inserting rows/columns/cells, 153, 155-156
margin settings, 159
merging cells, 153, 155
move handle, 152, 153, 157
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Word tables (continued)
moving, 153
navigating in, 152
overview of, 149
previewing, 154
resizing, 153, 157
row properties, setting, 159
saving as Quick Tables, 165
selecting elements in, 153, 155
shading cells, 162
size handle, 152, 157
sorting, 154
splitting cells, 154
total rows, 161
width, setting, 159

WordArt button, 198, 908-909
WordArt gallery, 909
WordArt objects

aligning, 911
best practices for, 908
centering, 198
colors, setting, 917
converting text into, 197
editing text, 909
formatting, 912
gradient fill, adding, 915
inserting, 197-198, 908-909
layout, modifying, 913
moving, 911
overview of, 197, 908
page position, modifying, 913
positioning, 198
resizing, 911, 912
selecting, 915
shading styles, 917
shadow effects, 918
shape, changing, 913, 914
starting new lines in, 198
styles, applying, 200, 909
text wrapping, 199

words
adding to dictionary, 269, 272
selecting, 65, 68

Work Week button, 705
Work Week view (Calendar), 702, 705
workbooks

arranging multiple windows, 243, 251
copying worksheets, 233, 235
creating, 228, 230
default, 228
display font, changing, 313, 315
displaying side by side, 243
Document Properties panel, 229

filtering ranges, 284
properties, 229-232
saving, 229, 232
switching between, 227, 243, 251
themes. See themes, Excel

worksheet cells. See also ranges
absolute references, 294, 307
active, 260-261, 349
aligning, 318
borders, 312, 314
contiguous, in formulas, 290
copying, 258, 261
deleting, 238, 240
deleting contents/formatting of, 311
entering data in, 256, 258
filtering. See filters, Excel
finding sum of, 286
formatting, copying, 258, 260
individual, selecting, 260
inserting, 238, 240
monitoring values in, 303, 304
moving, 238, 240
moving to, 260
noncontiguous, adding to formulas, 290
noncontiguous, formatting, 314
number formatting in, 319
pasting formulas in, 291
references, 294-295, 301
shading, 312-314, 324
visible, summarizing, 355, 357

worksheet columns
changing multiple, 237
copying, 261
deleting, 238
##### error code, 301
filtering. See filters
formatting, 312
hiding, 238-239
inserting, 237, 239
labels, and filtering, 349
labels, as range names, 283
labels, hiding, 249
moving, 261
selecting, 261
unhiding, 238
width, changing, 237
width errors, 301

worksheets, Excel
backgrounds, 341-344
columns. See columns, worksheet
copying, 233, 235
creating, 233
deleting, 234, 236
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displaying, 233
filtering. See filters
hiding, 234, 235
images, adding, 339, 342
purpose of, 233
renaming, 233, 235
reordering, 234-235
rows. See rows, worksheet
searching, 264
tab color, changing, 234-235
unhiding, 234, 236

Wrap Text button (Word), 199
wrapping text

in text boxes, 395
around WordArt, 199

X
XML data, removing before distributing 

document, 222
XML file formats, 44
XPS format

printing documents to, 223

Y
y-axis, 463

Z
zeros in number formatting, 329
ZIP codes, 811
Zoom arrow, 779
Zoom button (Word), 9, 53, 55, 56, 209
Zoom control, 242
Zoom dialog box (Excel), 242, 250
Zoom dialog box (Word), 55, 56, 209
Zoom In button (PowerPoint), 494
Zoom In button (Word), 56
Zoom Level button (Word), 176, 185
Zoom Out button (Word), 56, 102, 191
Zoom Slider, 9, 385
Zoom To Page button (PowerPoint), 494
Zoom To Selection button (Excel), 242, 249
zooming effect in slide transitions, 479
zooming in/out, 249

adjusting, 53, 102
of contact records, 662
displaying multiple pages, 55, 209
to full page, 176
overview of, 242
by percentage, 56
in Publisher, 904
in Reading Pane, 627
in reports, 778-779
specific zoom level, 242
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